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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an
overview of the COMSOL® environment with examples that show you how to use
the COMSOL Desktop® user interface and the Model Builder. It also provides a
quick introduction to creating applications and add-ins using the Application
Builder as well as a quick introduction to the Model Manager.

If you have not yet installed the software, install it now according to the
instructions at www.comsol.com/product-download.

In addition to this book, an extensive documentation set is available after
installation. Tutorials can be found throughout the COMSOL website, including
in the Learning Center at www.comsol.com /support/learning-center, the Video
Gallery at www.comsol.com /videos, and the COMSOL Blog at
www.comsol.com/blogs.


http://www.comsol.com/product-download
www.comsol.com/video/
www.comsol.com/blogs

COMSOL Desktop®

MODEL MANAGER — Click this button to switch to
the Model Manager for managing different versions of

your models.

QUICK ACCESS TOOLBAR — Use these
buttons for access to functionality such as file
open/save, undo/redo, copy/paste, and delete.

APPLICATION BUILDER —
Click this button to switch to
the Application Builder and
start building an application
based on your model.

MODEL BUILDER
TOOLBAR

MODEL TREE — The model
tree gives an overview of the _|
model and all of the functionalit;
and operations needed for
building and solving a model as
well as processing the results.

accessed by right-clicking a
node.
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RIBBON — The ribbon tabs have buttons
and drop-down menus for controlling all
steps of the modeling process.

GRAPHICS WINDOW TOOLBAR

GRAPHICS WINDOW — The Graphics window presents

= "oo

Compute  Study
1w

Study

jels)

+
Add Select Plot
Study Group ~

2 E- B+ 8- aE

&

Add Plot
Group ~

Results

=
]

3
Result
Templates

& o~
B |
(¥ ]

=

Windows  Reset
- Desktap «

Layout
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interactive graphics for the Geometry, Mesh, and Results nodes.
Operations include rotating, panning, zooming, and selecting.

HooA A
Uk +
er Add Add Build  Mesh
. Physics  Mathematics Mesh 1~
Physics Mesh
Eki G @ (& @
Auxiliary Data Table 1

INFORMATION WINDOWS — The Information windows will display vital
model information during the simulation, such as the solution time, solution
progress, mesh statistics, solver logs, and, when available, results tables.
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The screenshot on the previous pages is what you will see when you first start
modeling in COMSOL Multiphysics using the Model Builder. The COMSOL
Desktop® user interface provides a complete and integrated environment for
physics modeling and simulation as well as application design, providing you with
the tools necessary to build a user-friendly interface for your models. You can
customize the desktop to your own needs. The windows can be resized, moved,
docked, and detached. Any changes you make to the layout will be saved when
you close the session and available again the next time you open COMSOL
Multiphysics. As you build your model, additional windows and widgets will be
added. (See page 30 for an example of a more developed desktop.) Among the
available windows and user interface components are the following;:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo,
Redo, Copy, Paste, and Delete. You can customize its content from the Customize
Quick Access Toolbar list (the downward-facing arrow to the right of the toolbar).

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete
most modeling tasks. The ribbon is only available in the Windows® version of the
COMSOL Desktop environment and is replaced by menus and toolbars in the
macOS and Linux® versions. Click the Application Builder button to switch from
the Model Builder to the Application Builder and start building an application
based on your model.

Settings Window

This is the main window for entering all of the specifications of the model,
including the dimensions of the geometry, properties of the materials, boundary
conditions and initial conditions, and any other information that the solver will
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need to carry out the simulation. The picture below shows the Settings window for

the Geometry node.

Model Builder

— = =t~

~ & Untitled.mph (root)
v () Global Definitions
Fi Parameters 1
2 Materials
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» = Definitions
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2 Materials
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= Solid 1
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%= Thermal Insulation 1
A Mesh 1
v o Study 1
[= step 1: Stationary

> [El Results

Plot Windows

4

Geometry
[E8 Build All

Label:  Geometry 1|

~  Units
[] Scale values when changing units
Length unit:
m
Angular unit:

Degrees

~  Advanced

Geometry representation:
CAD kernel
Design Module Boolean operations
Default repair tolerance:
Automatic
Build new operations automatically
Build autornatically when leaving geometry

~ Cleanup

Automatic detection of small details

These are the windows for graphical output. In addition to the Graphics window,
Plot windows are used for visualizing results. Several Plot windows can be used to

show multiple results simultancously. A special case is the Convergence Plot
window, an automatically generated Plot window that displays a graphical

indication of the convergence of the solution process while a model is running.

Information Windows

These are the windows for nongraphical information. They include:

* Messages: Various information about the current COMSOL Multiphysics
session is displayed in this window.

* Progress: Progress information from the solver in addition to stop buttons.

* Log: Information from the solver, such as the number of degrees of freedom,
solution time, and solver iteration data.



e Table: Numerical data in table format as defined in the Results node.

* External Process: Provides a control panel for cluster, cloud, and batch jobs.

Other Windows

The Windows drop-down menu in the Home tab of the ribbon gives you access to
all COMSOL Desktop windows. On macOS and Linux®, you will find this in the
Windows menu. In addition to the windows described earlier, you can access the
following windows:

* Add Physics and Add Multiphysics: Expand the physics interfaces in a model.
* Add Study: Change the type of study.

* Results Templates: Add a predefined plot or evaluation associated with a
physics interface; only available for certain physics interfaces.

» Add Material from Library and the Material Browser: Access the material
property libraries.

* Application Libraries: Choose among the collections of MPH-files containing
tutorial models and runnable applications with accompanying documentation.

* Part Libraries: Load one of the predefined parameterized geometry models.

* Add-in Libraries: Load one of the add-ins that provides customized
functionality.

* Selection List: Show a list of geometry objects, domains, boundaries, edges,
and points that are currently available for selection.

* Properties and Comments: View model tree node properties, where you can
also type comments.

* Auxiliary Data: View auxiliary data associated with the model such as
interpolation files or CAD files.

* Messages: Display information after an operation is performed.
* Table: Display results in table format.

 External Process: Control COMSOL Multiphysics processes running
separately.

» Comparison Result: Compare the Model Builder and Application Builder
settings of two MPH-files.

* Find and Replace: Enter a search string for finding it in the model’s settings,
tags, labels, tables, etc.

* Versions: Display model versions stored in a Model Manager database.
* Chatbot: Command prompt for communicating with a chatbot.

* Java Shell: Command prompt for running and debugging code interactively.
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 Data Viewer: Inspect and change parameters, as well as view Application
Builder declarations and Java method variables.

+ Debug Log: Display debug information for methods.
* Recovery Files: View recovery files.

* Physics Builder Manager: Compile user-defined physics interfaces. This is only
visible if the Physics Builder has been activated in Preferences.

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is
located in the lower right-hand corner of the COMSOL Desktop interface.

Dynamic Help

The Help window provides context-dependent help texts about windows and
model tree nodes. If you have the Help window open in your desktop (by typing
F1, for example), you will get dynamic help (in English only) when you click a tree
node or a window. From the Help window, you can search for other topics, such
as menu items.

The Model Builder, the Application Builder, and the
Model Manager

The main components of the COMSOL Desktop environment are the Model
Builder, the Application Builder, and the Model Manager.

THE MODEL BUILDER

The Model Builder is the tool where you define the model and its components,
such as how to solve it, the analysis of results, and creating reports. You do that by
building a model tree. The model tree reflects the underlying data structure — the
model object — which stores the state of the model including settings for
geometry, mesh, physics, boundary conditions, studies, solvers, postprocessing,
and visualizations.

THE APPLICATION BUILDER

The Application Builder allows you to quickly create an application (also called an
app) with a specialized user interface that is easy to use. An application is typically
based on a model created with the Model Builder. The Application Builder
provides important tools for creating applications including the Form Editor, the
Main Window Editor, and the Method Editor. The Form Editor includes
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drag-and-drop capabilities to easily access and include user interface components,
such as input fields, graphics windows, and buttons. The Main Window Editor lets
you to add ribbon tabs with buttons and menus as well as organize your layout
using subwindows. The Method Editor is a programming environment that, for
example, allows you to modify the model represented by the model object data
structure. You can also use the Method Editor to add user interface logic and
auxiliary functionality to an application. The Java® programming language is used
to write code in the Method Editor, which means that all Java® syntax and Java®
libraries can be used.

In the Method Editor, program code is stored in methods. A method is another
name for what is known in other programming languages as a subroutine,
function, or procedure. Methods can be used to modify the model object data
structure in the Model Builder and the Application Builder. A method can be used
both for moditying the model object of the current session and for modifying the
model object in a running application. For a quick introduction to the Application
Builder, see “Building an Application with the Application Builder” on page 122.

THE MODEL MANAGER

The Model Manager is a workspace for simulation data management. It allows you
to collaborate with other users and centrally organize models and apps. The
Model Manager provides version control to track changes and updates to your
files. It will aid you in storing only relevant data of MPH-file drafts and revisions.
The Model Manager includes an advanced search tool that allows you to search
the models and applications stored in a Model Manager database for contents
based on keywords or tags. Depending on your license type, you can connect to a
local or remote and centrally managed Model Manager database. For a quick
introduction to the Model Manager, see “Using the Model Manager” on page
191.

FURTHER READING

This book, Introduction to COMSOL Multiphysics, gives a detailed introduction
to using the Model Builder and a quick introduction to the Application Builder
and the Model Manager. For detailed information on how to use the Application
Builder, see Introduction to Application Builder and the Application
Programming Guide. For more information on the Model Manager, see the
Reference Manual and the Model Manager Manual.
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Applications, COMSOL Server™, and COMSOL
Compiler™

The Application Builder is included in the Windows® version of COMSOL
Multiphysics. With a COMSOL Multiphysics license, apps can be run from the
COMSOL Desktop environment. Although applications cannot be built with the

macOS or Linux® versions of the software, applications can still be run with
COMSOL Multiphysics on those platforms.

By using COMSOL Compiler™ you can compile your application (MPH-file) to
an executable file for Windows®, Linux®, and macOS. You can freely distribute
the executable and it can be run without any license file.

With a COMSOL Server™ license, applications can be run in major web browsers
on a variety of operating systems and hardware platforms. In addition, you can run
applications by connecting to COMSOL Server with an easy-to-install COMSOL

Client for Windows®.

The COMSOL Client for Windows® allows a user to run applications that require
a LiveLink™ product for CAD (this functionality is not available when running
applications with a web browser).

Running applications in a web browser does not require any installation and no
web browser plug-ins are needed. Running an application in a web browser
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics
rendering in 3D are based on WebGL™ technology, which comes with all major
web browsers.

To create an application based on your model,

click the Application Builder button, accessible S delie S
from the Home tab on the ribbon. A : A
For more information on creating COMSOL Application  Model Component

. . . g Build M 1e
applications, refer to the section “Building an Hieer S

Application with the Application Builder” on page
122 and the book Introduction to Application
Builder.

Waorkspace M
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Preferences

Preferences are settings that affect the modeling environment. Most are persistent
between modeling sessions, but some are saved with the model. You access the

preferences from the File menu by selecting Preferences.

3 Preferences

Application Builder
Chatbot
Client-Server

Computing

Email

Files

Geornetry

Graphics
Default 3D View
Display Format
Fonts

v v

> Interaction
Sketch
Toolbars

Help

Libraries

LiveLink Connections

Mesh

Model Builder

Model Manager

Physics Builder

Results

Save
Security
Updates
User Interface

Factory Settings for Al Import...

Graphics

Rendlering: OpenGL -
Optimize for.  Quality -
Antigliasing:  Medium -
Detail: Mormal -
[] Enable antialiasing for on-screen transparency effects
Show logo on canvas

Logo file: | Ve Browse
Show mouse coordinates when drawing

[] Use software rendering for image export

Export..

Factory Settings

oK Cancel

In the Preferences window, you can change settings such as graphics rendering, the
number of displayed digits for results, the maximum number of CPU cores used
for computations, or paths to user-defined application libraries. Take a moment to
browse your current settings to familiarize yourself with the different options.

GRAPHICS AND PLOT WINDOWS

In the Graphics page, there are two graphics rendering options available: OpenGL®
and Software Rendering. If your computer does not have a dedicated graphics card,
you may have to switch to Software Rendering for slower but fully functional

graphics. A list of recommended graphics cards can be found at:

www.comsol.com/system-requirements
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COLOR THEMES

In the User Interface > Color Themes page, there are three color theme preferences:

* Desktop color theme: Choose between a Default, Light, or Dark theme for the
COMSOL Desktop environment.

* Graphics color theme: Choose a color theme for the Graphics window.

 Image export color theme: Choose a color theme for exported images.

Color Themes

Desktop color therme: Default -
Graphics color theme: Light
Dark

Image export color theme:  paga

When using the Dark theme in Linux®, some controls take their color from the
operating system’s theme. You will get a better user experience by picking both a
dark-looking theme in Linux® and the Dark theme in the COMSOL Desktop

environment.

| 17



Opening and Saving Files from the File Menu

The File menu provides several options for opening and saving model files on the
COMSOL MPH-file format, as well as a few other supported formats.

File Home  Definitions Geometry — Material

[ MNew Ctrl+N

[ Run Application

& Open.. Ctrl+0

P Open From... Ctrl+Shift+0
Recent >

[ Application Libraries

Save Ctrl+5

[ Save As..

I saveTo... Ctrl+Shift+5

Revert to Saved Ctrl+Shift+R

| Compact History
COMSOL Multiphysics Server >
Help >

T Licensed and Used Products...
Preferences...
Exit

* New lets you create a new model from scratch.

* Run Application opens and runs an application if a runnable application
definition is available in the chosen MPH-file.

* Open opens an existing file

. @ Open X
from the file system using ¢ 5 v B T s v s o ol 5 semcomn
thc OPen dlalog Gerne D S )

s Quick access teme

[ This PC

& Network

e name [orenchmph ] A1 COMSOLFies s "
o

18]



* Open From opens an
. K o B =] o S busbarmph - COMSOL Multiphysics
existing file from either e
the file system or from a
Model Manager database o
(see “Using the Model e e

(e ke Annular Ultraviolet Reactor with Particle Tracing

Manager” on page 191). [6] oneez et comsons

Utraviolet Sterilzation
Add Database

Open

CsiR~ 9 ¥~ ~ 100 of 1586 results shown Main

* Recent opens a recently R <] S ooy T
opened file from the file

Anode film resistance geom sequence
D Oct 24, 202, 6:00:42 AM (COMSOL)

system or from a Model
Manager database.

* Application Libraries opens a tutorial model or a runnable application from the
Application Libraries.

» Save saves the current file.

* Save As lets you save the

@ SaveAs x
current file to the file system | . ., s vosono » comar Te .
with a new name using the gg=s iz S )
Save As dialog. SO
[ This PC
& Network
« Hide Fldr e

* Save To lets you save to
o B =] o S busbarmph - COMSOL Multiphysics
a Model Manager e
database.

Save
Demo Database Save new
Tite Electical Heating ina Busbar
Comments

Add Database

W& Browse

Save v

* Revert to Saved opens the last saved version of the file and reinitializes the
user interface.
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Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model as
shown in the figure below.
e O % = v

File
New

Model Wizard

EBlank Model

CREATING A MODEL GUIDED BY THE MODEL WIZARD
The Model Wizard will guide you in setting up the space dimension, physics, and

study type in a few steps:
| Start by selecting the space dimension for your model component: 3D, 2D

Axisymmetric, 2D, 1D Axisymmetric, or 0D.

e O B Sk

File
Select Space Dimension

I
| = 9
|
2D 1D
Sb Axisymmetric HE Axisymmetric 1= iz

2 Now, add one or more physics interfaces. These are organized in a number of
physics branches in order to make them easy to locate. These branches do not
directly correspond to products. When products are added to your COMSOL
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Multiphysics installation, one or more branches will be populated with
additional physics interfaces.

Select Physics Review Physics Interface

ter text Heat Transfer in Solids (ht)
(5 Recently Used
¥ AC/DC
) Acoustics Temperature (K): T
Chemical Species Transport
£ Electric Discharge
Tf Electrochemistry
Fluid Flow
Heat Transfer
IF Heat Transfer in Solids (ht)
Heat Transfer in Fluids (ht)
& Heat Transfer in Solids and Fluids (ht)
> | = Conjugate Heat Transfer
> 1% Radiation
> /| Electromagnetic Heating
£ Lumped Thermal System (Its)
> {[] Thin Structures
> @4 Heat and Moisture Transport
> (@ Porous Media
> | @A Metal Processing
) Bioheat Transfer (ht)
> 24 Curing

Dependent Variables

(v v v v v v

Added physics interfaces:
I Heat Transfer in Selids (h)

Remove

e Space Dimension e Study
Help e Cancel [~/ Done
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3 Select the Study type that represents the solver or set of solvers that will be used
for the computation.

Select Study

v oo General Studies
[= Stationary
[V Time Dependent
v oo Preset Studies for Selected Physics Interfaces
[ Thermal Perturbation, Eigenfrequency
[== Thermal Perturbation, Frequency Domain
» b More Studies
~dt Empty Study
Added study:
[= stationary
Added physics interfaces:
) Heat Transfer in Solids (ht)

e Physics
Help Q Cancel E’/Done

Finally, click Done. The desktop is now displayed with the model tree configured
according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL

The Blank Model option will open the COMSOL Desktop interface without any
Component or Study. You can right-click the model tree to add a Component of a
certain space dimension, physics interface, or Study.
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The Ribbon, Quick Access Toolbar, and Graphics Menus

The ribbon tabs in the COMSOL Desktop environment reflect the modeling
workflow and give an overview of the functionality available for each modeling
step, including building simulation applications from your models.

File  Home Defintions Geometry Materials Physics Mesh Study Resuts Developer

g Lvenk Add Heat Transfer  Add Add Compute Study Add | Temperature AddPlot _Result Windows _ Reset
1v Study ()~ Group~ Templates -

B B
Al [} PartLibraries | Material inSolids v Physics  Mathematics  Mes)

@ [ a @ o N BA = e WM & W B
=
‘
:

Geometry Materials Physics Mes study Results Layout

The Home tab contains buttons for the most common operations for making
changes to a model, running simulations, and for building and testing
applications. Examples include changing model parameters for a parameterized
geometry, reviewing material properties and physics, building the mesh, running
a study, and visualizing the simulation results.

There are standard tabs for each of the main steps in the modeling process. These
are ordered from left to right according to the workflow: Definitions, Geometry,
Materials, Physics, Mesh, Study, Results, and Developer.

Contextual tabs are shown only if they are needed, such as the 3D Plot Group tab,
which is shown when the corresponding plot group is added or when the node is
selected in the model tree.

File  Home Defintions Geometry Materials Physics Mesh Study Results Developer Temperature (f)

% @ Volume W Slice = Line A

Pt Plot | Bl AmowVolume () kosurfoce @ Contour & Mes
Inv [ surface Arrow Surface 3 Streamline () Annotation  Plots

q =/ &k R EE

Marker  Cut  Cut Image  Animation
Point  Llinev Plane v v

More vl
Attibutes v | Along Normal

Plot Add Plot Graphics Interaction Export

Modal tabs are used for very specific operations, when other operations on the
ribbon may become temporarily irrelevant. An example is the Work Plane modal
tab. When working with work planes, other tabs are not shown, since they do not
present relevant operations.

Work Plane  Sketch  Developer

5 Virtual Operations v ’

THE RIBBON VS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model
tree in the Model Builder window. Most of the functionality accessed from the
ribbon is also accessible from contextual menus by right-clicking nodes in the
model tree. Certain operations are only available from the ribbon, such as selecting
which desktop window to display. In the COMSOL Desktop interface for macOS
and Linux®, this functionality is available from toolbars, which replace the ribbon
on these platforms. There are also operations that are only available from the
model tree, such as reordering and disabling nodes.

| 23
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THE QuUICK ACCESS TOOLBAR

The Quick Access Toolbar contains a sct of commands that are independent of the
ribbon tab that is currently displayed. You can customize the Quick Access Toolbar
and add most commands available in the File menu, including commands for
undoing and redoing recent actions, as well as for copying, pasting, duplicating,
and deleting nodes in the model tree. You can also choose to position the Quick
Access Toolbar above or below the ribbon.

e DE &R Cg

~ Untitled.mph - COMSOL Multiphysics

File Home Definitions Geometry Materials  Physics  Mesh  Study Results Developer

THE GRAPHICS MENUS

As an alternative to using the model tree or the ribbon, you can right-click in the
Graphics window to access context-dependent menus. The menus shown will
depend on which node is currently selected in the model tree. By using the Go To
option, when available, you can jump to a context menu for another node in the
model tree.

Graphics
QQ@A~ &l Ly ukkn Cr @B @ a-

Booleans and Partitions 3

Transforms b Array

Conversions v 8 Copy
[l Extract “4 Mirrar

= Explicit Selection & Move

E Delete "';:Z:: Rigid Transform
‘B Zoom to Selection O Rotate
i Measure ',_’J Scale
<@ Hide

Geometric Entity Level 3

Clipping v

Go To v

MACOS AND LINUX®

In the COMSOL Desktop environment for macOS and Linux®, the ribbon is
replaced by a set of menus and toolbars.

v e v o b | BB e - | | HetTonsterimsolis + % 6 24 2 < B Ment <] = swdyl - % | Tempesturet) ~ & -~ B

sics A\ Mesh o Study [ Resuls [ Developer [[Tempersturet) | @ B - @ B M W W B B 9 v & @ © @ - a-Rl/ /A vana e em-



The instructions in this book are based on the Windows® version of the COMSOL
Desktop environment. However, running COMSOL Multiphysics and the
COMSOL Desktop environment in macOS and Linux® is very similar, keeping in
mind that the ribbon user interface components can instead be found in the
corresponding menus and toolbars. In addition, the Application Builder is only
available in the Windows® version. However, you can run apps in all supported
operating systems.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model
tree, adding nodes, and editing the node settings.

All of the nodes in the default model tree are top-level parent nodes. You can
right-click on them to see a list of child nodes, or subnodes, that you can add
beneath them. This is the means by which nodes are added to the tree.

When you click on a child node, you will see its node settings in the Settings
window. It is here that you can edit node settings.

It is worth noting that if you have the Help window open, which is achieved either
by selecting Help from the File menu or by pressing the function key F1, then you
will also get dynamic help (in English only) when you click on a node.

THE ROOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node .
(initially labeled Untitled.mph), a Model Builder

Global Definitions node, and a Results FE-ES~ -8
node. The label on the root node is &
the name of the multiphysics model v % busbar.mph (roof

. > (i) Global Definitions
file, or MPH-file, to which the model > T Component 1 (comp )
is saved. The root node has settings ’ E Study 1

. > [ Resul

for author name, default unit system, s
and more.

The Global Definitions node has a Parameters and a Materials subnode by default.
The Global Definitions node is where you can, among other things, define
parameters, variables, functions, and couplings that can be used throughout the
model tree. They can be used, for example, to define the values and functional
dependencies of material properties, forces, geometry, and other relevant features.
The Global Definitions node itself has no settings, but its child nodes have plenty
of them. The Materials subnode stores material properties that can be referenced
in the Component nodes of a model.
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The Results node is where you access the solution after performing a simulation
and where you find tools for processing the data. The Results node initially has five
subnodes:

 Datasets, which contains a list of solutions you can v @ Unitied.mph (roct)

work with. > () Global Definitions
. . . > [l Compenent 1 {comp1)
* Derived Values, which defines values to be derived > oo Study 1
from the solution using a number of v (B Results

i Datasets
ez Derived Values

postprocessing tools.

e Tables, which is a convenient destination for the B Tables
. Ex
Derived Values or for Results generated by probes % R:m
E ports

that monitor the solution in real-time while the
simulation is running.

 Export, which defines numerical data, images, and animations to be exported
to files.

* Reports, which collects reports about the model in the HTML, Microsoft®
Word, and Microsoft® PowerPoint formats.

To these five default subnodes, you may also add more Plot Group subnodes that
define graphs to be displayed in the Graphics window or in Plot windows. Some of
these may be created automatically, depending on the type of simulations you are
performing, but you may include additional figures by right-clicking on the Results
node and choosing from the list of plot types. In addition, you can add an
Evaluation Group node, which is similar to the Derived Values node but with tightly
associated Evaluation Group tables, and a Parameters node for parameters used
exclusively in Results.

THE COMPONENT AND STUDY NODES

In addition to the three nodes just described, there are T
.. v & Untitled.mph (root)
two additional top-level node types: Component nodes > (@ Global Definitions

and Study nodes. These are usually created by the Model > W Component 1 {comp1)
. . >~ Study 1
Wizard when you start a new model. After using the » [ Results

Model Wizard to specify what type of physics you are

modeling and what type of Study (for example,

steady-state, time-dependent, frequency-domain, or eigenfrequency analysis) you
will carry out, the Model Wizard automatically creates one node of each type and
shows you their contents.
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It is also possible to add » @ Global Definitions
more Component and Study  ~ & Component 1 fcomp1)

nodes as you develop the > = Definitions %5 Add Physics
. ¥ Geometry 1 0 A I
model. A model can contain 2 Material ‘i Add Multiphysics
multiple Component and 5> I Heat Transferin o 2 Add Mathematics
. A5 Mesh 1 + Insert Physics
Study nodes and itwouldbe | 5 7 TS Insert Physic
. . = Insert Physics F
confusing if they all had the = Step 1 Stationary L "eeTt Physics From
same name. Therefore, > @ Results Meoving Mesh '
Deformed Geormetry v

these types of nodes can be
renamed to be descriptive of =

Topology Optimization

their individual purposes.  Shape Optimization '
. E Parameter Estimation
If a model has multiple K
Ao Add Mesh
Component nodes, they can
Copy as Code to Clipboard 3
be coupled to form a more
.. E] Copy Ctrl+C
sophisticated sequence of _
. . [ Delete — Del
simulation steps. -
=[1 Rename — F2
Note that each Study node S settings
may carry outa d1ffcrent Properties and Comments
type of computation, so B Hep -
each one has a separate
Compute button =. Keyboard Shortcuts —!

To be more specific,

suppose that you build a model that simulates a coil assembly that is made up of
two parts: a coil and a coil housing. You can create two Component nodes: one that
models the coil and another that models the coil housing. You can then rename
each of the nodes with the name of the object. Similarly, you can also create two
Study nodes, the first simulating the stationary or steady-state behavior of the
assembly, and the second simulating the frequency response. You can rename
these two nodes to be Stationary and Frequency Domain.

When the model is complete, save it to a file named Coil Assembly.mph. At that
point, the model tree in the Model Builder looks like the figure below.

In this figure, the root node is named Coil
Assembly.mph, indicating the file in which Model Bu i_|_d?_r
the model is saved. The Global Definitions ~ * - e
node and the Results node each have their
default name. Additionally, there are two
Component nodes and two Study nodes
with the names chosen in the previous
paragraph.

v Zv W~

~ @ Coil_Assembly.mph (root)
» () Global Definitions

> [l Coil (fcomp1)

> [l Coil Housing (comp2)

» rdb Stationary

» b Frequency Domain

>

& Results
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PARAMETERS, VARIABLES, AND SCOPE

Global Parameters

Global parameters are user-defined constant scalars that are usable throughout the
model. That is to say, they are “global” in nature. Important uses are:

o Parameterizing geometric dimensions.
* Specifying mesh element sizes.

* Defining parametric sweeps (simulations that are repeated for a variety of
different values of a parameter such as a frequency or load).

A global parameter expression can contain numbers, global parameters, built-in
constants, built-in and user-defined functions with global parameter expressions
as arguments, and unary and binary operators. For a list of available operators, see
“Appendix C — Language Elements and Reserved Names” on page 242. Because
these expressions are evaluated before a simulation begins, global parameters
cannot depend on the time variable, t. Likewise, they cannot depend on spatial
variables like x, y, or z, nor on the dependent variables for which your equations
are solving.

It is important to know that the names of parameters are case sensitive.

You define global parameters in the Parameters node in the model tree under
Global Definitions.

Model Builder Settings
+— ® Et- Elv =~ -' - Parameters
e
- Label: Parameters 1 ,%
~ & busbar.mph (reot)
~ () Global Definitions ~ Parameters
Pi Parameters 1
% Default Model Inputs " MName | Expression Value Description
i Materizls L 9em] 0.09m Length
L CDmpU_n_er_WH feomp1) rad_1 Glmm] 0.006 m Bolt radius
b Definitions
> [A] Geometry 1 thb S[mm] 0.005 m Thickness
> 551 Materials whhb 5crm] 0,05 m Width
> }._ Electric Currents &g} mh 3[mm] 0.003 m Maximum element size
> |8 Heat Transfer in Solids {ht) htc S[W/m2/K] 5 Wi (m®K) Heat transfer coefficient
> apy Multiphysics Vtot 20[mV] 0.02V Applied voltage
> /A Mesh i
~ ndo Study 1

|7 step 1: Stationary i =] \ ]
> [Tr. Solver Configurations f £2 A

> {[F Results Ll
Vot

Expression:

20[mV]

Description:

Applied voltage
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Note that you can add multiple Parameters nodes and they will be named
Parameters |, Parameters 2, etc. In addition, Parameters can be organized into
several cases and then swept over. For more information, see “Parametric Sweeps’
on page 172.

The following spread shows an example of a customized desktop with additional
windows.

2
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QUICK ACCESS
TOOLBAR SETTINGS WINDOW RIBBON

B DB DR SN B DR @

S acoustics_muffler.mph - COMSOL Multiphysfc

File Home  Definitions Geometry Materials  Physics  Mes Study Results Developer Sound Pressure Leve] (acpr)

= & . = Variables v = Import e o)
A =) ﬁ PI =g \‘!)/ o
Application  Model Component Add Parameters ([P FUnCtions o HIEEES Add Pressure Acoustics,  Add
Builder  Manager Tv Component « M Parameter Case Al ] PartLibraries | Material | Frequency Domain v Physi
MODEL BUILDER ‘Waorkspace Model Defipitions Geometry Materials Physics
WINDOW
Model Builder Settings Graphics
— >t | TEt~ .- Surface QaB~-FH Lk ¢
Plot = 4= = =i
Type filter text
S ¢ freq(91)=1000 Hz
v & acoustics_muffler.mph (root) Label:  Surface 1 =
v () Global Definitions
P; Parameters 1 v Data
£ Default Model Inputs
%) Materials Dataset:  From parent -~ 3
v [l Component 1 {comp)
> Definitians v Expression — > =hv
5[] Geometry 1 .
5t Materials pression: m
v Pressure Acoustics, Frequency Domain (acpr) acprlpt
i Pressure Acoustics 1 Unit:
S Sound Hard Boundary (Wall) 1
MODEL TREE = v (Wail dB -
BB Initial Values 1 -
> (m Plane Wave Radiation 1 O Description:
= Plane Wave Radiation 2 Total sound pressure level
i Interior Sound Hard Boundary (Wall) 1
> /A Mesh1 > Title
5 o Study 1
>
v [E Results [Emse
Datasets ~ Coloring and Style
Derived Values
> [ Tables Coloring: Color table -
> Nl Acoustic Pressure (acpr) Color table: Blritow ~ =
v il Sound Pressure Level (acpr)
™ Surface i | Color legend
> N Acoustic Pressure, lsosurfaces (acpr) Color table transformation: |~ None -
v A% Transmission Loss
Color table type: Continuous -
Scale: Linear -
[ Reports ] Wireframe
> Quality

> Inherit Style

Messages Progress Log Evaluatic
BES 85 850 NN
Bl B2 B0 o @ WD

x y z Value

0.65000/-0.0090720/0.061563 |67.170
0.65000/0.026388 |0.054952 |63.174
0.65000/0.077324 |-0.033967 65.393
0.54093/-0.0039627/0.029691 |67.388
0.49116/-0.0083584/0.028710 |66.632
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GRAPHICS WINDOW

DYNAMIC HELP — Continuously updated with online access to the
Knowledge Base and Application Gallery. The Help window enables
easy browsing with extended search functionality.

Au ] & — ~od
T = o R
Add Build  Mesh Compute  Study  Add
s Mathematics Mesh 1w 1~ Study
Mesh Study
B - e-EEO & ¢-ad

urface: Total sound pressure level (dB)

n 3D

190 BB B &~

m

Sound Pressure
Level (acpr) v

ds

70

60

50

40

30

20

1.71GB|2.08GB

= (m] x
& = O
Add Plot Result Windows Reset
Group v Templates - Desktop +
Layout

Help

~-a®

= Q

COMSOL Multiphysics > COMSOL Multiphysics Reference Manual =
Results Analysis and Plots > Plot Groups and Plots > Surface (Plot)

Surface (Plot) o

Use a Surface plot to display 3 quantity on a domain in 20 ( [ ) or on
a boundary in 30 (T]). Add Deformation, Filter, Image (Plot Attribute),
Marker, Material
Transparency (3D and 2D with a Haight Expression), Visual Effects (3D

e, Selection (Plot Attribute), Transformation,

and 2D with a Height Expression), or Height Expression (20 only}
subnodes a5 needed. Right-click 3 2D Plot Group o 3D Plot Group to
sdd 2 Surface plot, It is possible to use data from a 2D dataset to create

an embedded surface plot in 3D, on the xy-plane at = = 0. You can also
create  Surface plot from the Evaluation Group centextual ribben

toalbar for platting an evaluation group.

+ Go to Commen Results Node Settings for links to
information about these sections: Data,
Expression, Title Range, Coloring and Style,
Quality, and Inherit Style. <

Q

« Previous Section Next Section »

Plot 1
eaq-H UEODER & &~ S-@a

Global: Transmission loss o

Transmission loss

Transmission loss (dB)

PLOT WINDOW —
The Plot window is
used to visualize
Results quantities,
probes, and
convergence plots.
Several Plot windows
can be used to show
multiple results
simultaneously.

200 400 600

Frequency (Hz)

® .

800 1000

| o

INFORMATIONWINDOWS

PROGRESS BAR WITH CANCEL BUTTON ]
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Results Parameters

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model.

Model Builder Settings

n = St 3 2 2 Pararmeters

il
.

~ Parameters
~ @ busbar.mph (root)
> ({}) Global Definitions "
5 ii Component 1 (comp 1) MName Expression Value Description
wl
> oo Stucy 1 ’ iso_level 309.5[K] 309.5K Isosurface level

~ {E Results
Pi Parameters

\ ~ [ -
Datasets

Result parameters may depend on other parameters and built-in functions.

Variables

Variables have associated Variables nodes in the model tree and can be defined
either in the Global Definitions node or in the Definitions subnode of any Component
node.

) Global Definitions

g

~ & busbar.mph (root)
s @

B Component 1 {comp1)
v = Definitions
2= Variables 1
» g Selections
av Average 1 (aveop )

Naturally, the choice of where to define the variable depends on whether you want
it to be global (that is, usable throughout the model tree) or locally defined within
a single Component node. Like a parameter expression, a variable expression may
contain numbers, parameters, built-in constants, and unary and binary operators.
However, it may also contain variables like t, x, y, or z; functions with variable
expressions as arguments; and dependent variables that you are solving for, such
as temperature T or voltage V, in addition to their space and time derivatives.

If you have a model with many Variables nodes it may be useful to group them
together by using the Node Group feature, as shown below. You access this menu
by right-clicking the Definitions node.

= Show More Options...
MNode Group

E Group by Type

Node groups can be used to group nodes in Global Definitions, Definitions under a
Component, Geometry, Materials, physics interfaces, and results.
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Variables Used in Applications

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of'a parameter. In addition, variables
to be used in applications can be defined in the Application Builder, in the
application tree under the Declarations node. Such variables can also be used in
model methods.

Scope

The “scope” of a parameter or variable is a statement about where it may be used
in an expression. All global parameters are defined in the Global Definitions node
of the model tree as a Parameters subnode. This means that they are global in
scope and can be used throughout the model tree.

A variable may also be defined in the Global Definitions node, as a Variables
subnode, and have global scope, but they are subject to other limitations. For
example, variables may not be used in Geometry, Mesh, or Study nodes (with the
one exception that a variable may be used in an expression that determines when
the simulation should stop).

A variable that is instead defined under the Definitions subnode of a Component
node has local scope and is intended for use in that particular Component (but,
again, not in the Geometry or Mesh nodes). They may be used, for example, to
specify material properties in the Materials subnode of a Component or to specify
boundary conditions or interactions. It is sometimes valuable to limit the scope of
the variable to only a certain part of the geometry, such as certain boundaries. For
that purpose, provisions are available in the settings for a variable to select whether
to apply the definition either to the entire geometry of the Component or only to
a Domain, Boundary, Edge, or Point.
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The figure below shows the definition of two variables, q_pin and R, for which the
scope is limited to just two boundaries identified by numbers 15 and 19.

Settings

Variables

Label: Variables 2 B

Geometric Entity Selection

Geometric entity level: | Boundary -
Selection: i Manual -
»
12 B —
o W
,,
~ Variables
"
Name | Expression Unit | Description
g_pin mu/sqrt(3*(1+mu”2))*(r_pin*emega)*Ybar(T[1/K])[MPa]“step 1 (T_melt-T)[1/K]) | W/m®  Surface heat source, pin-workpiece interface
R sqr(c"2+y"2) m Distance in xy-plane from toal center axis
LH 55\ 5 Dap-
Name:
q_pin
Expression:
mu/sqrt(3*(1+mu”2))*(r_pin*omega)“Ybar(T[1/K])[MPa]*step 1((T_melt-T)[1/K])
Description:

Surface heat source, pin-warkpiece interface

Such a group of numbers is called a Selection and can be named and then
referenced elsewhere in a model. This can be useful, for example, when defining
material properties or boundary conditions that will use the variable at certain
boundaries but not elsewhere. To give a name to the Selection, click the Create
Selection button ( %) to the right of the Selection list.

Although the variables defined in the Variables node under the Component >
Definitions subnode are intended to have local scope, they can still be accessed
outside of the Component node in the model tree by being sufficiently specific
about their identity. This is done by using a “dot notation”, where the variable
name is preceded by the name of the Component node in which it is defined and
the names are joined by a “dot”. In other words, if a variable named foo is defined
in a Component node named MyModel, then this variable can be accessed outside of
the Component node by using MyModel.foo. This can be useful, for example,
when you want to use the variable to make plots in the Results node. Variables
defined under the Declarations node in the Application Builder are available
globally in form objects and methods but cannot be used in the Model Builder.
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Built-In Constants, Variables, and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and
functions. They have reserved names that cannot be redefined by the user. If you
use a reserved name (a name already used by the software) for a user-defined
variable, parameter, or function, the text you enter will get a yellow squiggly
underline (indicating a warning) or a red squiggly underline (indicating an error)
and you will get a tooltip message if you hover over the text string.

Some important examples are:

» Mathematical constants such as pi (3.14...) or the imaginary unit i or j

 Physical constants such as g_const (acceleration of gravity), c_const (speed
of light), or R_const (universal gas constant)

e The time variable, t

« First- and second-order derivatives of the dependent variables (the solution)
whose names are derived from the spatial coordinate names and dependent
variable names (which are user-defined variables)

e Mathematical functions such as cos, sin, exp, log, log10, and sqrt

See “Appendix C — Language Elements and Reserved Names” on page 242 for
more information.

The Application Libraries

The Application Libraries are collections of MPH-files containing tutorial models
and runnable applications with accompanying documentation. Tutorial models
show how to use the Model Builder and have documentation that includes
theoretical background and step-by-step instructions. Runnable applications have
instructions on how to use the application. You can readily inspect and edit all
tutorial models and applications to make them your own. Each physics-based
add-on module comes with its own application library with examples specific to its
applications and physics area. You can use the step-by-step instructions and the
MPH-files as a template for your own modeling.
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To open the Application Libraries window, select Application Libraries [fi from the
Windows menu on the Home toolbar or from the File menu . Then, search by
application name or browse under a module folder name.

Application Libraries

(¥ Refresh [§] Update COMSOL Application Libraries () Application Gallery
Search

3 COMSOL Muttiphysics
¥ AC/DC Module
) Acoustics Madule
= Battery Design Module
& CAD Import Module
1 CFD Module
> [ifl Applications
> [ifl Fluid-Structure Interaction
> fifl High Mach Number Flow
> fifi Multiphase Flow
> [ifl Nonisothermal Flow
> [ffl Particle Tracing
> [fff Shallow Water Equations
« ffi] Single-Phase Flow
air filter
backstep
chimney
cylinder_flow_viscoelastic
O hydrocyclone
O les 3d hill
© rotating_disk
sports_car
© turbulent_mixing
® water_purification_reactor
> [ Thin-Film Flow
> [fff Verification Examples

v wow v

Name

oeo

Used products
Physics interfaces

Created in

Computation time
Author

Last modified
Created

> 2% Chemical Reaction Engineering Madule
> &2 Composite Materials Module

> «; Corrosion Module

> T Design Module

> [ ECAD Import Module

> 3 Electric Discharge Module

> L Electrochemistry Module

Run Application Open

3] Open PDF Document

Help 6 Close

This example solves the incompre]
the size of the recirculation regio

Stationary Incompressible Flow over a Backstep

backstep
comsoL

Laminar FI

COMSOL
28 second

COMSOL

Sep 30, 20
Sep 30, 20

Streamine: velocty feld

Figure 3: The recirculation region visualized using a velocity streamiline plo.

Application Library path: CF0_lodule/Single-Phase_Tutorials/backstep

Modeling Instructions

From the File menu, choose New.

NEW
1 In the New window, click Model Wizard,

MODEL WIZARD

1 In the Model Wizard window, click 30.

2 In the Select physics
3 Click Add.

luid Flow>Single-Phase Flow>Laminar Flow (spf).

4 Click study.

Click Open [#] , Run Application » , or Open PDF Document . Alternatively,
sclect Help > Documentation from the File menu to search by application name or
browse by module. Note that the Run Application option is only available for
MPH-files that are runnable applications.

The MPH-files in the Application Libraries can have three formats — Solved
MPH-files, Compact MPH-files, or Preview MPH-files:

Solved MPH-files, including all meshes and solutions. In the Application
Libraries window, these appear with the @ icon. If the MPH-file size
exceeds 25 MB, a tooltip with the text Large file and the file size appears
when you position the cursor at the model’s node in the Application

Libraries tree.

Compact MPH-files, with all settings for the model but without built
meshes and solution data to save space in the installation. Some MPH-files
have no solutions for other reasons such that the computation time is short
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and the results are easily regenerated. You can open these to study the
settings and to mesh and re-solve. It is also possible to download the full
versions — with meshes and solutions — of most of these when you update
your Application Libraries. These appear in the Application Libraries window
with the (O icon. If you position the cursor at a compact file in the
Application Libraries window, a No solutions stored message appears. A solved
version is available for download via the Application Library Update (except
in a few cases where the file is a template related to another, regular, model).

Preview MPH-files, with only a model description and thumbnail image
available. These appear in the Application Libraries window with the ) icon.
The file is a preview of an application or a model file, including the model
description and information about used products and physics interfaces and
the computation time. Solved and compact versions are available for
download. Model documentation will be available if you have specified the
use of online help (see the Reference Manual for details on how to do this).

The Application Libraries are updated on a regular basis by COMSOL. To check
all available updates, click Update COMSOL Application Libraries [] at the top of the
Application Libraries window. You can also find this option from the File > Help
menu (Windows® users) or from the Help menu (macOS and Linux® users). This
connects you to the COMSOL website, where you can access new applications
and the latest updates.

Application Libraries

C* Refresh |} Update COMSOL Application Libraries| () Application Gallery
| Search

b [@ COMSOL Multiphysics
b % AC/DC Module
[ 1)) Acoustics Module

If your computer has internet connection, then you can click the Application
Gallery button to access a wide range of additional examples from the COMSOL

website.
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Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining
global variables to the final report of results, is displayed in the model tree.

Model Builder

- S Etv Elv Siv v

v 4@ backstep.mph (root)
v () Global Definitions
Fi Parameters 1
4 Default Model Inputs
= Materials
~ [l Component 1 {comp1)

» = Definitions
» Geometry 1
¥ Materials

Laminar Flow (spf)
s Fluid Properties 1
= Initial Values 1
= wall1
m Inlet 1
= Symmetry 1
m Outlet 1
A5 Mesh 1
» ~db Study 1
v {E| Results
Datasets
2 Derived Values
EH Tables
> Nl Velocity (spf)
» I'.’ Pressure (spf)
~ |@ Velocity, Streamlines

~ == Streamline 1

5 Color Expression 1

Export
[# Reports

From top to bottom, the model tree defines an orderly sequence of operations.

In the following branches of the model tree, the node order makes a difference
and you can change the sequence of operations by moving the subnodes up or
down the model tree:

¢ Geometry

* Materials

¢ Physics

* Mesh

¢ Study

¢ Plot Groups
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Nodes may be reordered by these methods:

* Drag-and-drop

» Right-clicking the node and selecting Move Up or Move Down
¢+ Pressing Ctrl + Up arrow or Ctrl + Down arrow

In other branches, the ordering of nodes is not significant with respect to the
sequence of operations, but some nodes can be reordered for readability. Child
nodes to Global Definitions is one such example. You can use the filter text field
above the model tree to display only those nodes that match the search string you
enter here. The Filter Options menu, available in the Model Builder toolbar, has
additional settings for modifying the search results.

Model Builder Settings
— ® Etv Elv - B~ backstep.mph
velocity E Show Children
v 4@ backstep.mph (root) abe Contains Word
v 7 Study ] o | Show Filter Text Field
~ [Tt Solver Configurations
v [ Solution 1 (sal) v Used Products
~ wiw Dependent Variables 1
7. Velocity field (comp1.u) COMSOL Multiphysics
v {E| Results .
i Velocity (spf) ~ Unit System

V@ Velocity, Streamlines 5
You can view the sequence of operations presented in the model tree as program
code statements by saving the model as a Model File for MATLAB® or as a Model File
for Java® after having selected Compact History in the File menu. Note that the
model history keeps a complete record of the changes you make to a model as you
build it. As such, it includes all of your corrections, including changes to
parameters and boundary conditions and modifications of solver methods.
Compacting this history removes all of the overridden changes and leaves a clean
copy of the most recent form of the model steps. In the Application Builder, you
can use the Record Method option to view and edit program code statements in the
Method Editor.

As you work with the COMSOL Desktop interface and the Model Builder, you
will grow to appreciate the organized and streamlined approach. However, any
description of a user interface is inadequate until you try it for yourself. In the next

chapters, you are invited to work through two examples to familiarize yourself
with the software.
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Example |: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL
Multiphysics®. For more fully featured structural mechanics models, see the
Structural Mechanics Module application library.

At some point in your life, it is likely that you have tightened a bolt using a wrench.
This exercise takes you through a structural mechanics model that analyzes this
basic task from the perspective of the structural integrity of the wrench subjected
to a worst-case loading.

The wrench is, of course, made from steel, a ductile material. If the applied torque
is too high, the tool will be permanently deformed due to the steel’s elastoplastic
behavior when pushed beyond its yield stress level. To analyze whether the wrench
handle is appropriately dimensioned, you will check if the mechanical stress level
is within the yield stress limit.

This tutorial gives a quick introduction to the Model Builder workflow. It starts
with opening the Model Wizard and adding a physics option for solid mechanics.
Then a geometry is imported and steel is selected as the material. You then explore
the other key steps in creating a model by defining a parameter and boundary
condition for the load; selecting geometric entities in the Graphics window;
defining the Mesh and Study; and finally, examining the results numerically and
through visualization.

If you prefer to practice with a more advanced model, read this section to
familiarize yourself with some of the key features, and then go to the tutorial
“Example 2: The Busbar — A Multiphysics Model” on page 81.
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Model Wizard

I To start the software, double-click the COMSOL
Multiphysics icon on the desktop, which will take you to
the New window with two options for creating a new G
model: Model Wizard or Blank Model.

If you select Blank Model, you can right-click the root node

in the model tree to manually add a Component and a Study.
For this tutorial, click the Model Wizard button. G Mol
If the COMSOL Desktop user interface is already open, Wizard
you can start the Model Wizard by selecting New from the

File menu. Choose the Model Wizard.

Blank Model
The Model Wizard will guide you through the first steps of
setting up a model. The next window lets you select the
dimension of the modeling space.

2 In the Select Space Dimension window, select 3D.

@ . -+ o -+ —

2D 1D
Axisymmetric 2E Axisymmetric e e
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3 In Select Physics, sclect
Structural Mechanics > Solid
Mechanics (solid) = . Click
Add.

Even without add-on
modules, the Solid Mechanics
interface is available in the
Structural Mechanics folder. In
the picture to the right, part
of the Structural Mechanics
folder is shown as it appears
when all add-on modules are
available.

Click Study © to continue.

4 Click Stationary i~ under General
Studies. Click Done & once you
have finished.

General Studies and other preset
studies have solver and equation
settings adapted to the selected
physics, which is, in this example,
Solid Mechanics. A Stationary
study is used in this case — there
are no time-varying loads or
material properties.

Any selection from the More Studies branch -« requires
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Select Physics

(5 Recently Used
¥ AC/DC
1) Acoustics
=¥ Chemical Species Transport
£ Electric Discharge
Tf Electrochemistry
== Fluid Flow
Heat Transfer
i Optics
&) Plasma
2 Radio Frequency
£ Semiconductor
v E23 Structural Mechanics
=1 Solid Mechanics (solid)
[ shell (shell)
€3 Layered Shell (Ishell)
[ Membrane (mbrn)
T2 Beam (beam)
Truss (truss)
b Wire (wire)
@ Multibody Dynamics (mbd)

©

Add
Added physics interfaces:
2= Solid Mechanics (solid)

Remove

G e Study

e Space Dimension
Help e Cancel [~/ Done

Select Study

~ o General Studies
[ Eigenfrequency
Frequency Domain

[= stationary
[ Time Dependent

Added study:
[= Stationary

Added physics interfaces:
f;l Solid Mechanics (solid)

manual settings.



Geometry

This tutorial uses a geometry that was previously created and stored in the
COMSOL native CAD format, .mphbin. To learn how to build your own
geometry, see “Appendix A — Building a Geometry” on page 217.

The location of the Application Library that contains the file used in this exercise
varies based on the software installation and operating system. In Windows®, the
file path will be similar to:

C:\Program Files\COMSOL\COMSOL63\Multiphysics\applications.
Now, import the ready-made geometry file as follows.

I In the Model Builder window, under Component I, right-click Geometry | 2 and
select Import =.

Model Builder
St Elv S @~

v @ Untitled.mph (root)

v () Global Definitions
P Parameters 1
2 Materials
Component 1 (comp 1)
Definitions
G 4| Geometry 1

== Materials [ Build All B

v =2 Solid Mecha = Import
= Linear EI

€
v v il

= m

oo Freel Livelink Interfaces v
= Initial Va ) Block
A Mesh 1
Cone
v oo Study 1

As an alternative, you can use the ribbon and click Import = from the Geometry
tab.
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2 In the Settings window for Import, from the Source list, if not already selected,

select COMSOL Multiphysics file.

Settings
mport
) Build Selected » [E8 Build All Objects B

Label: Import1

~ Source

Source:

COMSOL Multiphysics file G

Filename:

C\Program Files\ COMSOL\COMSOLE3\Multiphysics\applications\COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin

W& Browse ¥ [[& Import G

~ Virtual Geometry

Include result from virtual operations

o~

3 Click Browse and locate the file wrench.mphbin in the application library folder

of the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL63\Multiphysics\applications\
COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
4 Click Import. The geometry is now displayed in the Graphics window.

In the Import section, there are
two options for locating a file
for import: Browse and Browse
From. The Browse option lets
you import a file from the file
system using the Open dialog.
The Browse From option lets
you browse from either the file
system or a Model Manager

database.

44 |

Sett

mport

) Build Selected » [E8 Build All Objects B

Label:

ings

Import 1

~ Source

Source:

COMSOL Multiphysics file

Filename:

wrench.mphbin

W& Browse ¥ [[& Import

4

P= Browse From

——

Browse
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5 Click the wrench geometry in the Graphics window and then experiment with
moving it around. As you point to or click the geometry, it changes color. Click
the Zoom In @, Zoom Out <, Go to Default 3D View ..., Zoom Extents i, and
Transparency = buttons on the Graphics window toolbar to see what happens to
the geometry:

- To rotate, click and drag anywhere in the Graphics window.
- To move, right-click and drag.

- To zoom in and out, click the mouse scroll wheel, continue holding it, and
drag.

- To get back to the original position, click the Go to Default 3D View - button
on the toolbar.

Graphics -
QABR- @@ LRk ¢ B |S-@- B 22 @ EDEe- BB TS G-ab
o
A 10%m
Rotate: Click and drag 0

Pan: Right-click and drag

Also see “Appendix B — Keyboard and Mouse Shortcuts” on page 234 for
additional information.

The imported model has two parts, or domains, corresponding to the bolt and the
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.
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Geometry Cleanup

The next step is to define material properties. Before doing so, the geometry must
be prepared for analysis, which happens automatically when you click a node
under the Geometry node. This cleanup process removes unnecessary geometric
details like thin gaps, narrow surfaces, and short edges, which could otherwise
impede the analysis by requiring an overly fine mesh.

I Click the Materials node.
v Geometry 1
Import 1 (imp1)

* Form Union (fin)

G 2 Materials

The Geometry Cleanup dialog is opened.

3 Geometry Cleanup X

How do you want to clean up the small details detected in the geormetry?
Small details may prevent successful meshing and simulation.
You can turn off the automatic detection in the Settings for Geometry.

[] Remember my chaice

G Clean up Automatically Open Wizard Cancel

The Open Wizard option guides you through each step of the cleanup process,
but in this example, the automatic option is sufficient.
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2 Click the Clean up Automatically button.
After a few seconds, the Cleanup Log window is shown.

Model Builder Settings

— ® =ty Bl S §- Cleanup Log
N Cleanup Wizard

v & Untitled.mph (root) Label:  Cleanup Log B8
v (1) Global Definitions
P| Parameters 1 v Result
%) Materisls
« i@l Component 1 fcomp) All detected issues were resolved
: 2::‘::;: Model modification log
[ Import 1 (imp 1) Node Modification
Form Union (fin) v A\ Geometry 1
Remove Details 1 (rmmd 1) *%, Remove Details 1 (rmd1) Added node

£ Cleanup Log

35 Materials

~ B2 Solid Mechanics (solid)

B8 Linear Elastic Material 1
B Freel
B2 Initial Values 1

A Mesh 1

o Study 1
[~ Step 1: Stationary

> {E Results

v Information

Cleanup detail size: 5.96-5 m

Total cleanup time: 4 seconds

Geometry statistics

" Tpe Humber Feature dimensions (minimum/mediar)
Vertices 268 =

Edges 460 Q47E-5/ B6E-4 (m)

Faces 197 2.45E-4/ 0.00206 (m)

Domains 2 0011700141 (m)

The geometry has one connected component, There are no isolated entities.

The Cleanup Log window provides information on whether the cleanup was
successful, the specific actions applied, and other details related to the geometry
model. The cleanup process added a Remove Details node to the Geometry
sequence.

In the Remove Details window, you can see which features were removed. In this
case, 2 vertices were ignored, and 6 face regions were collapsed. These operations
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improve mesh quality, reducing the number of elements and leading to more

efficient computations.

Model Builder

=t

“—

v @ Untitled.mph (root)

v (@ Global Definitions
Py Parameters 1
%) Materials
Component 1 {comp )
Definitions

Geometry 1
[E Import 1 (imp )
Form Union (fin)

Remove Details 1 (md 1)

@ Cleanup Log
58 Materials
~ 2 Solid Mechanics (solid)
5 Linear Elastic Material 1

ES Initial Values 1
A\ Mesh 1

v o Study 1
[= Step 1: Stationary

> (B Results
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Settings
Remove Details
¥ Build Selected ~

Build All
Label:  Remove Details 1

~ Automation

Mode of operation: ~ Automatic
v Entities to Process

Entities:  Entire geometry

~ Details to Remove

fertices with continuous tangent
hort eclges
mall faces
liver faces

arrow face regions

Thin domains

v Parameters
Detail size: Absolute
Maximum absolute size: 5.9E-5

Continuous tangent tolerance: 5

v Information

™ Tpe of removal
Ignored vertices 2
Collapsed face regions 5
Last build time: 2 seconds

Built with:  COMSOL 6.3.0.244 (winé4), Sep 18, 2024, 2:

Removed entities




Materials

The Materials node :: stores the material properties for all physics and all domains
in a Component node. Use the same generic steel material for both the bolt and

tool. Here is how to choose it in the Model Builder.

1)

I Open the Add Materials window.
You can open the Add Materials

= Materials

window in either of these two v 5 Solid Mec| 553
i Linear
ways: =
y 5= Freel

- Right-click Component | >
Materials :: in the Model Builder
window and select Add Material
from Library :; .

A Mesh 1

= Initial | ===

Add Material from Library

Browse Materials
Blank Material

Layers

- From the ribbon, select the Home tab and then click Add Material.

Add Material

2 In the Add Material WindOW, click to () Add to Global Materials * - Add to Component +

&b

expand the Built-In folder. Scroll down

to find Structural steel, right-click, and e e
SClCCt Add to Component l. 5 Perfect vacuum
. . . & Polysilicon
3 Examine the Material Contents section iz Lead Zirconate Titanate (PZT-5H)
. . . . 2 Rubber
in the Settings window for Material to 3 Siica glass
see the properties that are available. i Silicon

Properties with check marks are used
by the physics in the simulation.

O =

']

2= Solder, 605n-40Pb
Steel AlSI 4340
Structural steel

i ) Addto Global Materials

Add to Component 1 (comp)

25 Water, liquid

> R AC/DC
4 Close the Add Material window.
v Material Contents
» Property Variable Value Unit
[ | Density tho 7850[kg/m™3] | kg/m®
G & Young's modulus E E(T) Pa
[/ | Poisson's ratio nu nu(T) 1
Isotropic structural loss factor eta_s 0.02 1
Relative permeability mur_iso ;.. |1 1
Heat capacity at constant pressure Cp 4T3[}/ (kg™K])] JilkgK)
Thermal conductivity k_iso; kii =... | 44.5[W/(m™K]] /{m:K)
Electric conductivity sigma_iso ;... | 4.032e6[5/m] S'm
Relative permittivity epsilonr_is... |1 1
Coefficient of thermal expansion alpha_iso ;.. |12.3e-6[1/K] 17K

i -

Property group

Basic

Young's modulus and Poisson's ratio
Young's modulus and Poisson's ratio
Basic

Basic

Basic

Basic

Basic

Basic

Basic

(4]

Search
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Note that some properties are available as functions of temperature T. If
you have no heat transfer physics defined in a model, then this temperature
is taken from the Default Model Inputs under Global Definitions.

See the busbar tutorial sections “Materials” on page 95 and “Customizing
Materials” on page 144 to learn more about working with materials.



Global Definitions

You will now define a global parameter specifying the load applied to the wrench.

Parameters

I In the Model Builder window, under Global Definitions @ , choose Parameters
|
~ 4@ Untitled.mph (root)
~ (1) Global Definitions
F; Parameters 1
7 Default Model Inputs

=) Mlaterials
~ [l Component 1 {comp 1)

2 Go to the Settings window for Parameters |. In the Parameters table, enter these
settings:

- In the Name column or field, enter F.

- In the Expression column or field, enter 150[N]. The square-bracket notation
is used to associate a physical unit to a numerical value; in this case, the unit
of force in Newtons. The Value column is automatically updated based on the

expression entered once you leave the field or press Return.
- In the Description column or
field, enter Applied force.

~ Parameters

L . -
Mame | Expression Value Description

F 150[N] 150N Applied force G

If you have a Parameters table with more than one entry, you can sort the
table with respect to a particular column by clicking on the corresponding
header.

The sections “Global Definitions” on page 87 and “Parameters, Functions,
Variables, and Couplings” on page 139 show you more about working with
parameters.

|51



So far, you have added the physics and
study, imported a geometry, added the
material, and defined one parameter. The
Model Builder node sequence should now
match the figure to the right. The default
feature nodes under Solid Mechanics are
indicated by a D in the upper-left corner of
the node icon i=.

The default nodes for Solid Mechanics are:
Linear Elastic Material, Free, and Initial
Values.

The node Linear Elastic Material is the
default material model for the Solid
Mechanics interface. The node Free is a
boundary condition that allows all
boundaries to move freely without a
constraint or load. The node Initial Values
is used for specifying initial displacement
and velocity values for a nonlinear or
transient analysis (not applicable in this
case).

Model Builder

— = =t~

~ @ Untitled.mph (root)
v () Global Definitions
Fi Parameters 1
45 Default Model Inputs
2 Materials
~ [l Component 1 {comp1)
» = Definitions
v Geometry 1
= Import 1 {imp1)
Form Union (fin)
Remove Details 1 {rmd 1)
£k Cleanup Log
v ige Materials
> EpE Structural steel (mat1)
~ @ Solid Mechanics {solid)
&= Linear Elastic Material 1
= Freel
= Initial Values 1
A Mesh 1
v o Study 1
[= step 1: Stationary

> [El Results

The default physics nodes cannot be removed. Instead, you specify physics settings
that deviate from that of the default nodes by adding additional nodes. These
additional nodes can override or contribute to the settings of the default nodes as
well as other nodes. For more information, see “Override and Contribution:
Exclusive and Contributing Nodes” on page 156.

At any time, you can save your model and then open it later in exactly the state in

which it was saved.

3 From the File menu, select Save As. Browse to a folder where you have write

permissions and save the file as wrench.mph.
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Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary

conditions.

| In the Model Builder window,

: . . . v 4 Untitled.mph (root)
right-click Solid Mechanics @ Unitiedmpn (root

» () Global Definitions

(solid) = and select Fixed v [l Component 1 {comp1)
Constraint . » = Definitions
- > Geomnetry 1
This boundary condition 5 2 Materials
constrains the displacement of G v 5 Solid Mechanics (solid)
. wee Linear Elastic Mater
cach point on a boundary o Free
surface to be zero in all = Initial Values 1
d. . A5 Mesh 1
1rections. “ & Study 1
. E Step 1: Stationary
You can also use the ribbon > [B) Results

and, from the Physics tab,
select Boundaries > Fixed
Constraint.

2 In the Graphics window, rotate the
geometry by clicking anywhere in the
window and then dragging the wrench
into the position shown. Click on the
exposed front surface of the partially
modeled bolt. The boundary turns blue,
indicating that it has been selected. The
Boundary number in the Selection list
should be 35.

Material Models

Volume Forces

Mass, Spring, and Damper

Domain Constraints
Variables

More

Boundary Load

Fixed Constraint

Prescribed Displacement

Roller

Thin Layer

3 Click the Go to Default View button ... on the Graphics toolbar to restore the

geometry to the default view.

Graphics (37

Qa @~ & B [k z =k

Go to Default View
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4 In the Model Builder window, right-click Solid Mechanics (solid) = and select
Boundary Load. A Boundary Load node = is added to the Model Builder sequence.

w %l Solid Mechanics (solid)
= Linear Elastic Material 1
S Freel
i Initial Values 1
i Fixed Constraint 1

G ¥y Boundary Load 1
A5 Mesh 1

The “warning” attribute displayed on the Boundary Load node indicates that its
boundary selection is empty. The next step will be to select a boundary.

5 In the Graphics window, click the Zoom 5
Box button .« on the toolbar and drag
the mouse to select the square region
shown in the figure to the right.
Release the mouse button to zoom in
on the selected region.

6 Select the top socket face (boundary
111) by clicking the boundary to
highlight it in blue and add it to the
Selection list.

7 In the Settings window for Boundary

Load, under Force, sclect Total force as v e

the Load type and enter -F in the text SR

field for the z component. The negative Kool foece ’
sign indicates the negative z direction Fror || User defined =
(downward). With these settings, the 0 x
load of 150 N will be distributed |° y N
uniformly across the selected surface. 6 = i
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Note that to simplify the modeling process, the mechanical contact between the
bolt and the wrench is approximated with a material interface boundary condition.
Such an internal boundary condition is automatically defined and guarantees
continuity in normal stress and displacement across a material interface. A more
detailed analysis including mechanical contact can be done with the Structural
Mechanics Module.

ADDING A PARAMETER DIRECTLY FROM A TEXT FIELD

As an alternative to the method shown above, you can add or edit a parameter
directly from a text field. For example, in the case of the wrench model, first type
the value of the Total force in the text field for the z component. Then, right-click
the text field and select Create Parameter from the drop-down menu to open a
Create Parameter dialog, as shown in the second figure below.

v Force
Load type:
Total force =
Fiot User defined -
0 x
0 y | N
-130[N] Iz
Fi Create Parameter
Copy Ctrl+C
Paste Ctrl+V
Select All Ctrl+ A

In this dialog, you can enter a parameter Name and Description.

3 Create Parameter *
Marme: F2

Expression:  -130[N]

Value: -150N

Description:  Applied force

oK Cancel
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The parameter is now added to the list of Parameters, as shown below.

Settings

Parameters
Label: Parameters 1

~ Parameters

L . -
Mame | Expression Value Description

F 150[N] 150N

Applied force
F2 -150[M] -150 N

Applied force

To edit a parameter, select the parameter in an edit field, right-click, and choose
Edit Parameter.

v Force
Load type:
Total force

Fiot User defined

P Create Parameter

Fiy  Edit Parameter

Note that when you hover over edit fields and table cells, a tooltip shows the value
of the parameter or expression. This only works when the value is a constant.
v Force
Load type:
Total force

Fiot User defined
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As an alternative to editing parameters, you can also use the Data Viewer window,
which can be opened from the Windows menu in the Home tab.

Data Viewer

MName Value

~ P Parameters 1
v 85 F 1500 N
abe Expression  130[N]

This window remains open in the COMSOL Desktop until you choose to close it.

SELECTING BOUNDARIES AND OTHER GEOMETRIC ENTITIES

When a boundary is unselected, its color is typically gray. The exception is when
you use the material Appearance sctting available in Materials; sce page 99. To
select a boundary, first hover over it. This highlights the boundary in red,
assuming the boundary was previously unselected. Now, click to select the
boundary by using the left mouse button. The boundary now turns blue. Its
boundary number will appear in the Selection list in the Settings window of the
corresponding boundary condition. Once a boundary is selected and you hover
over it again, the boundary turns green. If you click a boundary highlighted in
green, the boundary is deselected and now turns gray again. The same technique
for selecting and deselecting is applicable to geometry objects, domains,
boundaries, edges, and points.

The figure below shows the different selection states for a boundary.

Highlighted for selection Selected Highlighted for deselection

To select internal surfaces that are hidden behind the one closest to you, use one
of the following methods to cycle through the boundaries at the mouse pointer:
roll the mouse scroll wheel, use the keyboard + and - buttons, use the keyboard
arrow-up and arrow-down buttons, or use two-finger drag on a touchpad.
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When hovering over a boundary, information about the boundary number and
surface normal direction is displayed in the upper-left corner of the Graphics
window, as shown in the figure below.

Graphics

aq@- Bl Lrzzhn ¢y = @

—111| Up

Similarly, when selecting domains, edges, and vertices the corresponding
geometric entity number is displayed.

For each boundary surface, the normal vector has a “positive” and “negative”
direction, referred to as the up and down direction, respectively. When hovering
over a surface, the information display shows which normal direction is currently
pointing toward you. This information can be useful, for example, when defining
more advanced boundary conditions, especially on material interfaces.

SELECTING USING THE GRAPHICS WINDOW CONTEXT MENUS

As an alternative selection method, you can right-click in the Graphics window and
choose one of the options for domain, boundary, edge, or point selection.
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For example, to assign a Boundary Load boundary condition, first right-click and
select New Boundary Selection, as shown in the figure below.

‘B Zoom to Selection

Measure

% Select Box

Zoom Box

Zoom Extents

New Boundary Selection
New Edge Selection

R
(& Mew Domain Selection
=
B
% New Peint Selection

Clipping v

GoTo

Click to select the boundaries to which you would like to apply the boundary
condition. (In this case, the top socket face; boundary 111.) Then, right-click
again and select Boundary Load, as shown in the figure below.

= Boundary Load

== Fixed Constraint

= Prescribed Displacement

= Roller

= Thin Layer
Connections 3
Mass, Spring, and Damper 3
More Constraints 3
Variables 3
More 3

- .

- Zoom to Selection

= Measure

ae  Hide
Geometric Entity Level 3

&

- Show Selection for Solid Mechanics (solid)

Clipping 3
GoTo 3

You can also use this method to add additional boundaries to the selections of an
already created boundary condition. In the example above, you could, for
example, while having the Fixed Constraint node selected, select the menu option
Add to Boundary Selection for Fixed Constraint | (although it wouldn’t be applicable
in this example).
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SELECTING USING CLIP PLANES

For selecting geometric entities inside complicated CAD models, you can use clip
planes, clip boxes, clip spheres, or clip cylinders. You select these from the graphics
toolbar by clicking the Clipping toolbar button.

® - - @
[E  Add Clip Plane
f51 Add Clip Box

B0 Add Clip Sphere
B

Add Clip Cylinder

By selecting a Clip Plane, for example, you can quickly hide all parts of a model that
is on one side of the plane. The figure below shows a clip plane used to select one
of the interior boundaries of the wrench model.
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Mesh

The mesh settings determine the resolution of the finite element mesh used to
discretize the model. The finite element method divides the model into small
elements of geometrically simple shapes, in this case tetrahedra. In each
tetrahedron, a set of polynomial functions is used to approximate the structural
displacement field — how much the object deforms in each of the three
coordinate directions. The strains are computed by differentiating the
displacement field. Then, the stresses are computed from the strains using the
material properties.

In this example, a coarser mesh is sufficient to capture the variations in the stress
field and provide reasonably accurate results. Refining the mesh to improve
computational accuracy usually comes at the cost of slower performance and
higher memory usage.

I In the Model Builder, under Component I, click Mesh | 4 . In the Settings window
for Mesh, under Mesh Settings, sclect Coarser from the Element size list.

Settings
Mesh
[E2 Build All

Label: Mesh 1 =
v Sequence Type

Physics-controlled mesh =

~ Physics-Controlled Mesh

Element size: Coarser -
Extremely fine

Extra fine
Geometric An e,

L]
Contributo

Solid Mechani Fipe
MNormal
Coarse
Coarser
Extra coarse

Extremely coarse

2 Click the Build All button @ in the Settings window or on the Mesh toolbar.

With the resulting mesh, the model will require about 6.5GB to solve. If you
have a computer with less than 6.5GB of RAM you can select Extra coarse or
Extremely coarse from the Element size list (instead of Coarser.)
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3 After a few seconds, the mesh is displayed in the Graphics window. Rotate the
wrench to take a look at the element size distribution (this may vary a bit
depending on the version you are running).
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Study

In the beginning of setting up the model, you selected a Stationary study, which
implies that a stationary solver will be used. For this to be applicable, the
assumption is that the load, deformation, and stress do not vary in time. To start
the solver:

I Right-click Study I ~» and select
Compute = (or press F8). G > " Study 1

> [E Results || = Compute F&
After a few seconds of Parametric Sweep

computation time, the default plot 769 Function Sweep

is displayed in the Graphics

window. During computation, a

Progress window shows progress information from the solvers. After the
computation you can find other useful information about the computation in the
Messages and Log windows; Click the Messages and Log tabs under the Graphics
window to see the kind of information available to you. The Messages window can
also be opened from the Windows drop-down menu in the Home tab of the ribbon.

Messages Progress

avVm s

————— Dependent Variesbles 1 in Study 1/Solution 1 (soll) >
<---— Stationary Solver 1 in Study 1/Solution 1 ({soll)

Started at Sep 18, 2024, 4:25:32 PM.
Linear solver
Number of degrees
Symmetric matrices
Scales for dependent varisbles:
Displacement Field (compl.u): 1
Orthonormal null-space function used.
Iter SolEst Damping Stepsize #Res #Jac #5o0l LinErr LinRes

1 0.91 1.0000000 0.91 1 1 1 1.6e-09 4e-05
Solution time: 12 s.
Physical memory: 5.85 GB
Virtual memory: 6.53 GB
Ended at Sep 18, 2024, 4:25:44 PM.
————— Stationary Solwver 1 in Study 1/Solution 1 ({soll) >

eedom solwved for: 504627 (plus 1 internal DOFs).
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Results

The von Mises stress is displayed in the Graphics window in a default Volume plot
with the dls;lacement visualized using a Deformation subnode. Change the default
unit (N/m?) to the more suitable MPa as shown in the following steps.

I In the Model Builder, expand the Results > Stress
(solid) w node, then click Volume | w.

v {E| Results
H Datasets
Derived Values
EH Tables
~ W@ Stress (solid)
G > ) Volume 1
& Export
[# Reports

2 In the Settings window under
Expression, from the Unit list, select
MPa (or type MPa in the field). Expression:

solid.misesGp

v Expression > Ev =

Unit:

G MPa -

[] Description:

von Mises stress
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3 Click the Plot button & on the toolbar of the Settings window for the Volume
plot and then click the Go to Default 3D View button ... on the Graphics window
toolbar.

The von Mises stress distribution is shown in the bolt and wrench under an
applied vertical load.

Volume: von Mises stress (MPa)

You can add additional predefined plots by selecting from the list defined by
Results Templates under Results or by clicking the corresponding button from
the ribbon Home tab.

3D Plot Group
2D Plot Group
1D Plot Group

v [l Stre:
> @ @) Polar Plot Group
Expc @  Smith Plot Group
Iz Rep @ Evaluation Group
Configurations
Fi Parameters
Plot All

LI

Result Templates
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4 You can, for example, visualize the applied load distribution. Right-click Results
and select Results Templates. In the Results Templates window, sclect Solid
Mechanics > Applied Loads > Boundary Loads and click Add Plot.

Result Templates
—+ Add Result Ternplate (™ Reload
Type filter text
~ T Study 1/Solution 1 (s0l1)
v =2 Solid Mechanics

i'i Stress (solid)
il Displacement (solid)

il Boundary Loads (solid)
@ Total Reaction Forces and Moments (Solid Mechanics)

The resulting plot shows the boundary load using arrows.

Graphics 3
Qa@-@ Lk ¢y B FEEEEE@S - @8

Boundary Loads (solid)

For our purposes we are not interested in the stress in the bolt. We can selectively
visualize the stress in just the wrench by adding a Selection node.
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I Right-click the Stress > Volume node and select Selection

v {E| Results
Datasets
2% Derived Values
EH Tables
~ i'i Stress (solid)
> ) Volume 1
> Nl Boundary Loar Plot
Export Plot In
[# Reports
*. Filter
& Image
= Marker
252 Material Appearance
& Selection 0
L]

.~ Transformation

2 In the Graphics window, click the wrench, domain 1.

Model Builder Settings
— =+ 1+ | T =t~ Selection
Type filter text (&) ot
v @ wrench.mph (root) Label: Selection 1 E
» () Global Definitions
> [l Compenent 1 (comp1) v~ Selection
» ~db Study 1
v {E| Results Selection: I Manual -
> H Datasets " . —
2% Derived Values = hH
EH Tables El o
~ i“ Stress (solid) -
v Volume 1 =

== Deformation
:—.‘ Selection 1
» i'i Boundary Loads (solid)
Export
[# Reports
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3 Click Plot to see the visualization.

Volume: von Mises stress (MPa)

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa,
which means that we are getting somewhat close to plastic deformation for our
150 N load (which corresponds to about 34 pounds force). You may also be
interested in a safety margin of; say, a factor of three. To quickly assess which parts
of the wrench are at risk of plastic deformation, you can plot an inequality
expression such as solid.misesGp>200[MPa]. (The suffix Gp indicates that the stress
variables are obtained from the so called finite element Gauss points.)

I Right-click the Results node @ and add a 3D Plot Group W .

v {E| Results
Data WM
ez Deriv |
EH Table
v il Stres )
vRv®

> Nl Bour

[# Repc
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Polar Plot Group
Smith Plot Group

Evaluation Group
Configurations
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Plot All

Result Templates

Show More Options...
Mode Group
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Help
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2 Right-click the 3D Plot Group 3 node w and select Volume & .
v {E| Results

» i Datasets

2% Derived Values
EH Tables

> §@ Stress (solid)
>

Boundary Loads (solid)

3D Plot Group 3

Export Plot
[ Reports Plot In

a Volume G

@ Arrow Volume

™) surface

3 In the Settings window for Volume, click
the Replace Expression button = and
select Model > Component | > Solid
Mechanics > Stress > solid.mises-von

v Expression Eiv =fhv

Expression:

solid.misesGp = 200[MPa]

L. Unit:
Mises stress - N/m? by double-clicking. .
When you know the variable name O Descripti
. escription:
beforehand, you can also directly enter solid.misesGp» 200[MPal

solid.misesGp in the Expression field.
Now edit this expression to:
solid.misesGp>200[MPa].

This is a Boolean expression that evaluates to either 1 for true or 0 for false. In
areas where the expression evaluates to 1, the safety margin is exceeded.
4 Change the Color table to RainbowLight and click the Plot button & .

5 In the Model Builder window, click 3D Plot Group 3. Press F2 and, in the Rename
3D Plot Group dialog, enter Safety Margin. Click OK. Alternatively, edit the label
at the top of the Settings window.

Note that it is sometimes quicker to right-click a Plot Group, select
Duplicate from the menu, and then make the necessary changes to the
plot settings.

The resulting plot shows that the stress in the bolt is high, but the focus
of this exercise is on the wrench. If you wish to comfortably certify the wrench
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fora 150 N load with a factor-of-three safety margin, you would need to change
the handle design somewhat, such as by making it wider.

Volume: solid.misesGp>200[MPa]

x10°

02

‘/,\I/'x

You may have noticed that the manufacturer, for various reasons, has chosen an
asymmetric design for the wrench. Because of that, the stress field may be different
if the wrench is flipped around. Try now, on your own, to apply the same force in
the other direction and visualize the maximum von Mises stress to see if there is
any difference.
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Convergence Analysis

The results from a simulation software such as COMSOL Multiphysics can
shorten design times dramatically by, for example, reducing the number of
experiments or product tests. However, simulation software is not a substitute for
real-world testing. This is especially important if there are risks for physical or
environmental damage. One way to reduce (but not eliminate) the risk of drawing
the wrong conclusions from simulation results is to perform a convergence
analysis.

To check the accuracy of the computed maximum von Mises stress in the wrench,
you can now continue with a mesh convergence analysis. Do that by using a finer
mesh and therefore a higher number of degrees of freedom (DOFs).

This section illustrates some more in-depth functionality and the steps
below could be skipped at a first reading. Note that since the mechanical
contact between the bolt and the wrench is approximated with a material
interface boundary condition, there will be stress singularities in this area.
Due to this, we will neglect the stresses there and focus on the handle. A
more detailed analysis including mechanical contact can be done with the
Structural Mechanics Module.

EVALUATING THE MAXIMUM VON MISES STRESS

I To study the maximum von Mises stress in the wrench, in the Results section of
the model tree, right-click the Derived Values :» node and select Maximum >
Volume Maximum .

2 In the Settings window for Volume Maximum, under Selection, choose Manual and
select the wrench, domain 1, by clicking on the wrench in the Graphics window.
We will only consider values in the wrench domain and neglect those in the bolt.
In addition, since we are only interested in the stress values in the handle, which
we can achieve by multiplying the stress variable with the expression
(x>-0.045).

3 In the first row of the Expressions table, in the Expression column, type
solid.mises*(x>-0.045).
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4 In the Expressions table, type MPa as the Unit.

Settings
Volume Maximum

= Evaluate «
Label: Volume Maximum 1 E

~ Data

Dataset: Study 1/Solution 1 (sol1) -

~ Selection

Selection: &% Manual -

!

v Expressions + v =k

L . X -
Expression Unit Description

solid.mises™(x>-0.045) | MPa G

% ‘. v Eljv
Expression:

solid.mises*(x>-0.045)

In addition, to get optimal accuracy, in the same settings window, in the
Configuration section, change the Point type to Gauss points.

~ Configuration

Find maximum of: Real part =

Point type: Gauss points - G

Integration order: Mesh vertices ’

[] Include position Eatsspuints

Lagrange points

> Data Series Operation

5 In the Settings window for Volume

Maximum, click Evaluate to evaluate the Messages Progress  Log  Table 1
maximum stress. The result will be LR T Y

displayed in a Table window and will be IR —
approximately 368 MPa. The value may G 36783
vary slightly depending on the software

version and hardware platform.
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6 To see where the maximum value is attained, you can, for example, use a
Max/Min Volume plot. Right-click the Results node & and add a 3D Plot Group
. Next, right-click the 3D Plot Group 4 node w and select More Volume Plots
> Max/Min Volume = . Change the name of 3D Plot Group 4 to Max/Min Stress.

7 To plot values in the wrench and not in the bolt, right-click the Max/Min Volume
® node, select Selection, and then select the wrench, domain number 1.

8 In the Settings window for Max/Min Volume, in the Expression text field, type
solid.misesGp* (x>-0.045). Alternatively, you can use a Filter node: Right-click
the Max/Min Volume plot, select Filter, and change the Logical expression for
inclusion to x>-0.045.

9 In the Settings window under Expression, from the Unit list, select MPa (or enter
MPa in the field).

10 Click the Plot button & . This type of plot simultaneously shows the location of
the maximum and minimum values and also their coordinate location in the
table below (the exact values may differ depending on the version you are
running).

Graphics

Qa@-@ Lkl - @ e EBED 8- S ad

Max/Min Volume: solid.misesGp*(x>-0.045) (MPa) L
n: 0.00000
max: 372.492
z

Yobox

'"]ESSBQES Pr’ogr’ess Log Maximum and Minimum Values

SECEE O LY B RECECLEE

X ¥ z solid.misesGp*(x>-0.045) (MPa)

0.063750 |0.0011556 |-2.8267E-4 |0.0000
-0.036204 -4.9213E-4|-0.0064146372.49
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An alternative way of plotting the maximum and minimum stress is to
right-click the Stress > Volume plot and select Marker.
v {E| Results
» i Datasets
> 2 Derived Values
> E Tables
~ W@ Stress (solid)
~ I8 Volume 1
=3 Deformation
& Selection 1
= Marker 1
> | Boundary Loads (solid)
> | Safety Margin
> §@ Max/Min Stress
& Export
[# Reports

Note that the maximum and minimum values using this approach can
differ somewhat since the evaluation method is slightly different.

PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while
solving and then finally plot the maximum von Mises stress versus mesh size. First,
we define the parameters that will be used for controlling the mesh density.

I In the Model Builder window, click Parameters | » under Global Definitions @ .

2 Go to the Settings window for Parameters. In the Parameters table (or under the
table in the fields), enter these settings:

- In the Name column or field, enter hd. This parameter will be used in the
parametric sweep to control the element size.

- In the Expression column or field, enter 1.

- In the Description column or field, enter Element size divider.

3 Now, enter another parameter with

Name ho, Expression 0.01/3, and Settings e
Description Initial element size. parameters
This parameter will be used to Label:  Parameters 1 =

define the element size at the
beginning of the parametric sweep.

~ Parameters

. . Expressi Val Descripti
4 In the Model Builder window, under et ue v
. 150[M] 150 N Applied force
Component |, click Mesh | 4. In 1 ; b —
. ement size divider
the Settings window for Mesh, select 0.01/3 0.0033333 Initial element size

User-controlled mesh from the
Sequence type list.
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5 Under Mesh I, delete the Size | node 2J. This setting controls the boundary
mesh and to simplify the setup only the volume setting will be used.

6 Under Mesh I, click the Size node 4J.

7 In the Settings window for Size, under
Element Size, click the Custom button.

Under Element Size Parameters, enter:
- h0/hd in the Maximum element size ficld.

- h0/(4*hd) in the Minimum element size
field.

- 1.3 in the Maximum element growth rate
field.

- 0.1 in the Curvature factor ficld.
- 0.21n the Resolution of narrow regions ficld.

See page 109 for more information on the
clement size parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS

¥ Element Size Parameters
Maximum element size:
h0/hd

Minimum element size:
hi/{4*hd)

Maximum element growth rate:

1.3
Curvature factor:
0.1

Resolution of narrow regions:
0.2

As a next step, add a parametric sweep for the parameter hd.

I In the Model Builder window, rlght click Study I -
and select Parametric Sweep ::. A Parametric
Sweep node is added to the Model Builder
sequence.

2 In the Settings window for Parametric Sweep, under the table

o Study‘l

=== Parametric Sweep
[= step 1: Stationary

w

in the Study

[Fre Solver Configurations

Settings scction, click the Add button +. From the Parameter name list in the

table, select hd.

3 Enter a range of Parameter values to

sweep for. Click the Range ... button SELNGE

Parametric Sweep

and enter the values in the Range = Compute (* Update Solution
dialOg. In thC Start fleld, enter 1. In Label:  Parametric Sweep

the Step field, enter 1, and in the Stop
field, enter 4. Click Replace. The

~ Study Settings

L3
Parameter name

Sweep type: Specified combinations

Parameter value list | Pararneter unit

hd (Element size divider +  range(1,1,4)

©
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Parameter value list will now display range(1,1,4).

The settings above make sure that as the sweep progresses, the value of the
parameter hd increases and the maximum and minimum element sizes decrease.
See page 172 for more information on defining parametric sweeps.

For the highest value of hd, the number of DOFs will exceed three millions.
Therefore, we will switch to a more memory-efficient iterative solver.

4 Under Study 1 > Solver

. . 4 o Study 1
Configurations > Solution I, 12 Parametric Sweep
expand the Stationary Solver | [= step 1: Stationary
. . 4 Solver Configurations
node =, and right-click Suggested |'I"|'|-Di e (sol)
Iterative Solver[ and select 54 Compile Equations: Stationary
Enable. Sclecting an iterative b v Dependent Variables 1
. . 4 [75 stationary Solver 1
solver option typically reduces Direct
memory usage but may require 2, Advanced
. . P =* Fully Coupled 1
phySICS-Sp_CCIﬁC tallorln.g of the Suggested Direct Solver (solid)
solver settings for efficient b [N Suggested Iterative Solver (solid) G

computations. 4 (B Results

5 Click the Study | node and select
Compute =, cither in the Settings window or by right-clicking the node. You can
also click Compute on the ribbon Home or Study tab. The computation time will
be a few minutes (depending on the computer hardware) and memory usage
will be about 10GB. If you don’t have this amount of memory on your system,
you can instead use a parametric sweep from 1 through 3, or even 1 through 2.
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RESULTS ANALYSIS
Note that after running the parametric sweep, a new default plot node is created

corresponding to the new Dataset Study |/Parametric Solutions |.

Model Builder Settings

ot TE

i
a4
a4
a4

3D Plot Group
@ Plot b= 4= = =

v @ wrench.mph (root) Label:  Stress (solid) 1 =
» () Global Definitions
> [l Compenent 1 (comp1) ~ Data
» ~db Study 1
v (| Results Dataset: Study 1/Parametric Solutions 1 (s0l2) = =
>
Dat.asets Parameter value (hd): 6 =
¥ Derived Values
> .
% Tables ] > Selection
> Wi Stress (solid)
> Nl Boundary Loads (solid) > Title
> §i§ Safety Margin .
> N Max/Min Stress ERioteetings
> Nl i =
. Stress (solid) 1 View: Automatic - | |
= Export
[ Reports [] Show hidden entities

As a final step, analyze the results from the parametric sweep by displaying the
maximum von Mises stress in a table.

I In the Model Builder window, under Results > Derived Values, sclect the Volume
Maximum | node .

The solutions from the parametric sweep are stored in the Dataset named Study
I/Parametric Solutions 1. Now, change the Volume Maximum settings
accordingly:

2 In the Settings window for Yolume Maximum, change the Dataset to Study
I/Parametric Solutions 1I.

3 Click the arrow next to the Evaluate button at the top of the Settings window
for Volume Maximum and select to evaluate in a New Table. This evaluation may
take 10 seconds or so, depending on the computer.

4 To plot the results in the Table, click the Table Graph = button at the top of the
Table window (the first few values will vary due to slight mesh variations
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between versions for coarser meshes before a more mesh-converged value has
been reached).

Messages Progress Log Table 2 x

S WS S m® Vg =@
hd solid.mises*(x>-0.045) (MPa)

1.0000(376.01

2.0000370.48

3.0000(369.00

4.0000[368.56

solid. mises*(x>-0.045) (MPa)

o

It is more interesting to plot the maximum value vs. the number of DOFs. This
is possible by using the built-in variable numberofdofs.

5 Right-click the Derived Values node :: and select Global Evaluation .

6 In the Settings window for Global Evaluation, change the Dataset to Study
I/Parametric Solutions 1.

7 In the Expressions ficld, enter numberofdofs.

You can type the first few characters of the variable name and then use
the keyboard shortcut Ctrl+Space to get a variable suggestion from the
list of available variables.

8 In the Settings window for Global Evaluation, click the arrow next to the Evaluate
button and select the option to evaluate in Table 2, or Table I, depending on
which previous steps you chose to follow. This displays the DOF values for each
parameter next to the previously evaluated data.

This mesh-convergence analysis shows that the computed value of the maximum
von Mises stress in the wrench handle will decrease from the high original value,
for a mesh with about 250,000 DOFs, to about 369 MPa for a mesh with about
3,400,000 DOFs. If we further refine the mesh we will find that the results will
stay approximately around the value 369 MPa.
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The figure below shows the associated Table Graph and Table Graph Settings

window.

solid. mises*(x>-0.045) (MPa)

Settings
Table Graph
Plot
Label:  Table Graph 1 =
v Data
Source: Table -
Table: Table 2 MRE]
[] Row-based
x-axis data: Number of degrees of freedo +
Plot columns: Manual -
Colurmns:

I hd

solid.mises*(x>-0.043) (MPa)
Mumber of degrees of freedom (1)

Note that depending on the version of COMSOL Multiphysics that you are
running, the above values may vary slightly due to variations in the number of
clements generated by the meshing algorithm.

As an alternative to Derived Values, you can use Evaluation Groups. An Evaluation
Group shares some of the properties of Plot Groups as well as Derived Values. An
Evaluation Group comes with an integrated table whereas Derived Values outputs to
a table of your choice. In addition, Evaluation Groups allows you to automatically
reevaluate after solving. To enable this, select the corresponding checkbox in the
Settings window of the Results node as shown in the figure below.

Model Builder

— = Et -

~ @ wrench.mph (root)
» () Global Definitions
> [l Compenent 1 (comp1)
» ~db Study 1

> [B| Results

Settings
Results
~ Update of Results

[] Only plot when requested

Recompute all plot data after solving
Reevaluate all evaluation groups after solving
[] Run all exports after solving

~ Save Data in the Model

Save plot data:  Automatic =

In this Settings window you can also request to regenerate all plots after solving.
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You add an Evaluation Group in the same way as a Plot Group: by right-clicking the
Results node. The figure below shows an Evaluation Group that performs the same

task as the Derived Values described carlier.
v [, Evaluation Group 1

mif Volurne Maximum 1
|c:§| Global Evaluation 1

To get optimal accuracy, in the Volume Maximum settings window, in the
Configuration scction, make sure the Point type is sct to Gauss points.

The figure below shows the corresponding Evaluation Group table.

Messages Progress Log Evaluation Group 1

= |35 e B £ oms \ =N =
hd solid.mises®(x»-0.043) (MPa) | Number of degrees of freedom (1)
1.0000(376.01 2.5224E5

2.0000370.48 9.4986E5

3.0000(369.00 1.9122E6

4.0000(368.56 3.3946E6

This concludes the wrench tutorial.
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Example 2: The Busbar — A Multiphysics Model

Electrical Heating in a Busbar

This tutorial demonstrates the concept of multiphysics modeling in COMSOL
Multiphysics using the Model Builder. You will learn how to use one of the many
preconfigured multiphysics combinations as well as subsequently add the effects
of physics phenomena not initially included in the analysis. At the end, you will
have built a truly multiphysics model.

The model that you are about to create analyzes a busbar designed to conduct a
high amount of direct current in an industrial setting (see picture below). The
current conducted in the busbar, from bolt 1 to bolts 2a and 2b, produces heat
due to the resistive losses, a phenomenon referred to as Joule heating. The busbar
is made of copper, while the bolts are made of a titanium alloy. Busbar bolts are
usually made of steel, but in this example, we will assume a highly corrosive
environment. Therefore, a titanium alloy was chosen.

Under normal operational conditions, the currents are predominantly conducted
through the copper. This example, however, illustrates the effects of an unwanted
clectrical loading of the busbar through the bolts. The fact that there are different
materials is important because titanium has a lower electrical conductivity than
copper and will be subjected to a higher current density.

Titanium Bolt 2a

Titanium Bolt 2b  Titanium Bolt |

The goal of your simulation is to precisely calculate how much the busbar heats
up. Once you have captured the basic multiphysics phenomena, you will have the
chance to investigate thermal expansion that generates structural stresses and
strains in the busbar and the effects of cooling by an air stream.
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The Joule heating effect is described by conservation laws for electric current and
energy. Once solved for, the two conservation laws give the temperature and
electric field, respectively. All surfaces, except the bolt contact surfaces, are cooled
by natural convection in the air surrounding the busbar. You can assume that the
exposed parts of the bolt do not contribute to the cooling or heating of the device.
The electric potential at the upper-right vertical bolt surface is 20 mV and the
potential at the two horizontal surfaces of the lower bolts is 0 V. This corresponds
to a relatively high and potentially unsafe loading of this type of busbar. More
advanced boundary conditions for electromagnetics analysis are available with the
AC/DC Module, such as the capability to give the total current on a boundary. A
more advanced model that includes multiple busbars in an assembly, as shown in
the figure below, can be found in some of the add-on products, including the
AC/DC Module and a few of the LiveLink™ products for CAD.

Graphics

asaslses

Busbar Model Overview

More in-depth and advanced topics included in this tutorial are used to show you

some of the many options available in COMSOL Multiphysics. The following

topics are covered:

+ “Parameters, Functions, Variables, and Couplings” on page 139, where you
learn how to define functions and nonlocal couplings.

e “Material Properties and Material Libraries” on page 144 shows you how to
customize a material and add it to your own material library.
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“Adding Meshes” on page 146 gives you the opportunity to add and define
two different meshes and compare them in the Graphics window.

“Adding Physics” on page 149 explores the multiphysics capabilities by
adding solid mechanics and laminar flow to the busbar model.

“Parametric Sweeps” on page 172 shows you how to vary the width of the
busbar using a parameter and then solve for a range of parameter values. The
result is a plot of the average temperature as a function of the width.
“Parallel Computing” on page 184 gives you an overview of how to solve
on clusters.

“COMSOL Multiphysics Client—Server” on page 188 gives you an
introduction to using the COMSOL Multiphysics client—server mode of
operation.
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Model Wizard

I To open the software, double-click the COMSOL
Multiphysics icon on the desktop.

When the software opens, click the Model Wizard button.
You can also start the Model Wizard at any time by selecting G

New from the File menu. Then, choose Model Wizard. Modl

Wizard
2 In the Select Space Dimension window, click 3D. s
" " Blank Model
@ m - 9 -+ —
20 2D

0 1D

Axisymmetric Axisymmetric

3 In the Select Physics window, expand Heat

Transfer > Electromagnetic Heating. Then,
right-click Joule Heating (> and choose Add
Physics. Click the Study © button.

You can also double-click the selected physics
interface or click the Add button to add
physics.

(Another way to add physics is to open the
Add Physics window by right-clicking the
Component node in the Model Builder window
and selecting Add Physics ;.)

Note that you may have fewer items in your
physics list depending on the add-on
modules installed. The figure on the right is
shown for the case where all add-on modules
are installed.
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Select Physics

(D Recently Used
X AC/DC

) Acoustics

sf Chemical Species Transport

Tl Electrochemistry
== Fluid Flow
Heat Transfer
) Heat Transfer in Solids (ht)
Heat Transfer in Fluids (ht)
& Heat Transfer in Selids and Fluids (ht)
> == Conjugate Heat Transfer
> Radiation
v %! Electromagnetic Heating
= Joule Heating 6
i Induction Heating
& Microwave Heating
>f] Laser Heating
X Pyroelectricity

>
>
>
>
> B3 Electric Discharge
>
>

Added physics interfaces:

% Electric Currents (ec)
IE Heat Transfer in Solids (ht)

v . Multiphysics
= Electromagnetic Heating (emh1)

@ Space Dimension
Help 0 Cancel [+ Done



4 In the Select Study window, click to

select the Stationary = study type. Select Study
Click the Done button. + it Generel Stuies
. . i = Stationary G
Choosing a stationary study means L2 Time Dependent
. ~ ~d Preset Studies for Selected Physics Interfaces
that we are solving for the > oo Heat Transfer in Solcs
» ~dv Electric Currents

steady-state temperature of the o Preset Studies fr Selected Mukiphysics

. [e= F -Stat
busbar when it has reached thermal S

Added study:

equilibrium with its surroundings. I statonery
Added physics interfaces:
% Electric Currents (ec)
IF) Heat Transfer in Solids (ht)
~ iy Multiphysics
% Electromagnetic Heating (emh1)

@ Physics
[ 7 B eiar\cel [ pone G
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A preconfigured Study has solver and equation settings adapted to the selected
combination of physics interfaces; in this example, Joule Heating.

Note that you may have fewer study types in your study list depending on the
installed add-on modules.

A physics interface is a user interface for a specific physics area that
defines the equations together with settings for mesh generation,
solvers, visualization, and results. A multiphysics interface is a
combination of physics interfaces together with multiphysics couplings.
The Joule Heating multiphysics interface consists of two physics
interfaces, Electric Currents and Heat Transfer in Solids, together with the
multiphysics coupling Electromagnetic Heating that appear in the
Multiphysics branch. This method of mixing physics is very flexible and
makes it possible to use all the capabilities of the participating
single-physics interfaces for multiphysics purposes.

Model Builder

- S Etv Elv Siv v

~ & Untitled.mph (root)
v () Global Definitions
Fi Parameters 1
2 Materials
~ [l Component 1 {comp1)
» = Definitions
¥ Geometry 1
2 Materials
~ +\_ Electric Currents {ec)
i Current Conservation 1
%= Electric Insulation 1
= Initial Values 1
~ I[F Heat Transfer in Solids (ht)
= Solid 1
= Initial Values 1
%= Thermal Insulation 1
v .{‘,’3 Multiphysics
% Electromagnetic Heating 1 (emh 1)
A Mesh 1
v o Study 1
[= Step 1: Stationary

> [El Results
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Global Definitions

To save time, it is recommended that you
load the geometry from a file. In that case,
you can skip to “The Auto Completion and
Find Tools” on page 89.

On the other hand, if you want to draw the
geometry yourself, the Global Definitions ‘
node is where you define the parameters.
First, complete steps 1 through 3 below to |
define the parameter list for the model.
Then, follow step 4 before skipping to the
section “Appendix A — Building a
Geometry” on page 217.

The Global Definitions node @ in the Model
Builder window stores Parameters, Variables, wbb
and Functions with a global scope. The

model tree can hold several model

components simultaneously, and the

definitions with a global scope are made
available for all components. In this particular example, there is only one
Component node in which the parameters are used. If you wish to limit the scope
to this single component, you could define, for example, Variables and Functions
in the Definitions subnode, available directly under the corresponding Component
node. However, no Parameters can be defined here because Parameters that are
defined under Global Definitions arc always global.

Since you will run a parametric study of the geometry later in this example, define
the geometry using parameters from the start. In this step, enter parameters for
the length of the lower part of the busbar, L; the radius of the titanium bolts,
rad_1; the thickness of the busbar, tbb; and the width of the device, wbb.

You will also add the parameters that control the mesh, mh; a heat transfer
coefticient for cooling by natural convection, htc; and a value for the voltage
across the busbar, Vtot.

I Under Global Definitions @ , choose Parameters » . In the Parameters table, click
the first row under Name and enter L.

2 Click the first row under Expression and enter the value of L, 9[cm]. You can
enter the unit inside the square brackets.

3 Continue adding the other parameters: rad_1, tbb, wbb, mh, htc, and Vtot
according to the Parameters list below. It is a good idea to enter descriptions for
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variables in case you want to share the model with others and for your own
future reference.

~ Parameters

" MName Expression Value Description
G L Glcm] G 0.09 m Length

rad_1 8[mm] 0.006 m Bolt radius

thb 5[mm] 0.005 m Thickness

whb 3lem] 0.05m Width

mh 3[mm] 0.003 m Maximum element size
G htc S5[W/m*2/K] 5 W/ m~K) Heat transfer coefficient

Vot 20[mV] 0.02V Applied voltage

4 Click the Save button © on the Quick Access Toolbar and name the model
busbar.mph or use the corresponding File menu option. Then, go to “Appendix
A — Building a Geometry” on page 217.
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The Auto Completion and Find Tools

The model tree contains a large number of parameters and variables. To make it
casier to find them, you can use the auto completion and find tools as described
below.

AUTO COMPLETION

You can use Ctrl+Space for auto completion of parameter and variable names. For
example, in the Parameters table, if you click an empty Expression ficld and then
press Ctrl+Space, you will get a list of parameters and variables, as shown in the
figure below.

mh 3[mm] 0.003 m Maximum element size
htc S5[W/m*2/K] 5 W/ m~K) Heat transfer coefficient
Vot 20[mV] 0.02V Applied voltage
my_par

~  Model

~ Parameters
L - Length - m
Vtot - Applied voltage - V
htc - Heat transfer coefficient - W/(m*K)
mh - Maximum element size - m
rad_1 - Bolt radius - m
thb - Thickness - m

. whb - Width - m
t - ~ Component 1 (compT)
Marme: > Functions
my_par ~ Builtin
. > Mathematical constants
Expression:

> Mathematical functions
> Operators
> Physical constants

This functionality is also available for other edit fields in the Model Builder window.
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FIND

To find parameters, variables, as well as other strings in the model tree, you can
click the Find button in the Quick Access Toolbar or use the keyboard shortcut
Ctrl+FE. This opens the Find and Replace window.

Graphics Find and Rep

aA fa - '.v EH ~

Contains: current ® | O Search
Replace with: & Replace =
Mode Type Text Replace | Preview
}_ Electric Currents (ec) Mode label  Electric Currents [l Electric =
+\_ Electric Currents (ec) Mode type Electric Currents Electric Currents
w X_ Electric Currents (ec)
{& Current Conservation 1 Mode label  Current Conservation 1 (| Conservation 1
= Current Conservation 1 Modetype  Current Conservation Current Conservation
' Electromagnetic Heating 1 (emh1) Setting Electric Currents (ec) Electric Currents (ec)
A Mesh 1 Table cell Electric Currents (ec) Electric Currents (ec)
~ ~db Study 1
[= stationary Table cell Electric Currents (ec) Electric Currents (ec)
[= Stationary Table cell Electric Currents (ec) (| Electric s (ec)

The results of the search are displayed below the Contains and Replace with fields.
The results in this example are coming from the completed busbar model by
searching for the string current.

You can double-click any of the rows in this window to open the corresponding
Settings window.
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Geometry

This section describes how the geometry can be opened from the Application
Libraries. The physics, study, parameters, and geometry are included with the
model file you are about to open.

I Select Application Libraries [fi from the

Windows drop-down menu in the Home tab. [
You can also access the Application Libraries el et
v Desktop ~

from the File menu.
1 Add Physics

Add Multiphysics
Add Study

n—li-l] n—§’ s

Result Templates

Add Material from Library

Material Browser

Application Libraries

o

SN=ME

Part Libraries

i

= Add-in Libraries

2 In the Application Libraries tree
under COMSOL Multiphysics > Application Libraries
Multiphysics, sclect busbar_geom.

(# Refresh [J] Update COMSOL Application Libraries ) Application Gallery

To open the file, you can: | search
. v [3 COMSOL Multiphysics
- Double-click the name » % Applications
> Acoustics
i _hi - : > [l Chemical Engineering
- Right-click and select an option e ey
from the menu > ] Difusion

> [l Electromagnetics
> [fi] Equation Based

- Click one of the buttons under » ] Fluid Dynarmies

> [l Geometry Tutorials
the tree > [l Geophysics
> ] Heat Transfer
1 > [ffl Meshing Tutorials
You can select No if prompted to L g
save Untitled.mph. ® busbar
® busbar_assembly
The geometry in this file is G R
parameterized. In the next few o e comvecn
steps, we will experiment with o themilatwerh
. i ermal_actustor_simplifie
different values for the width ® thermsl_controller rom

> [l Structural Mechanics

parameter, wbb. il

Run Application E Open

@ Open PDF Document

Help e Close

91



3 Under Global Definitions @, click the

Parameters node - .

~ Parameters

L] .
In the Settings window for Parameters, Name | Expression Value
. . . L Glem] 0.09 m
click in the Expression column for the
rad_1 8[mm] 0.006 m
wbb parameter and enter 10[cm] to thb S[mm] 0.005m
change the value of the busbar width. e whb 0.1m
4 In the Model Builder window, under mh Slmml. 0003 m
lick th htc SW/mA2K] |5 WM
Component | > Geometry I, click the Vit 200mV] o

Form Union node = and then the Build

All button in the Settings window m to

rerun the geometry sequence. You can also use the ribbon and click Build All
from the Geometry group in the Home tab.

Model Builder
+— ® St~ El~
'.v

~ & Untitled.mph (root)
Global Definitions
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P
~ (5
L5l

<
< v il

P

Parameters 1
Materials

Component 1 (comp 1)

H

Definitions

Geometry 1

E Work Plane 1 (wp1)
Extrude 1 {ext1)
Work Plane 2 (wp2)
u Extrude 2 (ext2)
Work Plane 3 (iwp3)
Extrude 3 (ext3)
Form Union (fin)

7 m |:|’._|o

alm

Settings

Form Union/Assembly
[® Build Selected ~ [ Build All G

Label: Form Union =

~ Form Union/Assembly
Action:

Form a union =
Repair tolerance:

Automatic =

~ Information



5 In the Graphics toolbar, click the Zoom Extents button (3 to see the wider busbar
in the Graphics window.

Graphics G

Qa @~ @@l ke

Zoom Extents

wbb = 5cm wbb = 10cm

6 Experiment with the geometry in the Graphics window:

- To rotate the busbar, click and drag the pointer anywhere in the Graphics
window.

- To move it, right-click and drag.
- To zoom in and out, click the scroll wheel, continue holding it, and drag.

- To get back to the original position, click the Go to Default 3D View button ...
on the toolbar.

Graphics
Q Q@ >~ & &[] =

Go to Default View

7 Return to the Parameters table and
change the value of wbb back to 5[cm].

L] .
8 In the Model Builder window, click the Rl Exprcrion palbe

~ Parameters

. . L 9 0.09
Form Union node & and then click the feml =
. rad_1 8[mm] 0.006 m
Build All button & to rerun the geometry G thb S[mm] DT
sequence. whb 0.1m
9 On the Graphics toolbar, click the Zoom mh 3mm] 0.005m
hte SIWm S 27K] 5 W/ (m*K)

Extents button .
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10 If you built the geometry yourself, you are already using the file busbar.mph, but
if you opened the file from the Application Libraries window, select Save As from
the File menu and rename the model busbar.mph.

After creating or importing the geometry, it is time to define the materials.

94 |



Materials

The Materials node = stores the material properties for all physics and geometrical
domains in a Component node. The busbar is made of copper and the bolts are
made of a titanium alloy. Both of these materials are available from the Built-In
material database.

I In the Model Builder window, right-click Component | > Materials :: and select
Add Material from Library :. By default, the window will open on the
right-hand side of the desktop. You can move the window by clicking on the
window title and then dragging it to a new location. While dragging the
window, you will be presented with several options for docking.

~ [l Component 1 {comp1)
» = Definitions

¥ Geormnetry 1

G = Materials

*_ Electric Cu| “si  Add Material from Library

oo

I_ﬁ Heat Trans| B Browse Materials
e Multiphysi

oy phy:

A Mesh 1 == Blank Material

w

The Materials node will show a red x in the lower-left corner if you try to
solve without first defining a material, which we will go over in the next
few steps.

2 In the Add Material window,
expand the Built-In materials Add Material
folder and locate Copper. (1) Add to Global Materials * -+ Add to Component =
Right-click Copper :: and select
Add to Component I.

Search

22 Aluminum
24 Arnerican red oak

Alternatively, YOU can 2= Beryllium copper UNS C17200
double-click. % Brick
z= Castiron
A Copper node is added to the i Concrete
Model Builder window. S: Copper

25 FR4 (Circ ) Add to Global Materials

3 In the Add Material window, G i Glass (9U j= Add to Component 1 (comp1)
scroll to Titanium beta-21S in the & Granite
Built-In material folder list.
Right-click and select Add to

Component |.

2 High-strength alloy steel
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4 In the Model Builder window, collapse the Geometry | node ' to get an overview
of the model.

v 4 busbar_geom.mph (root)
v ({7} Global Definitions
P Parameters 1
= Materials
v @ Compenent 1 {comp 1)
Definitions
G » Geometry 1
~ fzi Materials
> fi& Copper{matl)
» g Titanium beta-215 (mat2)
> X®_ Electric Currents fec)
» |IE Heat Transfer in Solids (ht)
> . Multiphysics
£ Mesh 1
> ~do Study 1

» .@. Results

At this stage, the Materials node may display one or more red x symbols
depending on the active selection. These will disappear in the next few steps.

5 Under the Materials node, click Copper :: .

v [l Component 1 {comp 1)
» = Definitions
Geometry 1

v iga Materials

c » = Copper (matl)

> oig Titanium beta-215 (mat2)

6 In the Settings window for Material, examine the Material Contents section.

Property Variable Value Unit Property group
[ Electrical conductivity sigma_iso ; si... | 5.998e7[5/m] S‘m Basic
[ | Heat capacity at constant pressure | Cp 3850/ (kg™ K)] 1/ (kg-K) Basic
[ | Relative permittivity epsilonr_so.. |1 1 Basic
[ Density rho 8960[kg/m"3] kg/m* Basic
[  Thermal conductivity k_iso ; kii = k_.. 400[W/(m*K]] W/ (m-K) Basic
Relative permeability mur_iso; mur... 1 1 Basic
Coefficient of thermal expansion alpha_iso; al.. | 17e-6[1/K] 1K Basic
Young's medulus E 110e9[Pa] Pa Young's medulus and Poissen's ratic
Poiszon's ratio nu 0.35 1 Young's medulus and Poissen's ratic
Reference resistivity rhol 1.72e-8[chm*m] (:m Linearized resistivity
Resistivity temperature coefficient | alpha 0.0038[1/K] /K Linearized resistivity
Reference temperature Tref 298[K] K Linearized resistivity

The Material Contents section has useful information about the material
property usage of a model. Properties that are both required by the physics and
available from the material are marked with a check mark . Properties
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required by the physics but missing in the material are marked with a warning
sign 4 . A property that is available but not used in the model is unmarked.

The Coefficient of thermal expansion, Young’s modulus, and Poisson’s ratio
properties in the table above are not used but will be needed later when
heat-induced stresses and strains are added to the model.

Because the copper material is added first, by default, all parts have copper
material assigned. In the next step, you will assign titanium properties to the
bolts, which override the copper material assignment for those parts.
7 In the Model Builder window, click
Titanium beta-21S§ = . “ T Component 1 {comp1)
I = Definitions

b Geometry 1
4 EE Materials

I 228 Copper (matl)
G I* ig= Titanium beta-215 (mat2)

[ +\_ Electric Currents {ec)
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8 Select All Domains from the Selection list and then click domain 1 in the list. Now
remove domain 1 from the selection list.

Settings Graphics
Material Q Q- @
Label:  Titanium beta-215 E

Mame:  mat2

Geometric Entity Selection

Geometric entity level: Domain =
Selection: @ == All domains -
i ; s T+
(=0
2 E |—
2 o &
4 & = Remove from Selection
5

To remove a domain from the selection list (or any geometric entity, such as
boundaries, edges, or points), you can use either of these two methods:

- Click domain 1 in the selection list found in the Settings window for Material.
Then, click the Remove from Selection button — or press Delete on your
keyboard.

- Alternatively, in the Graphics window, click domain 1 to remove it from the
selection list.

@ The domains 2, 3, 4, 5, 6, and 7 are highlighted in blue.
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You can

enable and disable material color and texture from the Color

toolbar button in the Graphics window. To render the copper components
using a realistic color, select Show Material Color and Texture. This will also
enable material-true rendering of other materials. Here, you can also
enable coloring of selections by selecting Show Selection Colors, as well as
change the color theme used in the Graphics window.

= 5
B -

@ o
"

S-@ae |
Default from Preferences (Default)
Basic
Classic
ClassicDark
COMSOL
Dark
DarkSelection
Default
Light
LightSelection
RYB
RYBDark
Show Selection Colors

Show Material Color and Texture
|

The figures below show the Settings and Graphics windows corresponding
to a selection where a color (yellow) other than the default has been used.

There is also a second selection (not shown) with another color (green).
Settings RS 0 e BEEmIER (09 100 Oo B
Explicit
Label: T bolts B

v Input Entities

Geometric entity level: Domain -
2 Bl
—IB m
2 @
5
6
7
[ All domains

v Output Entities

Selected domains = v

v Color

Color:
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Note that to see the color while creating a selection, you need to click the Suppress
Selection Highlight button in the Graphics toolbar. For more information on
Selections, see page 152.

To further increase the level of realism in material rendering you can enable
Environment Reflections from the Scene Light menu button in the Graphics toolbar.
From this menu you can choose an Indoor Environment or Outdoor Environment.
You can also enable effects such as Direct Shadows and Floor Shadows.

The corresponding image, known as a skybox image, will be reflected in
the material, thereby increasing the level of realism. This is particularly
visible when the material is a metal, as shown in the figure below.

By selecting the Show Skybox option you can display the corresponding
skybox image used for the environment reflection.

For best results you will need a graphics card that supports OpenGL. See
also “Graphics and Plot Windows” on page 16. Not all of these
visualization options will be used in the remainder of this example.
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9 In the Settings window

for Material, be sure to Settings

: o Material

inspect the Material

Contents section for the Label:  Titanium beta-215 5
titanium material. All of Name  mat2

the properties used by
the physics should have a

Geometric Entity Selection

Geometric entity level: Domain =
check mark .
Selection: = Manual =
: .
3 E —
g @
5 <.
6
7

> Override
> Material Properties

~ Material Contents

Property Variable | Value Unit
e =4 Electric conductivity sigma... | 7.407e3[5/m] | 5/m
=4 Heat capacity at constant pressure |Cp TI00/ (kg k)] | )i (kg-K)
[ | Relative permittivity epsilo.. |1 1
[ | Density rtho 4840[kg/m... |kg/m®
[ | Thermal conductivity k_iso s | TS[W/m*K)] | W/ (me...
Relative permeability mur_i... |1 1
Coefficient of thermal expansion alpha_..| 7.06e-6[1/K] |1/K
Young's modulus E 105[GPa] Pa
Dniccan's ratin nu na2 1

10 Close the Add Material .
window cither by clicking the Add Material @

. : : Add to Global Materials « Add to Component -
icon in the upper-right corner or
o . Search
by clicking the Add Material =
. N » i=i Recent Materials
toggle button i in the Materials > T Material Library

group of the ribbon Home tab. > 3 Built-in

| 101



Physics and Boundary Conditions

Next, you will inspect the physics domain settings and set the boundary conditions
for the heat transfer problem and the conduction of the electric current.

In the Model Builder window, examine the default physics nodes of the
multiphysics interface for Joule Heating. First, collapse the Materials node. Then,
click the arrows next to the Electric Currents x , Heat Transfer in Solids =, and
Multiphysics .z, nodes to expand them.

Model Builder Settings
— ® Etv Elv - B~ Electromagnetic Heating
¢ Label:  Electromagnetic Heating 1 =

v & busbar_geom.mph (root)
@) Global Definitions Name: |emh1

~ @
Fi Parameters 1
2 Materials

~ [ Component 1 (comp1) Selection: & All domains =
>
>
>
v

~ Domain Selection

= Definitions 4
Geometry 1 O=]
2 Materials

+\_ Electric Currents {ec)

'ﬁ'@@ o

s Current Conservation 1

%= Electric Insulation 1

L R e N

= Initial Values 1
5] Heat Transfer in Solids (ht)
i Solid 1 ~ Boundary Selection
= Initial Values 1
%= Thermal Insulation 1 Selection: m» All boundaries -

<

<

iy Multiphysics

% Electromagnetic Heating 1 (emh 1) E=]
A5 Mesh 1
» ~db Study 1

> [El Results

L= T R e
& PE 4
"'T

The D in the upper-left corner of a node’s icon (=) means it is a default node.

The equations that are being solved are displayed in the Equation section of the
Settings windows of the respective physics nodes.

The default equation form, for example, whether it should be a stationary or
transient equation, is inherited from the study added in the Model Wizard. In this
case, the study is stationary and the equation form is the stationary version of the
equation system for Joule heating. For the Joule Heating multiphysics interface,
the equation system has the temperature and electric potential as dependent
variables.
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To always display the equations in the Settings windows, click the Show
More Options button ( =) on the Model Builder toolbar and sclect Equation
Sections so that a check mark appears next to it.

The Heat Transfer in Solids and
Electric Currents nodes have the settings
for heat conduction and current
conduction, respectively.

Under the Electric Currents node, the
Current Conservation node represents the
conservation of electric current at the
domain level and the Electric Insulation
node contains the default boundary
condition for Electric Currents.

Under the Heat Transfer in Solids node,
the domain level Solid node represents the
conservation of heat and the Thermal
Insulation node contains the default
boundary condition for Heat Transfer in
Solids. The heat source for the Joule

~ @ busbar_geom.mph (root)
v () Global Definitions
Fi Parameters 1
2 Materials
Component 1 (comp 1)
= Definitions
Geometry 1
2 Materials
+\_ Electric Currents {ec)
i Current Conservation 1

%= Electric Insulation 1

€
IR

= Initial Values 1
[T Heat Transfer in Solids (ht)
= Solid 1

= Initial Values 1

<

%= Thermal Insulation 1

<

.{;3. Multiphysics

% Electromagnetic Heating 1 (emh 1)
A Mesh 1
» ~db Study 1

> [El Results

heating effect is set in the Electromagnetic Heating node under the Multiphysics
node. The Initial Values node, found in both the Electric Currents and Heat Transfer
in Solids interfaces, contains initial guesses for the nonlinear solver for stationary
problems and initial conditions for time-dependent problems.

Now, define the boundary conditions.

I Right-click the Heat Transfer in Solids node . In the second section of the
context menu — the boundary = section — select Heat Flux.

> igi Materials
~ +\_ Electric Currents {ec)

&= Current Conservation 1
%= Electric Insulation 1
= Initial Values 1

) Heat Transfer in Solids (ht)

<

o

o= Solid 1 I= Solid

= Initial Values 1 = Fluid

o .

m Thermal Insulation 1 = Heat Source

v iy Multiphysics -
* Electromagnetic Heatin (= Initial Values

A Mesh 1 Specific Media
» ~db Study 1
> {El Results m  Temperature
= Thermal Insulation
m»  Heat Flux
= Symmetry

Domain section

~L—Section divider

Boundary section
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2 In the Settings window for Heat Flux,

. . ~ Boundary Selection
select All boundaries from the Selection

list. Selection: mw All boundaries -
Assume that the circular bolt boundaries ;| :::T;:Zlndanes |i G
are neither heated nor cooled by the 3 B &
surroundings. 4 =

In the next step, you will remove the 2

selection of these boundaries from the

heat flux selection list, which leaves them

with the default Thermal Insulation boundary condition for the Heat Transfer in
Solids interface.

3 Rotate the busbar to view the back. Move the mouse pointer over one of the
circular titanium bolt surfaces to highlight it in green. Click the bolt surface to
remove this boundary selection from the Selection list. Repeat this step to
remove the other two circular bolt surfaces from the selection list. Boundaries
8, 15, and 43 are removed.

Cross-check: Boundaries 8, |15, and 43 are removed from the
Selection list.

01

104 |



4 In the Settings window for Heat Flux, in
the Heat Flux section, sclect Convective
heat flux as the Flux type. Enter htc in RIS
the Heat transfer coefficient ficld, /. gy | Convective heat flux v

Heat transfer coefficient:

~ Heat Flux

This parameter was either entered in
the Parameter table in “Global

User defined =

Heat transfer coefficient:

Definitions” on page 87 or imported h i /(2K
with the geometry. External temperature:
T et User defined =
293.15[K] K

More advanced boundary conditions for heat transfer analysis are
available with the Heat Transfer Module. Examples include the
capability to give the total deposited power or to set boundary
conditions for common natural convection scenarios such as for a
horizontal or vertical wall.

Continue by setting the boundary conditions for the electric current according
to the following steps:

5 In the Model Builder window, right-click the Electric Currents node x . In the
second section of the context menu — the boundary section — select Electric
Potential. An Electric Potential = node is added to the model tree.
~ [l Component 1 {comp1)

» = Definitions

Geormnetry 1

2 Materials

¢ v o

2% Electric Currents (ec) = Current Conservation

T Current Conservation

b

‘-
mw Electric Insulation 1

== External Current Density

= Initial Values 1 == Force Calculation
[ Heat Transfer in Solids (hi |z
= Solid 1
= Initial Values 1
S Thermal Insulation 1 | I Terminal

= Heat Flux 1 = Initial Values

<

Current Conservation, Piezoresistive

= Current Source

<

iy Multiphysics

| Electromagnetic Heat ™= Ground
A5 Mesh 1 = Electric Potential e
>~ Study 1 m  Electric Insulation
> [El Results
= MNormal Current Density
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6 Move the mouse pointer over the circular face of the single titanium bolt to
highlight it and then click to add it (boundary 43) to the Selection list.

7 In the Settings window for Electric
Potential, enter Vtot in the Electric g ElectiiclBolential

pote ntial ficld. Electric potential:

. Vo Wi
The last step is to set the surfaces of the o [hot !

two remaining bolts to ground.

8 In the Model Builder window, right-click the Electric Currents node x . In the
boundary section of the context menu, select Ground. A Ground node = is
added to the model tree. The model tree node sequence should now match this
figure.

~ *_ Flectric Currents {ec)

It
= Current Conservation 1

%= Electric Insulation 1

= Initial Values 1

o Electric Potential 1

¥y Ground 1 @
v IIE Heat Transfer in Solids (ht)

i Solid 1

= Initial Values 1

%= Thermal Insulation 1

' Heat Flux 1
v ifﬂ Multiphysics

x| Electromagnetic Heating 1 {femh 1)

The “warning” attribute displayed on the Ground node indicates that its
boundary selection is empty. The next step will be to select boundaries.

106 |



9 In the Graphics window, click one of the remaining bolts to add it to the
Selection list.

G Cross-check: Boundaries 8 and 5.

Repeat this step to add the last bolt. Boundaries 8 and 15 are added to the
selection list for the Ground boundary condition.

10 On the Graphics toolbar, click the Go to Default View button ...

Graphics
Qa@- @@ [Bxksls

Go to Default View

More advanced boundary conditions for electromagnetics analysis are
available with the AC/DC Module, such as the capability to give the total

current on a boundary.

COMBINING PHYSICS INTERFACES MANUALLY

As an alternative to using the preconfigured Joule Heating multiphysics interface,
you can manually combine the Electric Currents and Heat Transfer in Solids
interfaces. For example, you can start by setting up and solving the model for
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Electric Currents and then subsequently add Heat Transfer in Solids. In that case,
you right-click the Multiphysics node to add the required multiphysics couplings.

~ +\_ Electric Currents {ec)
&= Current Conservation 1
%= Electric Insulation 1
= Initial Values 1
mw Electric Potential 1
m Ground 1

~ I[F Heat Transfer in Solids (ht)
= Solid 1

e Initial Values 1

%= Thermal Insulation 1
mw Heat Flux 1
'é:} Multiphysics

A Mesh 1 Electromagnetic Heating
> "R Study 1 Thermoelectric Effect
> [El Results

Equilibrium Discharge Heat Source

Equilibrium Discharge Boundary Heat Source

Bf2EK

Help

As an alternative, you can click the Add Multiphysics button in the Physics tab on
the ribbon and select a suggested multiphysics coupling in the Add Multiphysics
window.

@ ¥ | %  Add Multiphysics
Heat Transfer  Add Add + Add to Component

inSolids v Physics | Multiphysics > (D) Recently Used

Physics v ¥} AC/DC
v Electromagnetic Heating
X Joule Heating
v Heat Transfer
v %\ Electrormagnetic Heating
_ X Joule Heating
Thermoelectric Effect

Select the physics interfaces you want to couple

Physics Couple
+\_ Electric Currents (ec) =4
51| Heat Transfer in Solids (ht) =4

Multiphysics couplings in study

Studies Solve
Study 1 =4
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Mesh

The simplest way to mesh is to create an unstructured tetrahedral mesh, which is
perfect for the busbar model. Alternatively, you can create several meshing
sequences, as shown in “Adding Meshes” on page 146.

A physics-controlled mesh is created by default. In most cases, it is possible
to skip to the Study node and just solve to get a solution. For this exercise,
the settings are investigated in order to parameterize the mesh settings.
I In the Model Builder window, click the :
Mesh | node 4 . In the Settings window 33[}'“95
for Mesh, sclect User-controlled mesh 8 Build Al
from the Sequence Type list.

2 Under Mesh 1, click the Size node A].

Label:  Mesh 1 =
. . . v Sequence Type

Depending on your earlier choices, there

may be an additional Size 1 node G
controlling the mesh on the boundary.

In that case, delete that Size | node.

Physics-controlled mesh =

| User-controlled mesh

Physics-controlled mesh

Element size: Maormal =

v S Mesh 1

G A% Size

Free Tetrahedral 1
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3 In the Settings window for Size, in the .
Element Size section, click the Custom Settings

i
button. 128 a
%] Build Selected [E§ Build All

Under Element Size Parameters, enter:

Label: Size =

- mhin the Maximum element size ficld.

Note that mh is 3 mm — the value Element Size

entered earlier as a global parameter. Calibrate for:

By using the parameter mh, element General physics -

sizes are limited by this value. O Predefined  Mormal
- mh-mh/3 in the Minimum element size G e —

field. The Minimum element size is ~ Element Size Parameters

Slightly smaller than the maximum Maximum element size:

size. mh m

Minimum element size:

- 0.2 1n the Curvature factor ficld. The
Curvature factor determines the

mh-mh/3 m

Maximum elerment growth rate:

number of elements on curved 15
boundaries; a lower value gives a Curvature factor:
finer mesh. 02
Resolution of narrow regions:
The other two parameters are left 05
unchanged.

The Maximum element growth rate

determines how fast the elements should grow from small to large over a
domain. The larger this value is, the larger the growth rate. A value of 1 does
not give any growth.

For Resolution of narrow regions, a higher value will generally result in a finer
mesh.

The asterisk (*) that displays in the upper-right corner of the Size node 2|
indicates that the node is being edited.
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window for Size to create the mesh,

ings

the Sett

=

4 Click the Build All button
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You can also click Build Mesh in the Home tab of the ribbon.



Study

I To run a simulation, in the Model Builder
window, right-click Study | -« and choose

Compute =. You can also press F8 or click G - Stu1FrEETE“EhEd“'1
Compute on the ribbon Home tab. > (@ Results | = Compute
The Study node ~» automatically defines a Parametric Sweep
solution sequence for the simulation based 769 Function Sweep
on the selected physics and study type. In is Material Sweep

this case, the simulation only takes a few
seconds to solve. During the solution
process, two Convergence plots are generated
and are available from tabs next to the
Graphics window. These plots show the convergence progress of the different
solver algorithms engaged by the Study.

Study Reference

g
b=
b
[=3=1

Combine Selutions
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Results

By default, in the Results node, four plot groups
are generated: a Volume plot of the Electric
Potential, a Multislice and Streamline Multislice plot
of the Electric Field Norm (the magnitude of the
clectric field) and Electric Field, and a Volume plot
of the Temperature.

Click Results > Temperature @ to view the
Temperature plot in the Graphics window. The
temperature difference in the device is less than 10
K due to the high thermal conductivity of copper
and titanium. The temperature variations are
largest in the top bolt, which conducts double the
amount of current compared to the two lower

v B Results

» i Datasets
2% Derived Values
] Tables
v | Electric Potential (ec)
& volume
VB Electric Field Morm (ec)
5 Multislice 1
» 5 Streamline Multislice 1
v Nl Temperature (ht)
) volume
Export
[# Reports

£

bolts. The temperature is substantially higher than the ambient temperature of

293 K.

I Click and drag the image in the Graphics window to rotate and view the back of

the busbar.

Surface: Temperature (K)

2 In the Graphics toolbar, click the Go to Default 3D View button ...

You can now manually set the color table range to visualize the temperature

difference in the copper part.

3 In the model tree, expand the Results > Temperature node @ and click the

Volume node m.

| 113



4 In the Settings window for Volume, click Range to expand the section. Select the
Manual color range checkbox and enter 324 in the Maximum field (keep the
default for Minimum and replace the default for Maximum). Click the Plot button
in the Settings window for Volume.

Settings
Volume
4 Plot

Label: Volume1 =

> Data

» Expression - =pv =fv
> Title

~ Range

Manual color range

Minimum: 32242986

G Maximum: 324

5 On the Graphics toolbar, click the Zoom Extents button |2/ to view the updated
plot.

6 Click and drag in the Graphics window to rotate the busbar and view the back.

o

Surface: Temperature (K) Surface: Temperature (K)
™

324 328

The temperature distribution is laterally symmetric with a vertical mirror plane
running between the two lower titanium bolts and cutting through the center of
the upper bolt. In this case, the model does not require much computing power
and you can model the entire geometry. For more complex models, you can
consider using symmetries to reduce the computational requirements.

Select Go to Default View on the toolbar in the Graphics window -1,
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Then, generate a Surface plot that shows the current density in the device.

| In the Model Builder window,
right-click Results & and add a 3D Plot
Group . In the Label ficld, enter
Current Density to give the plot
group a descriptive name. Right-click

B.85
854

Z Derived Values

Tables

il Electric Potential (ec)
il Electric Field Norm (ec)
Temperature (ht)
Current Density | —,

. Plot
Current Density (former 3D Plot Group = :"Wt ol |
# Reports otin
4)w and add a Surface node =.
a Yolume
@ Arrow Volume
™ Ssurface
i slice
2 In the Settings window for Surface _
. . 4 Electric Currents
under Expression, click the Replace 4 Currents and charge
Expression button =i. Go to Model > ecn) - Normal current density - A/m?
. .norm)J - Current densi - Afm?
Component | > Electric Currents > Currents Scnese = CosENE deneiyosn - e
ec.rhog - Space charge density - C/m

and charge > ec.norm]) - Current density ec.thogs - Surface charge density - C/m?
norm - A/m? and double-click or press
Enter to select.

ec.normJ is the variable for the

magnitude, or absolute value, of the EgExpiession
current density vector. You can also type Expression:
ec.normJ in the Expression ficld when G ec.norm)
you know the variable name or, L
alternatively, use the auto completion
functionality by typing norm and then
pressing Ctrl+Space to get a variable
name suggestion.

« > ahe e

Afm"‘z -
[] Description:

Current density norm

3 Click the Plot button = .

The plot that displays in the Graphics window is almost uniform in color due to
the high current density at the contact edges with the bolts. The next step is to
manually change the color table range to visualize the current density
distribution.
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4 In the Settings window for Surface under Range, sclect the Manual color range
checkbox. Enter 1e6 in the Maximum field and replace the default.

~ Range

G Manual color range

Minimurm:  0,19062
Maximum:  1eé

5 Click the Plot button @ .

The resulting plot shows that the current takes the shortest path in the
90-degree bend in the busbar. Notice that the edges of the busbar outside of
the bolts are hardly carrying any current.

Surface: Current density norm (A/m?)
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6 Click and drag the busbar in the Graphics window to view the back. Continue
rotating the image to see the high current density around the contact surfaces
of each of the bolts.

Surface: Current density norm (A/m?)

01 0.04

L
When you are done, click the Go to Default View button ... on the Graphics toolbar.
GETTING THE MAXIMUM AND MINIMUM TEMPERATURE

You can easily obtain the maximum and minimum temperature values in the
busbar, including their locations.
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I Right-click Results > Temperature @ and sclect More Volume Plots > Max/Min

Volume.

» ~db Study 1

v {E| Results

H Datasets

2% Derived Values

EH Tables

> §@ Electric Potential (ec)

> §@ Electric Field Norm (ec)

~ |l Temperature (ht)
a Yolume 1
Current Density Plot In

Plot

> il

F8

Export
[# Reports

Volume

Arrow Volume

Surface
Slice

Isosurface

UEED N0

Arrow Surface

Line

)
=)

Contour
Streamline
Arrow Line

Mesh

ABE 4§

Annotation

More Volume Plots
More Surface Plots
More Line Plots

More Point Plots

% Add Image to Export

()

Scatter Volume
Coordinate System Volume
Mazx/Min Volume
Isosurface Series

Function

2 In the Settings window for Max/Min Volume under Expression, click the Replace
Expression button =i. Go to Model > Component | > Heat Transfer in Solids >
Temperature > T - Temperature - K and double-click or press Enter to select. You
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can also search for Temperature in the search field above the tree of
postprocessing variables or manually enter T. Click Plot.

v Expression —+ =~ =h

Expression:
v
> Geometry
> Mesh
> Electric Currents
~  Heat Transfer in Solids
> Domain fluxes
> Heat and energy balance
> Heat sources
> Material properties
v Temperature

> Weighted average temperature

T- Temperature - K G
ht.gradTmag - Temperature gradient magnitude - K/m

> Temperature gradient - K/m
> Velocity and pressure
v Builtin
> Mathematical constants

The maximum and minimum values are plotted in the Graphics window and
their locations and values are displayed in the Maximum and minimum values
table. The values may vary a bit depending on the version you are running. For
a finer mesh the results will be the same regardless of version.

Graphics
aa@~-[ Lrxkzizn ¢ @ <o BHE £

Volume: Temperature (K) Max/Min Volume: Temperature (K) ®

01

320

progress  Log  Maximum and Minimum Values
WSS @e \ @ EMOL BEE B8 -

x ly 2 Tempersture (0
0063272.-005000000000 32243
010500 |-0.024460/0.052799330.44

As an alternative to the method of plotting the maximum and minimum values
described above, you can use the Derived Values node or an Evaluation Group for a
pure numerical output. The following steps show how to use Derived Values.

3 In the Results section of the model tree, right-click the Derived Values = node
and select Maximum > Volume Maximum ..
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4 In the Settings window for Volume Maximum, under Selection, choose All
domains.

5 In the first row of the Expression table, enter T (unless it is automatically filled
out) for the temperature and click Evaluate at the top of the Settings window.

Model Builder Settings
— ® Etv Elv - B~ Volume Maximum
e = Evaluate «
v & busbar.mph (root) Label: Volume Maximum 1 =
» () Global Definitions
> [l Compenent 1 (comp1) v Data
» ~db Study 1
v {E| Results Dataset: Study 1/Solution 1 (sol1) v F
> H Datasets
v 2% Derived Values ~ Selection
max Volume Maximum 1
> E Tables Selection: & All domains -
> §@ Electric Potential (ec) N
> Tl Electric Field (ec) ; g —
~ |8 Temperature (ht) 3 El
2 volume 1 4 &
25 Max/Min Volume 1 . i
> §@ Current Density 3

[# Reports -
~ Expressions + v =

L . X -
Expression Unit Description

e T K Temperature

The resulting maximum temperature is shown in Table 1.

Messages Progress Log Table 1
1= | BES 85 B5D & |\ @
E= | eaz MM e g3 085 @ .0 B |

Temperature (K}
33043 G
As a next step, you can create a model thumbnail image.

CREATING MODEL IMAGES FROM PLOTS

With any solution, you can create an image to display when browsing for model
files. After generating a plot, click the corresponding plot node in the Model
Builder window under Results. Then, click the root node (the first node in the
model tree). In the Settings window for the root node, under Thumbnail, click Set

from Graphics Window.
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There are two other ways to create images from a plot. One is to click the

Image Snapshot button @ in the Graphics window toolbar to directly create an
image. You can also add an Image node = to the Export node to create an image
file. Right-click the plot group of interest and then select Add Image to Export.

You can use the Image Snapshot button to export Results visualizations to
gITE™ (file extension .glb). These files can then be opened in 3D
visualization software such as Paint 3D from Microsoft®, as shown in the
figure below. (If you are running Windows® 10 or 11, then this may be
available in your system. Otherwise, you can download it from the
Microsoft® Store.) You can also find gITE™ viewers online that run in
web browsers.

b seka ® Medraity D ovew  — 4 0% - Marker

Matte v

+ Add color

Make sure to save the model at this stage. This version of the model,
busbar.mph, is reused and renamed during the next set of tutorials.
Alternatively, for the subsequent tutorials, you can use the busbar file in
the Application Libraries under COMSOL Multiphysics > Multiphysics.
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Building an Application with the Application Builder

This section gives a brief introduction to using the Application Builder to create
applications, using the busbar model to demonstrate. Each application will have a
specialized user interface dedicated to interacting with the busbar model that
includes input fields for the length, width, and applied voltage. The outputs will
be the maximum temperature and a temperature plot.

In this introduction, you will learn how to use the New Form wizard to quickly
create an application in two different ways, using two different layout templates.
The wizard is used to create one or more forms with user interface components
called form objects. The wizard gives quick access to a subset of all of the form
objects available for creating applications with the Application Builder. In the
following examples, you will learn how to add input fields, numerical outputs,
graphics, and buttons. For detailed information on building applications, see the
Introduction to Application Builder manual.

The first example shows how to create an application based on a single form, using
the Single form template. The Single form template makes it easy to interactively
move buttons and edit fields by dragging. However, it does not allow you to resize
the graphics when changing the size of the application window. The second
example demonstrates how to use the Basic template to create an application with
several forms, subwindows, and a ribbon. Using this template automatically
creates an application with a resizable graphics window.

CREATING AN APPLICATION USING A NEW SINGLE FORM

I This example uses the busbar model. You can open the busbar model file from
the Application Libraries under COMSOL Multiphysics > Multiphysics or, if you
saved your model upon completing Example 2 on page 121, you can open your
saved busbar.mph file.

To switch from the Model Builder to the Application Builder, click the
Application Builder button in the leftmost Workspace section of the Home tab on
the ribbon.

e O % =
File Home  Defin
Application Model
Builder Manager

Waorkspace

o
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2 To create a new form, click the New Form button on the ribbon. This will create
a new global form.

File Home

® E M

Model Model MNew
Builder  Manager Form ~
Waorkspace

©

In the Select Template page of the wizard, select Single form.

Select Template

[ eiank form

Single form G
[ Basic

[ subwindows, sections, and graphics
[T subwindows, tabs, and graphics
[EMl Toolbar, sections, and graphics

[EMl Buttons, sections, and graphics

[EMl Compact layout for tablets

[EM Advanced compact layout for tablets
[EM compact layout for smartphones

[EM Advanced compact layout for smartphones
© conen G

Help e Cancel Done

Click Content to continue.
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The Select Content page appears.

Select Content

Formtitles  Form 1| [] Labels on top

Form name:  form1

Inputs | Qutputs Graphics  Buttons
Available: Selected

4 4 Model (root)
4 @ Global Definitions
4 P Parameters 1
5< Length (L)
55 Bolt radius (rad_1)
== Thickness (thb)

©= Width (wbb)
5 Maximum element size (mh)
o5 Heattransfer coefficient (htc)

55 Applied voltage (Viot)

@ empate
[2 D g(an(e\ [ Done

It consists of four tabs for Inputs, Outputs, Graphics, and Buttons. On the Inputs
tab, you can double-click the parameters in the tree to make them available in
the user interface of the application. For this application, we will select a few of
the parameters as input fields and the maximum temperature as the output.

3 On the Inputs page, double-click each of the parameters: Length (L), Width
(wbb), and Applied voltage (Vtot). Also, on the Outputs tab double-click Volume
Maximum under Derived Values.

Select Content Preview

Formtitle  Form 1 [] Labels on top Length: 9 m
Form name:  form1 Width: 5 em
Inputs  Outputs  Graphics  Buttons Applied voltage: 20 my
Available: Selected: Temperature:  0001235K

~ % Model (root) v % Model (root)
~ (@) Global Definitions « [E Results
v Pi Parameters 1 v £ Derived Values
o5 Length (L) wax Volume Maximum 1

#= Bolt radius (rad_1)
5 Thickness (tbb)
&= Width (wbb)
o= Maximum element size (mh)
55 Heat transfer coefficient (htc)
== Applied voltage (Viot)

~ [H Results

~ B Tables

2 Maximum and Minimum Values
[ Table

eT&mp\att
[ B8 e(an(&\ [+ pone

The Preview section to the right displays the user interface layout.
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Click the Graphics tab in the wizard and double-click the Temperature plot. A

graphics object placeholder appears in the Preview area.

Select Content

Formtitler  Form 1 [] Labels on top
Form name:  form1

Inputs  Outputs  Graphics Buttans

Available: Selected:
~ % Model (root) —+ v % Model (ro0t)
~ [ Component 1 (comp1) v [E Results

~ = Definitions

~ Ty Selections
% Tiboks
A\ Geometry 1
A Mesh 1
~ [E Results

Nl Electric Potential (ec)
N Electric Field (ec)
W Current Density

eT&mp\att
[ B8 e(an(&\ [+ pone

W Temperature (ht)

o

Preview

Length: 9 cm

Width: 5 m

Applied voltage: 20 my

Temperature: 0.001235K

aa@r @l brinizb g .

B~ 8

5 Click the Buttons tab in the wizard and double-click Compute Study. A Compute
button now appears in the Preview area beneath the graphics object.

Select Content

Formtitler  Form 1 [] Labels on top

Form name: ~ form?
Inputs | Outputs  Graphics Buttans
Available: Selected:
> @ GUI Commands v < Model (root)
~ £ Model (root) ~vib Compute Study 1
~ [@ Component 1 (compl)
> = Definitions
Y Plot Geometry 1
/s Plot Mesh 1

~ [E Results
Nl Plot Electric Potential (Ec)
Nl Plot Electric Field (Ec)
N Plot Temperature (Ht)
Nl Plot Current Density

eT&mp\at&
B QCEH(E‘ [ pone

©

Preview

Length: 9 cm
Width: 5 m
Applied voltage: 20 my

Temperature: 0.001235K
Qa@~r @ bl b ¢ o
B-ra [oR=]

Compute

6 Finally, click Done to accept the settings and close the wizard.

After closing the Form wizard, the Form Editor is opened in the Application
Builder workspace. The Form Editor allows you to drag and drop form objects
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and add new form objects. The default view is a preview of the form. Double-click

forml to enable editing.

Application Builder
EAS-T0 2

[@ Preview  [Jform1 X

v
(<] »
Length 9 m
¥ [£] busbarmph root Width: 5 em
5 Inputs i\
T Themes Applied voltage: 20 my
> [7] Main Window Temperature:  0.001235 K
~ @& Forms
[ form1
L Events
= Declarations Q [V hd
B Methods -~
> ffl Libraries

Compute

7 You can rearrange the user interface by dragging the graphics object to the right
of the input fields and dragging the button to a position directly under the input
fields, as shown in the figure below. Blue guidelines will aid you in aligning the

objects.
[Q] Preview  [Jform1 X
v
Length: ¢ Mooee@-@i -kl G- e B BEO @8
Width: 5 cm
Applied voltage: 20 my
Temperature: 0.001235 K

Compute

You can make the graphics object larger or smaller by dragging the blue handles.
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8 You can test the application by clicking Test Application on the ribbon.

o
Et] '\f/
Test Preview Testin Web
Form  Browser -

>

Application
Test

©

Alternatively, you can click the corresponding button in the Quick Access
Toolbar. This creates a run-time copy of the application and lets you quickly try
different designs during the process of developing an application.

a

Length: ] am
Width: 5 em
Applied voltage: 20 my
Temperature 3304K

Compute

9 Now, try a different Length value, for example, and click Compute.

Untitled mph - Electrical Heating in o Busbar

ae@-@Lrwrizn ¢ ([{He - BED a8

O

X

Volume: Temperature (K) Max/Min Volume: Temperature (K)
m

. 0.02

\ 0.1

| mhax: 330,406
0.5
| m

“o

" min: 322.400

324

ADDING A BUTTON

You may wish to preview the geometry before starting the computation. This can
easily be done by adding a button. There are two ways to add a button. Either click
Button button in the Form Objects scction of the Form tab on the ribbon, as shown
in the figure below, or use the Editor Tools window. In this example, you will use

the latter method.

File Home

Form

T Input Field [T] Text Label

[2¥] Button

[+ Checkbox

Data Display
Graphics
Form Ohbjects

More
Objects ~

About
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| First, make sure the Editor Tools window is visible by selecting the
corresponding button on the Home tab of the ribbon.

File Home  Form

(‘ D "% Data Access = settings

Eﬁ Record Method Editor Tools

Model Model MNew MNew
Builder  Manager Form v Method v [@3 Compiler G
Waorkspace Main

2 In the Editor Tools tree, right-click the Geometry node and select Button.

Settings Editor Tools X

= Edit Node =T =

% Themes

D Main Window
¥ % Forms
» @ GUI Commands
» [ Libraries
~ < Model (root)
» () Global Definitions

~ [l Component 1 (comp1)

» = Definitions

> }’\ Geomnetry 1

> i3 Materials [ Graphics

> 3 Electric Cunr @5 Button G
> 0 Heat Transfe i

> 4 Multiphysic. <4 Edit MNode

> A Mesh 1

3 Drag the Geometry button to the left of the Compute button.

[@ Preview  [Jform1 X
v
> a
Length: 2 o aa@ @il - <-a- BEHO @8
Width 5 m
Applied voltage: 20 mv

Temperature: 0001235 K

Geometry Compute

For each button, there is a command sequence that controls the action taken
when it is pressed. The command sequence is defined in the Settings window of
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the button. You can open the Settings window (if not already opened) by
double-clicking a button.

Double-click the Geometry button to see its Settings window. Command
sequences appear below the tree in the Choose Commands to Run section.

Settings X Editor Tools

Button

Name: button2

Text: Geometry

lcon: geometry 32.png
Size: Large

Style: Outlined

Tooltip:
Keyboard shortcut:

~ Choose Commands to Run

> B Forms
> @ GUI Commands
> [l Libraries
v & Model (root)
> () Global Definitions
~ [l Component 1 (comp1)
> = Definitions
~ YA Geometry 1
> & Work Plane 1 (wp1)
[5) Extrude 1 (ext)
> 18 Work Plane 2 (wp2)
Edit Node » Run [ Plot 7 SetValue

Show as Dialog 1 Import File () Enable

L3
Command lcon | Arguments
Plot Geometry 1 graphics1

£

Show
Disable

o

In this case, the command sequence for the Geometry has one command for
plotting the geometry. The input argument contains information concerning
which graphics window to send the geometry plot to. In this case, the graphics

object is graphics1.

To automatically adjust the axis settings, you can add a Zoom Extents command.

In the Choose Commands to Run section, locate the Zoom Extents command
under GUI Commands > Graphics Commands. Double-click to add it to the

command sequence.

Now, create the input argument to the Zoom Extents command. Click the white
field next to Zoom extents and click the Edit Argument button.

L
Command lcon | Arguments
Plot Geornetry 1 graphics1
Zoom extents G

t LR (A

> Dialog Actions

Edit Argurnent G
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7 This opens a dialog with possible input arguments. Select graphicsl under
forml.

3 Edit Argument X
4 & Forms
el D form1
graphics1 G

@_‘ Use as Argument

Selected argument:

[ graphicsl
oK Cancel

8 The command sequence is now complete.

L
Command lcon | Arguments
Plot Geornetry 1 graphics1
Zoom extents form1/graphics1 G

tLREE-#

9 To make sure the new Geometry button works, you can test the application again
by clicking Test Application on the ribbon.

USING FORMS IN THE MODEL BUILDER

Forms without graphics form objects can be used in the Model Builder. You can
use this functionality to create customized Settings windows for common or
repetitive tasks, for example. If you would like to reuse your customized Settings
window between sessions or even with other users, you can create an add-in, as
explained in the Introduction to Application Builder.
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To use a form in the Model Builder that was created with the Application Builder,
right-click Global Definitions and select the form under Settings Forms.

Model Builder

— F =l

h

~ & busbar.mph (root)
v (1) Global Definitions
Fi Parameters 1 P Parameters
45 Default Model - _

2= Variables
i) Materials .
> [l Component 1 (cor Functions '
> g Study 1 Geometry Parts 3
v Results
@' Mesh Parts v
¥ Datasets
¥ Derived Value: + Default Model Inputs
’ % Tables. Materials v
> N Electric Potent
> Wi Electric Field ( Lead and Constraint Groups 3
> Nl Temperature ( Thermodynamics v
» Current Densii A
Parameter Estimation 3
Export
[# Reports £9  Cosimulation for Simulink
Settings Forms 3 D form1

oi

Show More Options...

METHODS

When you need to perform a more advanced operation than what is possible with
a command sequence, you can use the Method Editor to write code that defines
the actions to be taken when the user clicks a button, selects a menu item, etc. In
addition to calling methods from applications or Settings Forms, you can call
methods from the Developer tab on the ribbon or from Method Calls in the model
tree. For more information, see Introduction to Application Builder.

An easy way to get started with the Method Editor is to convert an existing
command sequence into a method.

I In the Application Builder, locate or open the Settings window for the Geometry
button again. Select Convert to Method in the menu below the command
sequence. (The other two options in the drop-down menu are for creating two
types of local methods.)

t i xbgbE- @
+ Dialog Actio ’. Convert to Method G
5E Convert to Form Method

[[] Close dialog
st h ‘ Convert to Local Method
ore changes
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2 To open the method in the Method Editor, click the Go to Method button below
the command sequence.

L
Command lcon | Arguments
method1 @

b BB -

~ Dialog Acti Go to Method

The Method Editor now opens with the code for methodl, corresponding to
the Plot Geometry and the Zoom Extents commands in the previous command
sequence.

App\ication Builder @] Preview [ form1 method1 X
o =t 2 v P [0 1 hsssrﬂph‘.’cs(model.component(' mpl"”).geom("geoml”), "graphicsl");
= v = zoomExtents("Fforml/graphics1");

~ [Z] busbar.mph froct)
[ Inputs
T Themes

> [7] Main Window
~ % Forms
[ form1

Events

= Declarations

v [ Methods
method1 G
> [l Libraries

The Application Builder has several tools for automatically generating code. In
addition to converting a command sequence to a method, you can, for example,
click Record Code on the ribbon.

@] o

Goto Record Use
Node Code Shortcut

Code
This will generate code for each operation performed in the COMSOL Desktop
windows. Click Stop Recording on the ribbon to stop recording and go back to the
Method Editor.

THE JAVA SHELL AND CHATBOT WINDOWS

Note that, in addition to the Method Editor, you can use the Java Shell window
to run code. The Java Shell window is also accessible from the Model Builder

workspace and allows you to interact with a model using Java code. In addition,
while debugging methods, it gives you access to the variable contents at a break
point. Furthermore, you can communicate with a chatbot via the Chatbot window.
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This tool can be used to get tips on using Java syntax, debugging code, and more.
For more information, see Introduction to Application Builder and the
Application Programming Guide.

CREATING AN APPLICATION USING THE BASIC TEMPLATE

This second example shows how to use the Basic template to create an application
with several forms, subwindows, and a ribbon. Using this template creates an
application with a resizable graphics window. Note that the type of applications
that you create using templates can also be built using manual steps by starting
from a Blank form or Single form template; however, using templates accelerates
this process. For more information, see Introduction to Application Builder.
This example uses the busbar model. You can open the busbar model file from the
Application Libraries under COMSOL Multiphysics > Multiphysics or, if you saved
your model upon completing Example 2 on page 121, you can open your saved
busbar.mph file.
I To switch from the Model Builder to the Application Builder, click the
Application Builder button in the leftmost Workspace section of the Home tab on
the ribbon.

e O % =
File Home  Defin
Application Model
Builder Manager

Waorkspace

o
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2 To create a new form, click the New Form button on the ribbon. This will create
a new global form.

File Home

® E M

Model Model MNew
Builder  Manager Form ~
Waorkspace

In the Select Template page of the wizard, select Basic.

Select Template

[ Benkform
Single form
E Basic

[ Subwindows, sections, and graphics

[F=] subwindows, tabs, and graphics
[EM Toolbar, sections, and graphics

[EMl Buttons, sections, and graphics

[l Compact layout for tablets

[EM Advanced compact layout for tablets
[ZMl compact layout for smartphones

[EM Advanced compact layout for smartphones

© conen G

Click Content to continue.
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The Select Content page

Select Content

[] Lebels ontop

Inputs  Qutputs Graphics  Ribbon buttons
Available:
v 4 Model (root)
v (@ Global Definitions
v Pi Parameters 1
o= Bolt radius (rad_T)
&= Thickness (tbb)
a5 Maximum element size (mh)
85 Heat transfer coefficient (htc)

e Template
[2 28 Q Cancel [ Done

appears.

Inputs
v & Model (root)
~ (@) Global Definitions
v P Parameters 1
== Length (L)
=5 Width (wbb)

== Applied voltage (Vtot)

+ Add Form # Edit Form

Remove Form

Preview
File Home
|~ Inputs
| Length 9 cm
:Wldth: 5 <m

! Applied voltage: 20 my

Just like when using the Single form template, this page consists of four tabs for
Inputs, Outputs, Graphics, and Ribbon buttons. On the Inputs tab, you can
double-click the parameters in the tree to make these available in the user
interface of the application. In the same way as in the earlier example, using the
Single form template, on the Inputs tab, double-click each of the parameters:
Length (L), Width (wbb), and Applied voltage (Vtot). Also, in the Outputs page
double-click Volume Maximum under Derived Values.

3 Continue by clicking the Graphics tab in the wizard and double-click the

Temperature plot.

Select Content

[] Labels ontop

Inputs | Outputs Graphics  Ribbon buttons

Avalable: Selected
v % Model (root)
~ @ Component 1 (compT)
v = Definitions
© % Selections
% Tibots
A\ Geometry 1
A Mesh 1
v @ Results
Wl Electric Potential (cc)
W Electric Field (ec)
Nl Current Density

@ oot
Hep Q) Concel [ Done

— v % Model (root)
~ B Results

@ Temperature (ht)

©

Preview

File  Home

Main
~ Inputs

Length: s
Width: H
Applied voltage: 20
~ Outputs

Temperature: 0.001235K

aa@-

mv

When using the Basic layout template, this selection determines the default plot
shown when the application is started.
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4 The Ribbon buttons tab displays the model and application tree nodes that can
be run by clicking a button on the ribbon in the application user interface.

In the figure below, buttons have been added corresponding to the actions: Plot
Geometry, Plot Mesh, Compute Study, Plot Electric Potential, Plot Temperature,
Plot Current Density, and Reset Window Layout.

Select Content Preview c

[ Labels on top

A = 5] |
« [ 6UI Comman o > [ GUI Comman s | Geometty Mesh Compute  Electic  Tempersture Curent ResetWindow |
S O B G i T s Potential (ec) ) Density w !

Inputs | Outputs  Graphics Ribbon buttons

(]
El

Available: Selected:

> [y Graphics Commands v [ Component 1 (comp1)
> % Model Commands A\ Plot Geometry 1
v <& Model (roof) /2, Plot Mesh 1 v Inputs Qaqa- VrEEE g
v W Co 1 (comp % Compute Study 1
'>' = o o i & Length s em
v i Results Wl Plot Electric Potential (Ec) Width: 5 cm

Tl Plot Electric Field (Ec) Tl Plot Temperature (Ht) Applied voltage: 20 my
Wl Plot Current Density
~ Outputs

Temperature: 0.001235K

eT&mp\atE
2 a(antz\ [ pone

The option Reset Window Layout is available under GUI Commands > Main
Window Commands > Reset Window Layout. The application consists of two
subwindows, one for the inputs and outputs and one for the graphics. The Reset
Window Layout button will reset the two resizable subwindows in the application
to their original size. The Subwindows template is similar to the Basic template
but additionally allows you to detach, move around, and dock the subwindows.
In this case, the Reset Window Layout operation will rearrange all subwindows
to their original position and size.

Using the Main Window Editor in the Application Builder, you can add ribbon
buttons that run your own custom command sequences or methods.

Click Done to exit the wizard. This automatically takes you to the Main Window
Editor.
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5 You can test the application by clicking Test Application on the ribbon.

@ Unfitied.mph - Electrical Heating in a Busbar
File  Home

A A =

Geometry  Mesh  Compute
P

Temperature  Current  Reset Window
o (0 Density Loyout

Q@@ Lrzkk ¢ |< - BHO @8

Volume: Temperature (K) Max/Min Volume: Temperature (K)

~ Inputs
Length: £l em
Width: 5
Applied voltage: 20

324

~ Outputs

Temperature: 3305K

To learn more about using the Form Editor and the Method Editor, see the book
Introduction to Application Builder, which provides more information on
writing methods. For more in-depth information on methods, see the
Application Programming Guide and the Application Builder Reference
Manual.

This completes the busbar example. To switch back to the Model Builder, click

the Model Builder button on the ribbon.

File Home

Y/ 5
& &
Model Model
Builder  Manager

Waorkspace
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Overview of Advanced Topics

The next sections are designed to deepen your understanding of the steps
implemented so far and to extend your simulation to include additional effects like
thermal expansion and fluid flow. These additional topics begin on the following

pages:

“Parameters, Functions, Variables, and Couplings” on page 139
“Material Properties and Material Libraries” on page 144
“Adding Meshes” on page 146

“Adding Physics” on page 149

“Parametric Sweeps” on page 172

“Parallel Computing” on page 184

“COMSOL Multiphysics Client—Server” on page 188
“Appendix A — Building a Geometry” on page 217

138 |



Advanced Topics

Parameters, Functions, Variables, and Couplings

This section explores working with parameters, functions, variables, and nonlocal
couplings.

The Global Definitions and Component > Definitions nodes contain functionality that
helps you to prepare model inputs and nonlocal couplings and to organize
simulations. You have already used the functionality for adding parameters to
organize model inputs in “Global Definitions” on page 87.

Functions, available as both Global Definitions and Component > Definitions, contain
a set of predefined function templates that can be useful when setting up
multiphysics simulations. For example, the Step function template can create a
smooth step function for defining different types of spatial or temporal transitions.

To illustrate using functions, assume that you want to add a time-dependent study
to the busbar model, where an electric potential is applied across the busbar that
goes from 0 V to 20 mV in 0.5 seconds. For this purpose, you could use a step
function to be multiplied with the parameter Vtot. In this section, you will add a
step function to the model that goes smoothly from 0 to 1 in 0.5 seconds to find
out how functions can be defined and verified.

DEFINING FUNCTIONS

For this section, you can continue working with the same model file created in the
previous section. Locate and open the file busbar.mph from page 121 if it is not
already open on the desktop.

| 139



I Right-click the Global Definitions node @ and select Functions > Step I .

o

~v @ busbar.mph (root)
v () Global Definitions

P Parameters1 | Fi Parameters
4 Default Model| 5= yoiobles
= Materials o0
> [ Component 1 fcon AivEians v | Analytic
> rdt Study 1 Geometry Parts y | L Interpolation
e @ Results Mesh Parts | v Piecewise
> Datasets .,‘
» &5 Derived Values v Default Model Inputs S gGa==anBuks
> E Tables Materials 3 /" Ramp
> §i Electric Potent T Rectangle
> i Electric Field Load and Constraint Groups 3
I s
> [l Temperature ( Thermodynamics ’ =
> A\ Triangl
Current Densig !-; Cosimulation for Simulink T
:‘port ‘= Show More Opti 1 L
eports - ow More Options...
" - . Normal Distribution
W
; Mode Group MV Random
= G by Ty
"= D S G External
Ll FI | & mamas
G Elevation (DEM)
A Image
Least-5quares Fit
% Gaussian Process
7 Polynomial Chaes Expansion
ol Deep Neural Network
/- Partial Fraction Fit
ﬂa‘l Function Switch

2 In the Settings window for Step, enter 0.25 in the Location ficld to set the
location of the middle of the step function, where it has the value of 0.5.
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Settings

Step

Plot Create Plot

Label: Step 1 =
Function name:  stepl

~ Parameters

Location:  0.25
From: 0

To: 1

~ Smoothing

Size of transition zone: 0.5
Location definition: Middle of step =
Mumber of continuous derivatives: 2 =



3 Click Smoothing to expand the section and enter 0.5 in the Size of transition zone
field to set the width of the smoothing interval. Keep the default Number of
continuous derivatives at 2 as well as the setting for Location definition.

4 Click the Plot button = in the Settings window for Step.

If your plot matches the one below, this confirms that you have defined the
function correctly.

Graphics  Funetion Plt
| aQ@- WEOE a 2~ o-@d

stepl
°
&

You can enable an interactive tooltip that displays data values while
hovering over the graph. You control the enabling of this functionality
from the Enable Tooltip button in the Graphics toolbar (default on).

Graphics  Function Plot stepl

caa-@HEDD & 8- & ——————

Enable Tooltip / —

Y:0.9479
X:0.4039

You can also add comments to the function to make it more descriptive.
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5 Right-click the Step | node | in the Model Builder window and select Properties

and Comments =.

~ & busbar.mph (root)
v () Global Definitions
Fi Parameters 1
_[” Step 1(step1)
45 Default Model
i) Materials
> [l Component 1 (con
» ~db Study 1
v {E| Results
Datasets
Derived Values
max Volume Mi
> E Tables
W8 Electric Potent
I'.’ Electric Field (¢
& Temperature (1
W& Current Densit
Export
[# Reports

»
»
»
»

Copy as Code to Clipboard 3
Copy Ctrl+C
Duplicate Ctrl+Shift+D
Group Ctrl+G

Delete Del

Disable F3

Rename F2

Settings

Properties and Comments e

Help

Fi

6 In the Properties window, enter any information you want. Right-click the
Properties tab and select Close when you are finished. Special characters and
markup tags that you use here will be displayed in reports generated from the

Reports node.

Settings Properties X

Step

Label: Step 1
Mame: stepl
Tag: stepl

G ~ Mode Properties

Created: Oct 7, 2024, 11:33:17 AM

Author: COMSOL

Version: Version 1.0 of this model

Commentss L § E

C

c

C

X X

—

o X, X2 N0 mvEeres

[

Created for the Introduction to COMSOL Multiphysics book

Q
-

- o =

G G
o ¥

l|]

m
X

i

8
W
’

1
w

K L LvEomp
r AOGAZEINIXZY

For the purpose of this exercise, assume that you want to introduce additional
components, for example, a second component to represent an electric device
connected to the busbar through the titanium bolts.
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In this case, it is good practice to give each component a descriptive name. Now,
rename Component | to specify that it represents the busbar.
I Right-click the Component | node @ and sclect Rename = (or press F2).
2 In the Rename Component window, enter Busbar. Click OK and save the model.
v 4% busbar.mph [roct)
» () Global Definitions
il Busbar {comp 1)

>
» rdn Study 1
>

{El Results

©

DEFINING NONLOCAL COUPLINGS AND PROBES

Right-click the Definitions node = under Busbar v % busbar.mph (raot)

(compl) to introduce a nonlocal coupling that v (@) Global Definitions
. Fi Parameters 1

computes the integral of any BusI.Jar (compl) . - Varinbles |

variable at the bolt boundaries facing the electric I Step 1 (step1)

45 Default Model Inputs
Materials
~ [l Busbar {comp1)

device. You can use such a coupling to define a
variable in a Variables node under the Global

Definitions node that calculates the total current. v = Definitions
This variable is then globally accessible and > Ta selections
) . Jdu Integration 1 {intop 1)
could, for example, form a boundary condition [ Boundary System 1 (sys1)
for the current that is fed to an electric device > [ View1
Geormnetry 1

modeled as a second component.

2 Materials

+\_ Electric Currents {ec)

5] Heat Transfer in Solids (ht)
iy Multiphysics

The Nonlocal Couplings in Definitions have a wide
range of uses. The Average ~ , Maximum »~, and

W W W v

Minimum «+ couplings have applications in > A Mesh1
. . » ~db Study 1
generating results as well as in boundary > @ Revalts

conditions, sources, sinks, properties, or any

other contribution to the model equations. The Probes # are for monitoring the
solution progress. For instance, you can follow the solution at a critical point
during a time-dependent simulation or for each parameter value in a parametric
study.

You can find an example of using the average operator in “Parametric Sweeps” on
page 172. Also see “Functions” on page 248 for a list of available functions.

To learn more about working with definitions, in the Model Builder window,
click the Definitions = or Global Definitions @ node and press F1 to open the
Help window @ . This window displays helpful information about the selected
item in the desktop and provides links to the documentation. It could take
up to a minute for the window to load the first time it is activated, but will
load quickly the next time it is opened.
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Material Properties and Material Libraries

You have already used the functionality in the Materials node to access the
properties of copper and titanium in the busbar model. In the Materials node, you
are also able to define your own materials and save them in your material library.
In addition, you can add material properties to existing materials. In cases where
you define properties that are functions of other variables, typically temperature,
the plot functionality helps you to verify the property functions in the range of
interest. You can also load Excel® spreadsheets and define interpolation functions
for material properties using LiveLink™ for Excel®.

The Material Library add-on product contains over 15000 materials with
hundreds of thousands of material properties. In addition, many of the add-on
products include material libraries relevant to their application areas.

First, investigate how to add properties to an existing material. Assume that you
want to add bulk modulus and shear modulus to the copper properties.

CUSTOMIZING MATERIALS

Let us keep working on the busbar.

I In the Model Builder window, under Materials,  [7] Geometry 1
click Copper :: . v :5 Materials
G > &= Copper (matl)

> S Titanium beta-215 (mat2)
> 3 Electric Currents (ec)

2 In the Settings window for

Material, click to expand the v Material Properties

Material Properties section, > [l Fatigue Behavior

which contains a list of all of > [} Geomechaics Materil
N » [ Hyperelastic Material

the definable properties. « [l Linear Elastic Material

» |z Anisotropic

Expand the Solid Mechanics >

=i Anisotropic, Voigt Notation

>
Linear Elastic Material section. > |2 Bulk Modulus and §h-=-*4--t--t-o-
. . - Add to Material
Right-click Bulk Modulus and > [ Compliance |7 Addto Meter
» |:5 Compliance, Voigt Motation
Shear Modulus and select + > [ Cubic G
>

= Cubic (3 Constants)

Add to Material.

This lets you define the bulk
modulus and shear modulus
for the copper in your model.

3 In the Copper node, locate the Material Contents section. Bulk modulus and Shear
modulus rows are now available in the table. The warning sign a indicates that
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the values are not yet defined. To define the values, click the Value column. In
the Bulk modulus row, enter 140e9 and in the Shear modulus row, enter 46e9.

©

~ Material Contents

L
Property

Bulk modulus

Shear modulus

Density

K|Q|X (K ||

Relative permeability

Coefficient of thermal expansion | alpha_...

Young's modulus

[ P T

4 ahe

Electric conductivity

Relative permittivity

Thermal conductivity

Heat capacity at constant press... | Cp

Variable | Value Unit

K 140e9 M/rm®

G N/m?

sigma... | 5.998e7[.. |5/m
38500/ (k. | W (kg K)

epsilo., |1 1

rtho 8960[kg/ ... | kg/m®

k_iso ;.. [400[W/(.. fmK)

mur_is... | 1 1
17e-6[1/K] | 1/K

E 110[GPa] |Pa

- nooc El

Property group

Bulk modulus and shear...

Bulk modulus and shear...

Basic
Basic
Basic
Basic
Basic
Basic

Basic

Young's modulus and P...

L R TR T N .

By adding these material properties, you have changed the contents of the Copper
material. You can save this information in your own material library, but not in the
read-only Solid Mechanics materials library.

4 In the Model Builder window, right-click Copper and select Add to User-Defined
Library [§.

»

»
»
»
»
="

aometry‘l

2 Materials

> &= Copper (matl)

» S Titanium beta-21
+\_ Electric Currents {ec)
5] Heat Transfer in Solid
iy Multiphysics
A Mesh 1
Study 1

User-Defined Property Group

Merge Into

Add to User-Defined Library o

Copy as Code to Clipboard

To see this library, click the Browse Materials in the Materials tab on the ribbon.
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Adding Meshes

A model component can contain different mesh sequences for generating meshes
with different settings. A mesh sequence is an ordered set of instructions for
generating a mesh. Mesh sequences can be accessed by the study steps. In a study,
you can select which mesh you would like to use in a particular simulation.

In the busbar model, a second Mesh node is now added to create a mesh that is a

bit coarser (has larger elements).

ADDING A MESH

I Open the model busbar.mph that
was saved earlier on page 121.

2 In order to keep this model in a
separate file for later use, select File
> Save As and rename the model
busbar_I.mph.

3 To add a second Mesh node,
right-click the Component | node
@ and select Add Mesh 4 . (If you
followed the instructions in
“Parameters, Functions, Variables,
and Couplings” on page 139, the
name of Component | is Busbar
instead.)

By adding another Mesh node, a
Meshes parent node is created that
contains both Mesh | and Mesh 2.

4 Click the Mesh 2 node. In the Settings

<
vvwv vy vl

& busbar.mph (root)
v (1) Global Definitions

Fi Parameters 1

45 Default Model Inputs
2 Materials
Component 1 (comp 1)
= Definitions
Geormnetry 1

2 Materials

+\_ Electric Currents {eg
) Heat Transfer in Soli
iy Multiphysics

A Mesh 1

~do Study 1

> [El Results

w

©

Lo

window for Mesh under Mesh Settings, sclect Settings

User-controlled mesh as the Sequence type.

A Size and Free Tetrahedral node are now

available under Mesh 2.
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Add Physics

Add Multiphysics
Add Mathematics
Insert Physics

Insert Physics From
Moving Mesh
Deformed Geormetry
Topology Optimization
Shape Optimization
Parameter Estimation
Add Mesh

Copy as Code to Clipboard

|E8 Build All
Label: Mesh2 =
v Sequence Type

Physics-controlled mesh -

G | User-controlled mesh ||

Physics-controlled mesh |




5 First, delete the additional Size | node (which controls the boundary mesh).
Then, in the Model Builder window, under Mesh 2, click Size 2.

Model Builder Settings
— ® Et iy W Siz
~ [ Build Selected [ Build Al G
v & busbar.mph (root) Label:  Size =
v () Global Definitions
P Parameters 1 Element Size
4 Default Model Inputs
S Materials Calibrate for:
~ [l Component 1 {comp1) General physics =
» = Definitions -
) Predefined Jorma
’ Geometry 1 ) Predefine Mormal
> L2k Materials (® Custom G
> 3 Electric Currents (=c) - —— ;
» IE) Heat Transfer in Solids (ht) ement slze Farameters
> gy Multiphysics Maximum element size:
~ /A Meshes -
2*mh m
> A Mesh 1
v A Mesh2 Minimum element size:

Size 2*(mh-mh/3) m

Free Tetrahedral 1 Maximum elerment growth rate:
» ~db Study 1 15
v {E| Results
N Datasets Curvature factor:
> 2% Derived Values 0.2
> [ Tables Resolution of narrow regions:
» I'.’ Electric Potential (ec) 05

» I'.’ Electric Field (ec)

The asterisk in the upper-right corner of a node icon indicates that the node is
being edited.

6 In the Settings window for Size, under Element Size, click the Custom button.
7 Under Element Size Parameters, cnter:

- 2*mh in the Maximum element size ficld, where mh is 3 mm — the mesh control
parameter defined previously.

- 2*(mh-mh/3) in the Minimum element size ficld.
- 0.2 in the Curvature factor ficld.
8 Click Build All & . Save the file as busbar_I.mph.

Compare Mesh | and Mesh 2 by clicking the Mesh nodes. The mesh is updated in
the Graphics window. An alternative to creating multiple meshes in this way is to
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Adding Physics

The distinguishing characteristics of COMSOL Multiphysics, particularly
adaptability and compatibility, are prominently displayed when you add physics to
an existing model.

In this section, you will experience the ease with which this seemingly difficult task
is performed. By following these directions, you can add structural mechanics and
fluid flow to the busbar model.

STRUCTURAL MECHANICS

After completing the busbar Joule heating simulation, we know that there is a
temperature rise in the busbar. What kind of mechanical stress is induced by
thermal expansion? To answer this question, let us expand the model to include
the physics associated with structural mechanics.

To complete these steps, either the Structural Mechanics Module or the
MEMS Module (which enhances the core Solid Mechanics interface) is
required.

If you want to add cooling by fluid flow, or do not have the Structural
Mechanics Module or MEMS Module, read this section and then go to
“Cooling by Adding Fluid Flow” on page 158.

I Open the model busbar.mph that was saved earlier on page 121. From the main
menu, sclect File > Save As and rename the model busbar_II.mph. Alternatively,
you could load the busbar.mph model from the Application Libraries as shown
earlier.

2 In the Model Builder window,
right-click the Component | node m
and select Add Physics ;.

(1) Global Definitions
Il Component 1 {comal)
~ Study 1 1 Add Physics G
B Results 4, Add Multiphysics
A4 Add Mathematics

~ @ busbar_ll.mph (root)
>
>
>
>
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3 In the Add Physics window, under

Structural Mechanics, select Solid Add Physics
Mechanics = -+ Add to Component 1 - Add to Selection
=,

To add this interface, you can

right-click and select Add to

Component | or click the + Add to

Component | button at the top of £ Electric Discharge
. el Electrachemistry

the window. You can also ~ Fluid Flow

> ¥ AC/DC
>
>
>
>
>

double-click. » Heat Transfer
>
>
>
>

1)) Acoustics
<+* Chemical Species Transport

4 Close the Add Physics window and "é; EE::;
save the file.

£ Radio Frequency
é Semiconductor

e Structural Mechanics

55 Solid Merhanics fcalid)
G [:] Sh -+ Addto Component 1
£ La ~+  Add to Selection

[ T
R Ream (heaml

When adding additional physics, you need to make sure that materials
included in the Materials node have all of the required properties for the
selected physics. In this example, all properties are already available for
copper and titanium.

You can start by adding the effect of thermal expansion to the structural
analysis.

5 In the Model Builder window, v 5 ol Mechanics (said)
right-click the Multiphysics node 85 Linear Elastic Materia
and select Thermal Expansion = . P e Ve 1
A Thermal Expansion node is added o ; ”'Ei?ii'i: M Flectromagnetic Heating
to the model tree. e xj"” BT Themoelectric Effect
You can also use the ribbon and, > B Results ) Eauilerm Discherge Heat Source
@ Piezoresistivity, Domain Currents
from the Physics tab, select G =4 Themmal Expansion
MUItithSics coup“ngs > Thermal E‘a Equilibrium Discharge Boundary Heat Source
Expansion. =38 Thermal Expansion, Thin Layer
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6 In the Settings window for Thermal
Expansion, sclect All domains from the
Selection list. This will enable thermal

Settings
Thermal Expansion

expansion in the copper as well as in the Label:  Thermal Expansion 1 B
titanium bolts. Name: tel
The Thermal Expansion Properties section ~ Domain Selection
of this window shows information about c sekcion: TR .
the coefficient of thermal expansion and 1 N
the strain reference temperature (there z B —
are also some more advanced settings). 3 @ N
The Coefficient of thermal expansion takes . =
its value from the Materials node. In the 2
Model Input scction, the Volume reference
temperature (strain reference s auation
temperature) has a default value of v Coupled Interfaces
293.15 K (room temperature) taken Flent transfer
from Common model input, which in this Heat Transfer in Solids (ht) - f
case corresponds to the Default Model Structure:
Inputs node that is available in Global Solid Mechanics (solid) -] £
Definitions, and defines the temperature

. . . ~ Model Input +
for which there is no thermal expansion.
The Coupled Interfaces section shows PITARESELE SRR .
which two physics interfaces define the Trer =l &
physiCS for heat transfer and solid v Thermal Expansion Properties
mechanics. This is useful in the case Input type:
where there is more than one physics e e

interface for heat transfer or solid
mechanics in the model component.
Keep all default settings in this window.

Coefficient of thermal expansion:

a From material

Next, constrain the busbar at the position of the titanium bolts.

7 In the model tree, right-click Solid Mechanics = and from the boundary level,
select Fixed Constraint = . A node with the same name is added to the tree.

8 Click the Fixed Constraint node = . In the Graphics
window, rotate the busbar to view the back. Click the
circular surface of one of the bolts to add it to the
Selection list.

4 @ Solid Mechanics (solid)
= Linear Elastic Material 1
5= Freel
= Initial Values 1

©

»yy Fixed Constraint 1
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9 Repeat this procedure for the remaining bolts to add boundaries 8, 15, and 43.

¥ Boundary Selection

Selection: | Manual

a
on ]
)

Active 43

For easier management of multiple boundary selections, you can group
boundaries into a user-defined selection. Once you have selected
boundaries 8, 15, and 43, click the Create Selection button = and give it
a name, such as Bolt top surfaces.

This selection is then added as a node under Component | > Definitions and
is accessible from the Selection list in the Settings window for all types of
boundary conditions. You can use this technique to group domains,
boundaries, edges, and points. In the figure below, an additional selection
for the titanium bolt domains has been created.

Model Builder Settings
- 1 F Sty Elv S B~ Explicit
pe Iertext ¢ Label: Bolt top surfaces B8
v % busbar_ll.mph {root)
~ () Global Definitions ~ Input Entities
P Parameters 1
4 Default Madel Inputs Geometric entity level: Boundary -
2 Materials 2
~ [l Component 1 {compT) 15
~ = Defintions

43

v g Selections
% Tibolts
» Bolt top surfaces
[Z] Boundary System 1 {sps1)

> [ View1 [ All boundaries
? Geometry 1 [] Group by continuous tangent
> igs Materials
> 3 Electric Currents (ec) v Output Entities

Next, we update the Study node to take the added physics into account.

SOLVING FOR JOULE HEATING AND THERMAL EXPANSION

The Joule heating effect is independent of the stresses and strains in the busbar,
assuming temperature invariant materials and small deformations, and ignoring
the effects of electric contact pressure. This means that you can run the simulation
using the temperature as merely an input to the structural analysis. In other words,
the extended multiphysics problem is weakly coupled. As such, you can solve it in
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two separate study steps to save computation time — one for Joule heating and a
second one for structural analysis. In a more advanced analysis, you can include all
of the aforementioned effects.

For this example, you can skip these steps and just click Compute.
However, the following technique can be useful for saving computational
time and memory resources, especially for larger simulations.

I In the Model Builder window, right-click " o Stud 1
Study | = and sclect Study Steps > Stationary > = g)trep 1: Stationary

Stationary = to add a second stationary study G [~ Step 2 Stationary 2
stcp > [fre Solver Configurations

S

When adding study steps, you need to manually connect the respective
physics with the correct study step. We start by disabling the structural
analysis from the first step.

2 Under Study I, click the Step I: Stationary node v~ Study 1
=. [= Step 1: Stationary
[= step 2: Stationary 2
3 In the Settings window for Stationary, locate the > [fre Solver Configurations

Physics and Variables Selection.

4 In the Solid Mechanics (solid) row under Solve for, click to change the check mark
@ to an | | to remove Solid Mechanics from Study Step 1.

In the Multiphysics couplings section, keep all of the default settings.

~ Physics and Variables Selection ]

[] Modify model configuration for study step

MNode Solve for | Equation form
~ IE Component 1 (comp)

¥, Electric Currents (ec)

eat Transfer in Solids (ht)
= Solid Mechanics (solid)

v iy Multiphysics

Automatic (Stationary)
Automatic (Stationary)

Automatic (Stationary) G

*. Electromagnetic Heating 1 (&... Automatic (Stationary)

KR ODMEHE

E2 Thermal Expansion 1 (tel) Automatic (Stationary)

Now, repeat these steps to remove Electric Currents (ec) and Heat Transfer in
Solids (ht) from the second study step.

5 Under Study 1, click Step 2: Stationary 2 '-. v b Study 1
[= step 1: Stationary

e [= Step 2: Stationary 2

> [fre Solver Configurations
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6 Under Physics and Variables Selection, in the Electric Currents (ec) and Heat
Transfer in Solids (ht) rows, click to change the check mark & toan | | to remove
Joule heating from Step 2: Stationary 2.

~ Physics and Variables Selection s

[] Modify model configuration for study step

MNode Solve for | Equation form
~ IE Component 1 (comp) =4
ff Electric Currents (ec) O Automatic (Stationary) G
Heat Transfer in Solids (ht) O Automatic (Stationary)
Iif Solid Mechanics (solid) =4 Automatic (Stationary)
v iy Multiphysics
*. Electromagnetic Heating 1 (&... =4 Automatic (Stationary)
Thermal Expansion 1 (tel) =4 Automatic (Stationary)

7 Right-click the Study I node ~» and select Compute = (or press F8 or click
Compute on the ribbon) to solve.

G v oo Study 1
= = Compute F8

Step 1: Stationary
[~ Step 2: Stationary2 | (¥ Update Solution F5
> [fre Solver Configurations

> [El Results

Parametric Sweep

Save the file as busbar_II.mph, which now includes the Solid Mechanics interface
and the additional study step.

RESULTING DEFORMATION

Now that a physics interface has been added, additional plots for Solid Mechanics
need to be added manually. First, a displacement plot.

I In the Model Builder window, right-click Results & and add a 3D Plot Group w .
In the Label ficld enter Displacement to give the plot group a descriptive name.
Right-click Displacement @ and add a Surface | node =. Click the Surface |
node m.

v {E| Results

H Datasets

% Derived Values

EH Tables

Nl Electric Potential (ec)
I'.’ Electric Field Morm {ec)
I'.’ Temperature (ht)

W& Current Density

i Displacement

™ Surface 1

v v v v v v




2 In the Settings window for Surface in
the Expression section, click the Replace
Expression button =:.

From the context menu, select Model >
Component | > Solid Mechanics >
Displacement > solid.disp - Displacement
magnitude - m.

You can also enter solid.disp in the
Expression ficld.

Now, change to a more suitable unit.
In the Settings window under
Expression, from the Unit list, select mm
(or type mm in the field).

The local displacement due to thermal
expansion is displayed as a surface plot.

 Expression

Expression:

solid.disp

©

Unit:
mm v
[] Description:

Displacement magnitude

4 Model
[ Global definitions
[ Materials
4  Component 1 (compl)
b Definitions
b Frames
 Geometry
b Mesh
I Electric Currents
I Heat Transfer in Solids
4 Solid Mechanics
I Acceleration and velocity
b Activation
4 Displacement
G solid.disp - Displacement magnitude - m
[ Curl of displacement {material and geometry frames)
[ Displacement field - m

Alternatively, you can use the Results Templates window to add a

Displacement plot.

Result Templates
—+ Add Result Ternplate (™ Reload

Study 1/Solution 1 (sol1)

> 3 Electric Currents

» |IE) Heat Transfer in Solids
v =2 Solid Mechanics

Nl Stress (solid)

Vi Displacement (solid)

@ Total Reaction Forces and Moments (Solid Mechanics)

> .y Electromagnetic Heating 1
Study 1/Solution Store 1 (sol2)
> 3 Electric Currents

» |IE) Heat Transfer in Solids

> .y Electromagnetic Heating 1

Next, we will add information about the busbar deformation.

3 In the Model Builder window, under Results > Displacement, right-click the
Surface | node m and add a Deformation node = . The plot automatically
updates in the Graphics window. Click the Go to Default View button ... so your
view appears similar to the plot shown below.
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The deformations shown in the figure are highly amplified to make the
very small distortions that actually take place more visible.

Surface: Displacement magnitude (mm)

0.05

4 Save the busbar_II.mph file, which now includes a Surface plot with a
Deformation.

You can also plot the von Mises and principal stresses to assess the
structural integrity of the busbar and the bolts.

OVERRIDE AND CONTRIBUTION: EXCLUSIVE AND CONTRIBUTING NODES

The model tree nodes for a physics interface are traversed in a downward sequence
starting from the top. Depending on the selection, a node can totally or partially
override, or shadow, a node that comes earlier in the sequence. There are two
types of physics interface nodes: exclusive and contributing. How the nodes are
treated depends on the type.

A constraint boundary condition is a typical example of an exclusive node.
Examples of constraint boundary conditions include Electric Potential or Fixed
Constraint. In the case of Electric Currents, for example, if there are two or more
Electric Potential nodes for the same boundary, then the last Electric Potential node
in the sequence will override the settings of the other nodes. The Ground node is
also an exclusive node and will similarly override the boundary conditions specified
by any previous node.
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The figure below shows the Override and Contribution section in the Settings
window for Electric Potential. The Overrides list indicates that this boundary
condition takes precedence over the default Electric Insulation boundary condition.

Model Builder Settings
+— L ® Etv Elv Eiv @~ Electric Potential
Label:  Electric Potential 1 B8
v @ busbar_|l.imph (root)
~ () Global Definitions v Boundary Selection
Pi Parameters 1
& Default Model Inputs Selection: w Manual -
=) Materials Fe
~ [l Component 1 {comp1)
> = Definitions
> Geometry 1
> 538 Materials

' Electric Currents fec)

T8 Current Conservation 1 ~ Owverride and Contribution
3—- Electric Insulation 1 Overridden by:
& Initial Values 1
mw Electric Potential 1

mw Ground 1

> |4 Heat Transfer in Solids (ht)
> 45 Solid Mechanics (sofid) ORI
¥ vy Multiphysics Electric Insulation 1
> A Mesh1
¥ ~db Study 1
> [ Results Contributes with:

A flux boundary condition, such as one specifying a heat flux, is a typical example
of a contributing node. You can stack several heat flux boundary conditions and
they will all contribute to the total heat flux. The figure below shows an example
where a Heat Flux 2 boundary condition overrides the default Thermal Insulation
boundary condition and contributes to the heat flux together with Heat Flux 1.

~ Y Heat Transfer in Solids (ht) 3

i Solid 1
= Initial Values 1 ~ Override and Contribution
%% Thermal Insulation 1
o Heat Flux 1
ww Heat Flux 2
> E=8 Solid Mechanics (solid)
> .ﬁ:‘, Multiphysics
¥ A Mesh 1
» ~db Study 1

> B Results

Overridden by:

Overrides:

Thermal Insulation 1

Contributes with:
Heat Flux 1

In the model tree, the override and contribution relationships are indicated by a
red arrow and an orangge circle, respectively.
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COOLING BY ADDING FLUID FLOW

After analyzing the heat generated in the busbar and possibly the induced thermal
expansion, you might want to investigate ways of cooling the busbar by letting air
flow over its surfaces. These steps do not require any additional modules, as the
model only includes Joule heating without the previous thermal expansion
analysis.

If you use either the Nonisothermal Flow or Conjugate Heat Transfer
multiphysics interface, the coupling between heat transfer in solids and fluids
is automatic, whereas in this example, this is done manually and with limited
functionality. This is to illustrate adding a multiphysics coupling to an already
existing analysis.
Adding fluid flow to the Joule heating model creates a new multiphysics coupling.
To simulate the flow domain, you need to create an air box around the busbar for
the external flow. You can do this manually by altering the geometry from your
first model or by opening an Application Library file. To save time, open a file with
the box already created.

After loading the geometry, as described later, you will learn how to simulate air
flow according to this figure:

Air outlet

Air inlet

DEFINING INLET VELOCITY

Start by loading the geometry and adding a new parameter for the inlet flow
velocity.
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I If you have just reopened the software, close the New window that opens
automatically by clicking the Cancel button o .

2 Click the Home tab, and, from the Windows menu, select Application Libraries ffj.
Navigate to COMSOL Multiphysics > Multiphysics > busbar_box. (You can also
open the Application Libraries directly from the File menu.)

Double-click to open the file,
which contains the geometry Application Libraries
in addition to the physics

. (' Refresh Update COMSOL Application Libraries ([} Application Gallery
modeling steps completed

Search

through the end of the « £ COMSOL Mutinhysics
section “Customizing > [l Applications
. » [l Acoustics
Materials” on page 144. > [l Chemical Engineering
» [ili Cluster and Batch Tuterials
> [ilfi Diffusion

» [l Electremagnetics
> [illf Equation Based
> [illf Fluid Dynamics
» [l Geometry Tutorials
> [l Geophysics
» [l Heat Transfer
> [ilfi Meshing Tuterials
~ [ Multiphysics

@ busbar

bushar_assembly
G O busbar_box

busbar_geom

Run Application Open

EI Open PDF Document

Help e Close
3 Under Global Definitions, click
the Parameters node - .

4 In the Settings window for Parameters, click the empty row just below the Vtot
row. In the Name column, enter Vin. Enter 0.1[m/s] in the Expression column

| 159



and a description of your choice in the Description column, such as Inlet

velocity.
Model Builder
— & Et- El v

v @ busbar_box.mph (root)
~ () Global Definitions

© -

< Default Model Inputs

Parameters 1

= Materials
~ [l Component 1 {comp1)

> = Definitions

v Geometry 1

~

-

w

E Waork Plane 1 (ivp1)
[EL Extrude 1 (ext1)
& Work Plane 2 (iwp2)

E Work Plane 3 (iwp3)
[EL Extrude 3 fext3)

FR Dl 1 /LI

o

Settings

Parameters
Label:  Pararneters 1

v Parameters

L3
Name

Expression Value Description
L G[cm] 009 m Length
rad_1 &[rmm) 0.006 m Bolt radius
thb 3[rmm) 0,005 m Thickness
whb 5[em] 0.05m Width
mh 3[mm) 0,003 m Maximum element size
htc S[WSm*2/K] W/ (™K Heat transfer coefficient
Vtot 20[mV] 002V Applied voltage
Vin 0.1 m/s Inlet velocity

5 Seclect File > Save As and save the model with a new name, busbar_box_I.mph.

ADDING AIR

The next step is to add the material properties of air.

I From the Home tab, sclect Add Material @i (or right-click the Materials node and
select Add Material from Library).

2 In the Add Material window, expand
the Built-In node. Right-click Air and
select Add to Component |. Close the

Add Material window.

©

Add Material

(1) Add to Global Materials * - Add to Component

» 7=% Recent Materials

» [ Material Library

v [@ Built-in
i Air
2= Acry () Add to Global Materials
2a Alur
2a Alur
24 Alurminum 6063-T83

B Addte Component 1 (compl)

3 In the Model Builder window, under Materials, click the Air node :: .

v igi Materials

>
»

®

& Copper (mat1)
& Titanium beta-215 {matz)

7 Air (mat3)

4 On the Graphics window toolbar, click Zoom Extents 7).
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5 In the Graphics window, click the air box (domain 1) to add it to the Selection
list, which changes the color to blue. This step assigns the air material properties

to the air box.

ADDING FLUID FLOW
Now, add the physics of fluid flow.

Settings

Material
Label:  Air =

Mame:  mat3

Geometric Entity Selection

Geometric entity level: Domain =
Selection: = Manual -
‘
E p—
B W
.. =

I In the model tree, right-click Component | @ and select Add Physics ;.

2 In the Add Physics window under
Fluid Flow > Single-Phase Flow,
right-click Laminar Flow =. and
select + Add to Component.
Laminar Flow will appear under
Component | in the model tree.
Close the Add Physics window.

3 In the Graphics toolbar, click the
Transparency button =. In
addition, click the Wireframe
Rendering button = . These two

settings make it easier to see inside
the box. Toggle these on and off as

needed during the modeling
process to control the type of
rendering used.

Add Physics
+ Addto Component 1 ~+ Add to Selection

» (O Recently Used
> % AC/DC
» 1)) Acoustics

> =% Chemical Species Transport

¥ E Electric Discharge
> Tuf Electrochemistry

w

©

“= Fluid Flow

Single-Phase Flow

Creeping Flow (spf)

Laminar Flow (snfi

Turbulent Flow  —  Add to Component 1

Large Eddy Sim ~+  Add to Selection
Detached Eddy oo

== Rotating Machinery, Fluid Flow
:-."ft‘v: Pipe Flow (pfl)

Now that you have added fluid flow to the model, you need to remove the air
domain (domain 1) from the Electric Currents (ec) interface (assuming that the
air has no electric conductivity and hence no currents) and then couple the heat
transfer part of the Joule Heating multiphysics interface to the fluid flow.
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4 In the model tree, select the
Electric Currents (ec) node
x . In the Graphics window,
move the mouse pointer
over the air domain and
click to remove it from the
selection list. At this point,
only the busbar should be
selected and highlighted in
blue.

5 In the Model Builder window, right-click Heat Transfer in Solids = . In the first
section of the context menu, the domain level &, select Fluid.

¥ H Geormnetry 1 = solid
i Materials
! -
¥ +\_ Electric Currents (ec) = Fluid e
~ IIF) Heat Transfer in Solids (ht) | @ Heat Source
= Solid 1 =

w

Initial Values
D o
e Initial Values 1 . :
5% Thermal Insulation 1 m
(mw Heat Flux 1 = Ternperature
v S i
= Laminar Flow (spf) (= Thermal Insulation

= Fluid Properties 1

5= initial Values 1 Heat Flux
5= wall1 @ Symmetry
’ '& Multiphysics (== Perindic Canditinn

6 In the Graphics window, click the
air domain (domain 1) to add it to
the Selection list.

Now, couple the fluid flow and
heat transfer phenomena.
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7 In the Settings window for Fluid, under

Heat Transfer in Solids, in the section v Model input #
Model Input, sclect Absolute pressure LI

(spf) from the Absolute pressure list. In T | Temperature (ht) i
the section Heat Convection, select R EETE

Velocity field (spf) from the Velocity field 6 Pa et B
list. > Coordinate System Selection

This identifies the pressure and flow v Heat Convection

field from the Laminar Flow interface Velocity field:

and couples it to heat transfer. 6 U Velocity field (spf) =i

Now, define the boundary conditions
by specifying the inlet and outlet for the
heat transfer in the fluid domain.

8 In the Model Builder window, right-click Heat » % Electric Currents (ec)

Transfer in Solids /= . In the second section of - Tﬁ_ Heat Transfer in Solids (ht)
the context menu, the boundary section =, 2= Solid 1
select Temperature. i Initial Values 1

. %= Th I Insulaticn 1
A Temperature node is added to the model = Thermalnstianen

tree.

mw Heat Flux 1
I= Fluid 1

G ¥y Temperature 1

v === Laminar Flow (spf)
im Fluid Properties 1
s Initial Values 1
T Wall1
9 In the Graphics window, click the
inlet boundary, boundary number M
2, to add it to the Selection list. |
This sets the inlet temperature to I '
293.15 K, the default setting.

The graphics should look like the
image to the right. (It may look
slightly different depending on
whether you have Transparency and
Wireframe Rendering on or off.)
Continue by defining the outlet.
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10In the Model Builder window, right-click Heat Transfer in Solids =. At the
boundary level, select Flow Conditions > Outflow. An Outflow node = is added to
the model tree.

> H Geomnetry 1 = Ssolid
» Lie Materials .
> 3 Electric Currents (ec) = Fluid
v I[F) Heat Transfer in Solids (ht) | I& Heat Source
i Solid 1 I= Initial Values
= Initial Values 1 Snecific Medi 5
%= Thermal Insulation 1 pecihic Vedia
w Heat Flux 1 = Temperature
'E Fluid 1 = Thermal Insulation
= Temperature 1 -
Laminar Flow (spf) mw  Heat Flux
= Fluid Properties 1 = Symmetry
Dmm W —
= Initial Values 1 s Periodic Condition
= Wall1 -
3 -&. Multiphysics s Lumped Systern Connector
> A Mesh 1 = Phase Change Interface
" Study 1 = Phase Change Interface, Exterior
& Results —
Flow Conditions b | b Inflow
Heat Sources v | b Outflow @
Thin Structures » | m Open Boundary

Il In the Graphics window, click the
outlet boundary, boundary
number 5, to add it to the
Selection list. Use the mouse scroll
wheel to scroll in and highlight
the boundary before selecting it,
or use the up and down arrow
keyboard buttons.
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The settings for the busbar, the bolts, and the Electric Potential | and
Ground | boundaries have retained the correct selection, even though you
added the box geometry for the air domain. To confirm this, in the model
tree under Electric Currents, click the Electric Potential |1 and the Ground |
nodes to verify that they have the correct boundary selection.

Settings Settings

Electric Potential Ground

Label:  Electric Potential 1 = Label: Ground 1 =

~ Boundary Selection ~ Boundary Selection

Selection: w Manual - Selection: e Manual -

“9 . e .
B — 20 B —
B N @ &
= =

> Override and Contribution > Override and Contribution

> Equation > Equation

~ Electric Potential

Electric potential:

Vo Viot v

Next, continue with the flow settings. You need to indicate that fluid flow only
takes place in the fluid domain and then set the inlet, outlet, and symmetry
conditions. Do this by first removing all domains from the selection and then
adding the air domain.
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I In the model tree, click the Laminar Flow node =.. In the Settings window for
Laminar Flow, click the Clear Selection button |5 .

Settings
Laminar Flow

Label:  Laminar Flow E

Mame:  spf
~ Domain Selection

Selection: &= All domains -

2 50 [l 4
(=)

L R e N

2 In the Graphics window, click the air box (domain 1) to add it to the Selection.
Settings
Laminar Flow

Label:  Laminar Flow E

Mame:  spf

~ Domain Selection

Selection: &% Manual =
‘ L 2
B W
&
It is good practice to verify that the Air v 32 Materials
material under the Materials node has all of > fjz Copper (mat1)

> je Titaniurn beta-215 (matz)

the properties that this multiphysics _
> g Air (mat3)

combination requires. In the model tree
under Materials, click Air. In the Settings
window for Material under Material Contents, verify that there are no
missing properties, which are marked with a warning sign a . The section
“Materials” on page 95 has more information.

Now, we continue with the boundaries.
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3 Inthe Model Builder window, right-click Laminar Flow =-

~ == Laminar Flow (spf)
and at the boundary level, select Inlet. An Inlet node = B2 Fluid Properties 1
is added to the model tree. G5 Initial Values 1

S Wall1
G w Inlet 1
In the Graphics window, click the

inlet (boundary 2) to add it to the T
Selection list. //\‘ E

In the Settings window for Inlet

under Velocity in the U, field, ) _ _

enter Vin to set the Normal inflow e
() Velocity field

velocity. G Uy Vin -

Right-click Laminar Flow =. and at

the boundary level, select Outlet = . c
In the Graphics window, click the

outlet (boundary 5) to add it to the
Selection list. Use the mouse scroll

wheel or keyboard arrows to scroll

in and highlight the boundary

before selecting it.

~ Velocity

The last step is to add symmetry
boundaries. For simplicity, assume
that the flow just outside of the
faces of the channel is similar to the
flow just inside of these faces. This
assumption can be correctly
expressed by the symmetry
condition.

Right-click Laminar Flow =. and select Symmetry. A Symmetry node = is added
to the sequence.
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8 In the Graphics window, click each of the blue faces in the figure below
(boundaries 1, 3, 4, and 48) to add all of them to the Selection list. You may need
to use the mouse scroll wheel or rotate the geometry to select all of them.

Save the busbar_box_I.mph file, which

now includes the Air material and
Laminar Flow interface settings.

When you know the boundary
numbers, you can click the
Paste Selection button 1 and
enter the information. In this
example, enter 1,3,4,48 in the
Paste Selection window. Click

|3 Paste Selection *

Selection: 1,3,4,43]
oK Cancel

OK and the boundaries are automatically added to the Selection list.

COARSENING THE MESH

To get a quick solution, we will change the mesh slightly and make it coarser. The
current mesh settings would take a relatively long time to solve, and you can

always refine it later.

I In the Model Builder window, expand the Mesh |

node 4 and click the Size node 4J.

2 In the Settings window for Size
under Element Size, click the
Predefined button and ensure that
Normal is selected.

168 |

v /A Mesh 1

é! Size

Free Tetrahedral 1

Settings
Size
® Build Selected [E§ Build All

Label: Size =

Element Size

Calibrate for:

General physics =

g @ Predefined ~ Mormal v

() Custom



3 Click the Build All button & . The
geometry displays with a mesh in
the Graphics window (you may
need to turn Transparency off to sce
the picture below).

You can assume that the flow velocity
is large enough to neglect the
influence of the temperature increase
in the flow field.

It follows that you can solve for the
flow field first and then solve for the
temperature using the results from
the flow field as input. This is
implemented with a study sequence.

SOLVING FOR FLUID FLOW AND JOULE HEATING

When the flow field is solved before the temperature field, it yields a weakly
coupled multiphysics problem. The study sequence described in this section
automatically solves such a weak, or one-directional, coupling.

I In the model tree, right-click Study I ~» and select Study Steps > Stationary >
Stationary i~ to add a second stationary study step to the Model Builder window.

» gt Study 1
> dEl Results | = Compute F8

£55  Parametric Sweep

9 Function Sweep
Material Sweep

Study Reference

88 &1 &

Combine Solutions
Optimization »
i Surrogate Model Training
Uncertainty Quantification v
Study Steps v Other v
[T Show Default Selver Stationary v = stationary
[E Show Default Plots Time Dependent v | [ Stationary Plug Flow

Next, the correct physics needs to be connected with the correct study step.
Start by disabling the Electric Currents (ec) and Heat Transfer in Solids (ht)
interfaces associated with Joule heating from the first step.
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2 Under Study I, click Step I: Stationary ~.

v rdn Study 1
[= Step 1: Stationary
[= Step 2: Stationary 2

N

)

~ Physics and Variables Selection

[] Modify model configuration for study step
MNode Solve for | Equation form
~ IE Component 1 (comp) =4
Electric Currents (ec) G O Automatic (Stationary)
O
&

eat Transfer in Solids (ht) Automatic (Stationary)

@ Laminar Flow (spf) Automatic (Stationary)

v iy Multiphysics
3, Electromagnetic Heating 1 (emh1) =4 Automatic (Stationary)

3 In the Settings window for Stationary, locate the Physics and Variables Selection
section. In both the Electric Currents (ec) and the Heat Transfer in Solids (ht)
rows, click to change the check mark & to an [ in the Solve for column,

removing the Joule heating effect from Step 1.

4 Repeat the step. Under Study I, click Step 2: Stationary 2 = . Under Physics and
Variables Selection, in the Laminar Flow (spf) row, click in the Solve for column to
change the check mark & toan | |.

~ Physics and Variables Selection ]

[] Modify model configuration for study step

MNode Solve for | Equation form
~ IE Component 1 (comp) =4
}f Electric Currents (ec) =4 Automatic (Stationary)

eat Transfer in Solids (ht) =4 Automatic (Stationary)
aminar Flow (spf) G O Automatic (Stationary)
v iy Multiphysics

:5;: Electromagnetic Heating 1 (emh1) =4 Automatic (Stationary)

5 Right-click the Study I node ~» and select Compute = (or press F8 or click
Compute on the ribbon). This will now automatically create a new solver
sequence that solves for laminar flow and then Joule heating.

w o Study 1
[= Step 1: Stationary | = Compute e
[= Step 2: Stationary 2 )

N @ Results Parametric Sweep

f Function Sweep

6 After the solution is complete, select the Temperature (ht) plot under the Results
node in the Model Builder window. If you do not already have transparency on,
click the Transparency button = on the Graphics toolbar to visualize the
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temperature field inside the box. To zoom, middle-click and hold down the
mouse button (or scroll wheel) while dragging the mouse.

Surface: Temperature (K)

Y_\T"x

The Temperature plot that displays in the Graphics window shows the
temperature in the busbar and in the surrounding box. You can also see that the
temperature field is not smooth due to the relatively coarse mesh. A good
strategy to get a smoother solution would be to refine the mesh to estimate the
accuracy.

7 At this point, save the busbar_box_I.mph file so you can return to it at any time.
The next steps use the original busbar.mph file.
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Parametric Sweeps

SWEEPING A GEOMETRIC PARAMETER

It is often useful to generate multiple instances of a design with the objective of
meeting specific constraints. In the previous busbar example, a design goal might
be to lower the operating temperature or decrease the current density. We will
demonstrate the former. Since the current density depends on the geometry of the
busbar, varying the width, wbb, should change the current density and, in turn,
have some impact on the operating temperature. Let us run a parametric sweep on
wbb to study this change.

ADDING A PARAMETRIC SWEEP

| From the File menu, open the
~ & busbar.mph (root)

mOdCl ﬁlC busbar. mph. IfyOU. did 3 :’, Global Definitions
not save the model, you can also > Tl Component 1 (comp1)

e . . . » ~db Study 1
open it fror.n the Ap[.)hc?non > @ Resuts | = Compute e
L.1brar.1€s. File > Appllcat‘lon . O Update Solution -
Libraries > COMSOL Multiphysics > G PR

Multiphysics > busbar.

f Function Sweep
In the Model Builder window,

right-click Study | -~ and select Parametric Sweep
is added to the Model Builder sequence.

A Parametric Sweep node

2 In the Settings window for Parametric Sweep, under the empty parameter table,
click the Add button + . From the Parameter names list in the table, select wbb.

Maodel Builder Settings

-— ® Etw Parametric ¢

ijii
4
4
4

(¥ Update Solution

O = Compute
~ & busbar.mph (root) Label:  Parametric Sweep 15|
v (1) Global Definitions
Fi Parameters 1 v Study Settings
4 Default Model Inputs
= Materials Sweep type: Specified combinations >
> [ Component 1 (comp1) "
v i Study 1 Parameter name | Parameter value list Parameter unit
G Parametric Sweep whb (Width) - m
Step 1: Stationary
¥ |'|'|-F Solver Configurations L (Length)
- @& Results rad_1 (Bolt radius)
» 2 Dat.a;ets tbhb (Thickness) [
» ez Derived Values whh (Width)
> B Tables

} mh (Maximum element size)
htc (Heat transfer coefficient)
- Vtot (Applied voltage)

> §i§ Electric Potential (ec)
> §i§ Electric Field (ec)
> |@ Temperature (ht)
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The Sweep type is used to control parametric sweeps with multiple
parameters. You can choose between sweeping for All combinations of
the given parameters, a subset of Specified combinations, or Parameter
switch. The option Parameter switch makes it possible to sweep over
Cases for Parameters, as defined in Global Definitions (shown below).

Model Builder

— 4 ® St~ Elw

~ < busbarmph (root)
v (f) Global Definitions
~ Py Parameters 1
P Casel
P Casel
P Case3
£ Default Model Inputs
i Materials
> @ Component 1 {comp 1)
v oo Study 1
arametric Sweep
[= Step 1: Stationary
>[I Solver Configurations

v B Results

Settings
Parametric Sweep

= Compute (* Update Solution
Label: Parametric Sweep

w Study Settings

Sweep type: Parameter switch

L]
Switch Cases

Parameters 1« All

Settings
Case

o)

Label: Casel

~ Parameters

L] c
Mame Expression

L Glem]

rad_1 &[mm]

tbb 5[mm]

whb 5[em]

mh 3[mm]

htc 5[\ *2/K]
Vtot 20[mV]

=

Case numbers

~ |range(1,1,3)

Description
Length
Bolt radius
Thickness
Width

Maximum element size

Heat transfer coefficient

Applied voltage

Note that you can replace the set of main Parameters used in the model
with that of a Case by selecting from the menu in the upper-left corner
of the Parameters window.

Model Builder

& Etv =l v

v 4@ busbar.mph (root)

v () Global Definitions

&
~ P} Parameters 1
P; Casel
P; Case2
Pi Case3
& Default Model Inputs
=) Materials
> i@ Compenent 1 (comp1)
v db Study 1
arametric Sweep

Step 1: Stationary
¥ |'|'|-|. Solver Configurations
~ @l Results

Settings
Parameters
) Casel
) Case?

) Casel

L
Mame Expression

L 9lcm]

rad_1 B[mm]

tbb 3[mm]

whb 3[cm]

mh 3[mm]

htc S[Wim " 2/K]
Vtot 20[mV]

Value
0.09m
0.006 m
0.005 m
0.05m
0.003 m
5W/(m*K)
002V

Description

Length

Bolt radius

Thickness

Width

Maximum element size
Heat transfer coefficient

Applied voltage
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3 Enter a range of parameter values to sweep the width of the busbar from 5 cm
to 10 cm in 1 cm increments. There are different ways to enter this information:

- Copy and paste or enter range(0.05,0.01,0.1) into the Parameter value list
field.

- Click the Parameter value list field and then
click the Range .. button and enter the = fenge x
values in the Range dialog. In the Start ficld, Entry method:
enter 0.05. In the Step ficld, enter 0.01, and Step =
in the Stop field, enter 0. 1. Click Replace. S[:;:

- In any of the methods, you can also use Step:
length units to override the default SI unit 0.01
system using meters. Instead of 0.05, you Stop:
can enter 5[cm]; similarly, 1[cm] instead of 0.1
0.01and 10[cm] instead of 0. 1. You can also Function to apply to all values:
change the default unit system from the Nene -
Settings window of the root node in the G Replace || Add Cancel

model tree.

~ Study Settings

Sweep type: Specified combinations =

L] . .
Parameter name | Parameter value list Parameter unit

whb (Width) + |range(0.05,0.01,0.1) m

+ =) > @k

Next, define an Average nonlocal coupling that can be used later to calculate the

average temperature in the busbar.
4 Under Component |, right-click Definitions = and select Nonlocal Couplings >

Average -~ .

N

w

@ busbar.mph (root)
» (1 Global Definitions

B Component 1 {comp1)

» = Definitions

3 Geometry 1 2= Variables

> igs Materials Functions r

> % Electric Cur -

> I8 Heat Transf] Gelections '

> %y Multiphysi¢ Probes 4

> £ Mesh1 Physics Utilities ,
v o Study 1 -

122 parametric Monlocal Couplings » | Jau Integration
Step 1: Sta Pairs b | 4 Average L

> [Tre Solver Conf Coordinate Systems b M Maximum

> [El Results
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5 In the Settings window for Average, sclect All domains from the Selection list.

Model Builder Settings
- ® Etv Elv - B~ Average
¢ Label: Average 1 =

v @ busbar.mph (root)
# busbar.mph (ro0 Operator name: | aveopl

P

i Global Definitions

F'L Parameters 1 Source Selection
£ Default Model Inputs
i) Materials Geometric entity level:  Domain -
v 7
I? ;Drgi?i:::r:srcomp i Selection: e |5 All dornains -
» g Selections
G av Average 1 (aveop)
[ Boundary System 1 (sys1)
> [ view1
¥ Geometry 1
> igi Materials
> 3 Electric Currents (=c)
» IE) Heat Transfer in Solids (ht)
¥ .{;3, Multiphysics

[= T R S TVR
B (P il &
=/

~  Advanced

> A Mesh 1 Integration order: 4
v o Study 1 .
123 Frame: Spatial (x,y, 2) v

Parametric Sweep
[= Step 1: Stationary
_> [Fre Solver Configurations

This creates an operator called aveop1. This operator is now available to
calculate the average of any quantity defined on the selected domains. Later, we
use this tool to calculate the average temperature, but it can also be used to
calculate average electric potential, current density, and so forth.

6 Sclect File > Save As to save the model with the new name, busbar_III.mph.

7 To run the sweep, right-click Study | «« and select Compute = or click Compute
in the Home tab.
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PARAMETRIC SWEEP RESULTS

Click the Temperature (ht) |1 node (the second
temperature plot node) located under Results in the
model tree.

The plot that displays in the Graphics window shows
the temperature in the wider busbar using the last
parameter value, wob=0.1[m] (10[cm]). Select Zoom
Extents [} from the Graphics window toolbar so that
you can see the entire plot. The resulting plot is rather
uniform in color, so we need to change the maximum
color range.

wbb(6)=0.1 m

Surface: Temperature (K}

I Under the Temperature (ht) |

» I‘i Electric Potential (ec) 1
> N Electric Field Morm (ec) 1
v Nl Temperature (ht) 1
) Volume 1
Export
[# Reports

176 |

v {E| Results

S R . B B

i Datasets

2% Derived Values

EH Tables

I“ Electric Potential (ec)

I“ Electric Field Morm {ec)

I“ Temperature (ht)

W& Current Density

I‘i Electric Potential (ec) 1

I“ Electric Field Morm {ec) 1

i@ Temperature (ht) 1
Export

[# Reports

314

node, click the Yolume node & .



2 In the Settings window for Volume,
click Range to expand the section.
Select the Manual color range
checkbox. Enter 309.5 in the
Maximum field (replace the default).

3 The Temperature (ht) | plot is
updated in the Graphics window for
wbb=0.1[m] (10[cm]).

wbb(6)=0.1 m Surface: Temperature (K}

~ Range

G Manual color range

Minimum:
Voo

G Maximum:

309.05088

309.5

309.27 9

The plot may look a bit different depending on which version you are running.
Compare the wider busbar plot to the temperature for wbb=0.05[m] (5[cm]).
For this purpose, you can reuse one of the previously defined plot groups.

I In the Model Builder window, click the first Temperature (ht) node @.

v {E| Results

Datasets
Derived Values
EH Tables
i“ Electric Potential (ec)
i“ Electric Field Morm {ec)
i@ Temperature (ht)
W& Current Density
i'i Electric Potential (ec) 1
i“ Electric Field Morm {ec) 1
il Temperature (ht) 1

B volume 1
Export
[# Reports

w

&

v v v W v v v v
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2 In the Settings window for
3D Plot Group, sclect
Study I/Parametric Solutions
I from the Dataset list. This
dataset contains the results
from the parametric sweep.

3 In the Parameter value list,
select 0.05 (which
represents wbb=5 cm). Click
the Plot button @ . Click the

Settings
3D Plot Group
[ Plot M= 4= =p =p|

Label: Temperature (ht) E
v Data
Dataset: G Study 1/Parametric Solutions 1 (sol2) ~ E

Parameter value (whb (m)): 0.05 e

Zoom Extents button 5 on the Graphics window toolbar.

The Temperature (ht) plot is updated for wob=0.05[m] (5[cm]). Note that if you
have updated the color range for this plot already, your plot should look similar to
the one below. If not, follow the subsequent steps.

wbb(1)=0.05 m Surface: Temperature (K) Max/Min Volume: Temperature (K}

m

AR 323.25

0.1

: 330.400

0.05
m

m 322.39

(The plot may include the maximum and minimum points, depending on which
version of the model you started from.) Like the wider busbar, the plot may be
quite uniform in color, so change the maximum color range.

I Under the first Temperature (ht) node, click the Volume node w .

2 In the Settings window for Volume, click Range to expand the section (if it is not
already expanded). Select the Manual color range checkbox.
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3 Enter 323.25 in the Maximum field (replace the default).

The Temperature (ht) plot is updated in the Graphics window for wbb=0.05[m]

(5fcm]).

Click the first and second Temperature plot nodes to compare the plots in the
Graphics window. The maximum temperature decreases as the width of the

busbar increases from 5 cm to 10 cm.

ADDING MORE PLOTS

To further analyze these results, you can plot the average temperature for each

width.

I Right-click Results & and add a ID Plot Group -~ .

v {E| Results

» i Dat @ 3D Plot Group
Der B 2D Plot Group

B Tab
W Blec ™~ 1D Plot Group G

il Elec @) Polar Plot Group
B Ter
i Cur
Nl Elec E,  Evaluation Group
I'.’ Elec
B Terr
Exp Pi Parameters

[ Rep Plot All

22 Smith Plot Group

WO W W W W W W W

Configurations v

() Close All Plot Windows
[®, Result Templates

& Show More Options...

2 In the Settings window for thelD Plot Group, sclect Study |/Parametric

Solutions | from the Dataset list.

Settings
1D Plot Group
Plot

Label: 1D Plot Group & =

~ Data

G Dataset: Study 1/Parametric Solutions 1 (sol2) =

Parameter selection (whbb): All
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3 In the Model Builder window, right-click 1D Plot Group and add a Global & node.

Model Builder Settings
— = Et~ El- - B~ Global
o Plot
v % busbar_lllmph (roct) Label:  Global 1 5|
> () Global Definitions
> @ Component 1 {comp1) ~ Data
» ~do Study 1
v [E Results Dataset: ~ From parent ORE!
>

242 Derived Values v y-Axis Data + - IE|EI hs
Ef Tables

W8 Electric Potential (ec) " Expression Unit Description

Wi& Electric Field (ec) aveopl(T) K Average 1 G
V8 Temperature (ht)

W& Current Density

Wl Electric Potential (ec) 1

W Electric Field (e) 1 AN - v

B Temperature (ht) 1 Expression:

~w 1D Plot Group 8

£ Global 1

v W ow v v v W v

Description:

4 In the Settings window for Global under y-Axis Data, click the first row in the
Expressions column and enter aveopi (T). This is the operator that we defined
on page 175 for later use. You use a similar syntax to calculate the average of
other quantities.

You can also use auto-completion by using Ctrl+Space after clicking the
first row or after typing a few characters.

~ y-Axis Data

" Expression Unit Description
ave
~  Model
v~ Component 1 (compl)
v Definitions
~ Monlocal couplings
aveop1(expr) - Average 1

To use a nonlocal coupling operator without solving, you can select the
option Update Solution that is available by right-clicking a Study node.

» ~db Study 1

> [E Results | = Compute F8

(' Update Solution F5

Parametric Sweep
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5 Click the Plot button = and save the busbar_III.mph model with these
additional plots that use the parametric sweep results.

Global: Average 1 (K) e
T T T T T T T T T T
k\

\
2F N ]
321 1

\
\
\
3201 AN 1
\
\
\,
3194 N 4
AN
\

a8 \\ ]
o 7f \\ ]
= .
o 316 S 1
g
g AN
£ a5 =

\\
314+ \\ i
\\
313 \ 4
\
anz| \\ 1
\
™.
EISYS 4
3l0F 4
L . L . L L L L L L
0.05 0,055 0.06 0.065 0.07 0.075 0.08 0.085 0.09 0.095 01

wbb (Width)

In the plot, the average temperature decreases as the width increases.

PARAMETERS IN RESULTS

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model. The
following example shows how you can animate over a Parameter defined under
Results.

I Right-click the Results node and select Parameters.

v {E| Results

w

v v v v v v v v

Dat:
Deri
FH Tabl
i Elec
i Elec
B Tem
& Cun
VB Elec
i Elec
B Tem
1DF

Y

v
2

&5

&

3D Plot Group
2D Plot Group
1D Plot Group
Polar Plot Group
Smith Plot Group

Evaluation Group
Configurations
Parameters

Plot All

Clear Plot Data

o
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2 Define a parameter, iso_level, with Expression 309.5[K].

Model Builder

- ® Eftw

Elv

v 4 busbar_lll.mph (root)
» () Global Definitions
» i@ Component 1 (comp 1)
> rdb Study 1
w [E Results
Fi Parameters
Datasets

» 2% Derived Values

3

Settings

Parameters
~ Parameters

L]
Mame

iso_level

Expression
308.5[K]

Description

309.5K G Isosurface level

3 Right-click the Results node and select Results Templates. In the Results
Templates window, add an Isothermal Contours plot, from the Heat Transfer in
Solids branch of Study I/Solutionl. For the Isothermal Contours (ht) plot group,
in the Settings window for the Isosurface plot, change the Entry method to
Levels. For the Levels expression field, type iso_level.

Global 1

~ I" |sothermal Contours (ht)
¥ lsosurface 1

Export

[# Reports

v Levels
Entry method: Levels
Levels: iso_level

[ Interactive

4 In the same Settings window, click Plot.

wbb(6)=0.1m

Isosurface: Temperature (K)

F={ 300.5




5 Generate an Animation by either selecting the Player option in the Animation
menu of the Isothermal Contours (ht) | tab on the ribbon, or right-click the
Export node and select Animation > Player.

Model Builder

— = Et -

~ @ busbar_lll.mph (root)

» () Global Definitions

> [l Compenent 1 (comp1)

» ~db Study 1

v {E| Results

Fi Parameters
Datasets
2 Derived Values
EH Tables
I'.’ Electric Potential (ec)
I'.’ Electric Field (ec)
VB Temperature (ht)
W& Current Density
Nl Electric Potential (ec) 1
I'.’ Electric Field (ec) 1
VB Temperature (ht) 1
s 1D Plot Group 8
Global 1
~ @ Isothermal Contours (ht)
¥ lsosurface 1

LR R I N .

v {& Export

[ Animation 1 e

[# Reports

Settings
Animation
g Show Frame

Label: Animation 1
v Scene
Subject: |sothermal Contours (ht)
~ Target

Target: Player

~ Animation Editing

Sequence type: Result parameter
Parameter: iso_level (lsosurface level)
Start: 309

Stop: 310

Unit: K

~ Frames

Mumber of frames: 50

Frame number: 1

6 In the Settings window for Animation, change the Sequence type to Result
parameter and select the iso_level parameter. Type 309 for Start and 310 for
Stop. Click the Play button in the Graphics toolbar or the Show Frame button in
the Settings window for Animation. To get a smoother animation, change the
Number of frames to a higher number; for example, 50.

The subject of parametric sweeps raises the question of parallel computing; it
would be efficient if all parameters were solved simultaneously.
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Parallel Computing

COMSOL Multiphysics and COMSOL Server support most forms of parallel
computing, including shared-memory parallelism for multicore processors and
high-performance computing (HPC) for clusters and clouds. All COMSOL
licenses are multicore enabled. For cluster or cloud computing, including
parallelized sweeps, a Floating Network License (FNL) is needed.

You can use clusters or clouds with one of two options: Cluster Sweep or Cluster
Computing. If you have an FNL, these two options are available by right-clicking
the Study node. However, you first need to enable the Batch and Cluster study
options by clicking the Show More Options button = on the Model Builder toolbar
and selecting Batch and Cluster in the Show More Options dialog.

- o -
Model BU||der Show More Options
A =5y Bl &~ '-v v i Physics
Show More Options... e A Equation Sections

aus - .
v 4 busbar_lll.mph (root) L1547 Equation View
. . [C]+%, Stabilization
» () Global Definitions A - —
4 uation-Based Contributions
[[] Ay Equation-Based Contributi
Elcj: Extra Dimensions
[] &= Advanced Physics Options
[] 2= Show All Variables
v o Study
g" Batch and Cluster
|:|I||II Sensitivity
B8 Multigrid Level
[ (@) Reduced-Order Modeling
[} ‘—ﬁ Solver and Job Configurations

v {E| Results
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CLUSTER SWEEP

The Cluster Sweep option is used for solving several models in parallel where each
model has a different set of parameters. This can be seen as a generalization of
Parametric Sweep. Right-click the Study node to add a Cluster Sweep node.

Model Builder Settings
— ® Ety Elv S B Cluster Sweep
e = Compute (' Update Solution
~ & busbar_lll.mph (root) Label:  Cluster Sweep =
v () Global Definitions
Fi Parameters 1 v Study Settings
{q’ Default Model Inputs
Materials Sweep type: Specified combinations -
> @ Component 1 {comp1) "
v~ Study 1 Pararmeter name | Parameter value list Parameter unit
| Cluster Sweep whb (Width) m
123
=22 Parametric Sweep
[=  Step 1: Stationary
> [Tre Solver Configurations
> E] Job Configurations + =3 | & L_J

> @ Results

v Batch Settings

The Study Settings for Cluster Sweep arc similar to that of Parametric Sweep, but
additional settings are required for the cluster or cloud being used. The picture
above shows how the top of the Settings window for Cluster Sweep would look for
the same sweep as defined in “Parametric Sweeps” on page 172. To add and run
a Cluster Sweep in this case, you would first remove the Parametric Sweep node.

CLUSTER COMPUTING

You can also utilize a cluster or cloud to solve a single large model using
distributed memory. For maximum performance, the COMSOL software cluster
implementation can utilize shared-memory multicore processing on each node in
combination with the Message Passing Interface (MPI) shared-memory model.
This is also known as hybrid parallelism and brings a major performance boost by
making the most out of the computational power available.

Right-click the Study node to add a Cluster Computing node. A Cluster Computing
node cannot be used in combination with a Cluster Sweep. You will be asked if you
want to remove the Cluster Sweep before proceeding. Select Yes.
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The Settings window for Cluster Computing, shown below, helps to manage the
simulation with settings for the cluster or cloud.

Model Builder

— = Et -

~ @ busbar_lll.mph (root)
v () Global Definitions
Fi Parameters 1

4 Default Model Inputs

2 Materials
~ [l Component 1 {comp1)
» = Definitions

2 Materials

5] Heat Transfer in Solids (ht)
.{;3. Multiphysics
A5 Mesh 1
v o Study 1
%% Cluster Computing
1

>
>
> 3 Electric Currents (=c)
>
>
>

Parametric Sweep

Step 1: Stationary
> [fpe Solver Configurations
¥ E_'J Job Configurations

> [El Results

Settings
Cluster Computing
= Compute ' Update Solution

Label: Cluster Computing E

~ Batch Settings

Filename:

[] Generate solver sequence in external process

batchmodel.mph

Mumber of nodes: 1
[] Use batch license
Before sweep
[] Clear meshes
[] Clear solutions
During sweep
[] Synchronize solutions
Clear synchronization data

Save model to file after synchronization is completed

Synchronize accurnulated probe table
After sweep
Output model to file

Cluster computing settings

Settings: Preferences controlled =

> Cluster Settings
> Remote and Cloud Access

> Advanced Settings

The Settings menu under Cluster computing settings has two options: Preferences
controlled or User controlled. The figure above shows the Preferences controlled
option. For the Preferences controlled option, the settings are defined in the
Preferences window in the File menu.
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For the User controlled option, you choose the type of cluster job you want to
perform from the Scheduler type list.

Cluster computing settings

Settings: User controlled =
Scheduler type: General -
Host file: |Genera|

Microsoft® HPC Pack
Bootstrap server:

0GS/GE
Directory: SLURM
[] Specify server direct PES

IEM LSF®

Directory
Mot distributed

[] Specify external COMSUL Batch directory path
Directory
[] Specify external COMSOL installation directory path
Directory

Number of job restarts: 0

Alive time (seconds): 300

COMSOL Multiphysics and COMSOL Server support General, Microsoft® HPC
Pack, Open Grid Scheduler/ Grid Engine (OGS/GE), SLURM, PBS, IBM
LSE®, or Not distributed. The General option is a multipurpose option for Linux
clusters. Additional cluster and scheduler settings, such as Prepend command and
Postpend command, arc available in the Preferences window in the File menu.

®

To learn more about running in parallel, see the Reference Manual.

The Cluster Sweep and Cluster Computing options are only visible if you
have an FNL and have enabled the Batch and Cluster study options.
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COMSOL Multiphysics Client-Server

When using COMSOL Multiphysics with an FNL, it is possible to use a client—
server mode of operation to access remote computing resources for solving large
models, while still using the graphics card on a local machine to display graphics.
This mode of operation should not be confused with the use of Windows®
Remote Desktop, and similar technologies, to connect to a COMSOL
Multiphysics session, or the use of the COMSOL Server product for use with
COMSOL applications.

Using the COMSOL Multiphysics client—server mode can have some significant
advantages, since engineering and scientific computing problems involve working
with large amounts of data — anywhere from megabytes to gigabytes of data are
commonly generated during a simulation. To generate and store this data, you
may want to use computers with fast processors, large amounts of Random Access
Memory (RAM), and a large hard drive. To visualize large datasets, it is important
to have a high-end graphics card on your local computer.

Under ideal conditions, you would always be working on a high-end computer
with more than enough memory and processing power for all of the simulation
steps. If this is not the case and you need to solve larger models, you may instead
access a shared computing resource across a network.

At any time while using COMSOL Multiphysics, it is possible to connect to a
remote computing resource via the client—server mode of operation. This is a
two-step process. First, log onto the remote system and invoke the COMSOL
Multiphysics server, which will start the COMSOL Multiphysics server process
and open a network connection. Second, on the local machine, simply enter the
network connection information into an open session of COMSOL Multiphysics.
The software then transparently streams the model data and results back and forth
over the network and uses the remote computing resource for all computations.

There are several ways to start a COMSOL Multiphysics server session. In
Windows® 10, you can start a server session from the COMSOL Launchers option
from the Windows start menu.

« - 4 « 05(C) » Program Files » COMSOL » COMSOLE3 » Multiphysics » COMSOL Launchers v @

iR COMSOL Documentation 3 COMSOL Multiphysics 6.3 (OpenGL)

# Quick access . . . .
13 COMSOL Multiphysics 6.3 (Software) L3 COMSOL Multiphysics 6.3

@ OneDrive - Personal 13 COMSOL Multiphysics Client 6.3 & COMSOL Multiphysics Server 6.3
ELmTooLs 3 Setup

3 This PC i, -
12 Uninstall i3 Update

¥ Network
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In Linux®, you can use the comsol mphserver command. The server and client
sessions can be run on different operating systems. For example, the server can run

in Linux® and the client session in Windows®.

The first time you start a COMSOL Multiphysics server on a computer, you are
asked for a username and password that are associated with the client-server mode
of operation and stored for future connections. The figure below shows the

command window for starting a server session in Windows®.

& CA\Program Files\COMSOL\COMSOLE3 \Multiphysics\bin\win64\comsolmphserver.exe

Username: paul

COMSOL Mul y
Use the console

The figure below shows how to connect to a server session from the COMSOL
Desktop user interface. From the File menu, select COMSOL Multiphysics Server >
Connect to Server to connect.

a b & 2 v v ~  Untitled.mph
File

[ New Ctrl+N

5] Run Application

% Open.. Ctrl+0

P Open From... Ctrl+Shift+0

[ Application Libraries

Save Ctrl+S

@ Save As...

I saveTo... Ctrl+Shift+5

=| Compact History
COMSOL Multiphysics Server > h Connect to Server...
Help >

T Licensed and Used Products...

Preferences...

Exit
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You are now prompted for the username and password that you gave the first time
you started a server session.

3 Connect to COMSOL Multiphysics Server X
Server User

Server: | myserver.address.com Username: | paul

Port: Default M Password: | esssss

Remember username and password

oK Cancel

For more information on running the COMSOL Multiphysics client-server, see
the Reference Manual.
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Using the Model Manager

This section gives a brief introduction to using the Model Manager for simulation
data management. The Model Manager allows users to collaborate and centrally
organize models and apps and provides tools for version control, efficient storage,
searching for MPH-file contents, and more. A database can either be stored locally
on your computer for personal use, or, if you have an FNL, accessed remotely
from a server for collaborative use. You will learn how to create a local Model
Manager database, store simulation data, and control versions.

For detailed information on using the Model Manager, see the book Model
Manager Refevence Mannal.
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Creating a Local Database

Assuming you have not already created a local database, this is how you create one
in order to get started using the Model Manager.

In the File menu, the Open and Save As menu items let you open and save files to
a local or shared file system. The Open From and Save To menu items also let you
open and save to a Model Manager database.

I From the File menu, sclect k& Open From.

e [ & = v
File
[ MNew Ctrl+N
[ Run Application
& Open.. Ctrl+0
P Open From... Ctrl+Shift+0 G
[ Application Libraries
] save Ctrl+5
[ Save As..
I saveTo... Ctrl+Shift+5

ek

Compact History

COMSOL Multiphysics Server >
Help >
T Licensed and Used Products...

Preferences...

Exit

2 In the Open window, choose = Add Database in the list of options.

Open

‘(_D/ Recent

= Add Database G

r' Browse
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3 In the Add Database window, choose New Local Database

Add Database

©

Mew Local
Database

Open Local
Database

=

Connect to
Server Database

4 In the New Local Database window, type Modeling Example as the name for the
new database in the Name field. You can choose a more suitable name if you
intend to keep using this database.

New Local Database

Database name
Mame  Modeling Example G

Databases directory

Directory: | C:\Users\alice\AppData'Local\COMSOL\ModelManager\Databases ¥ Browse

G oock
Help 9 Concel [V Add Database

©

5 Click [/ Add Database.
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A progress window is displayed, informing you that the database is being created
on the file system.

Progress

Creating local database

Once finished, the Open window is shown with the newly created database selected
in the list.

e O & ® - - S Untitled.mph - COMSOL Multiphysics
File
Open
(_L) Recent ¢ B~ vl¥- * Mo results found
- Q Search | k) v

IE_E Modeling Example
IE’ Add Database

r' Browse

H&Ip eiar\cel G Open Run

6 From the Open window, you can search the database for models to open. At the
moment, your database is empty. Click € Cancel.
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Version Control

MODEL WIZARD SETUP

For the purpose of demonstrating using the Model Manager, we will revisit the
wrench model “Example 1: Structural Analysis of a Wrench” on page 40 and start
anew from the Model Wizard.

I From the File menu, select New. In the New window, choose Model Wizard.
2 In the Select Space Dimension window, select 3D.

3 In Select Physics, select Structural Mechanics > Solid Mechanics (solid) = . Click
Add. Click Study @ to continue.

4 Sclect Stationary [~ under Preset Studies. Click Done [/ once finished.

SAVING A FIRST VERSION
Place your new model under version control by saving it to your database.
I From the File menu, select [ Save To.

2 In the Save window, choose your newly created database, Modeling Example,
from the list of options.

The Save window updates with the selected database set as the target for the
save. The header reads Save new as the model is not yet present in the database.

3 Type 3D stationary solid mechanics in the empty Title field.
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4 You can type an optional comment describing what you are saving in the
Comments field. Type Setup for a 3D solid mechanics model using a
stationary study.

Save new
Title: 3D stationary solid mechanics
Comments:

Setup for a 30 solid mechanics model using a stationary study.

o

Save =

5 Click the Save button ([_] ).

A first version of the model is now saved in the Modeling Example database.

Click the root node in the Model Builder window. The Title field in the Presentation
section of the Settings window has been updated with the title you gave when
saving.

SAVING ADDITIONAL VERSIONS

The model uses a geometry that was previously created and stored in the
COMSOL native CAD format mphbin.

I In the Model Builder window, right-click Geometry 1 '~ and select Import = .

2 In the Settings window for Import, from the Source list, sclect the COMSOL
Multiphysics file.

3 Click Browse P& and locate the file wrench.mphbin in the applications folder of
the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL63\Multiphysics\applications\
COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin

Double-click to add, or click Open.
4 Click Import /= to display the geometry in the Graphics window.
5 Select Geometry | ‘4 and click the Build All button g in the Settings window.

With the geometry imported to the model, save a second version:
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I From the File menu, select [ Save as Version.

File Home  Definitions  Geometry  Materials

[ MNew Ctrl+N

[ Run Application

& Open.. Ctrl+0

P Open From... Ctrl+Shift+0

Recent >

[ Application Libraries
" [ save Draft Ctrl+5

[£2 save as Version... G
I saveTo... Ctrl+Shift+S

Revert to Saved Ctrl+Shift+R

The Save window opens with your database preselected in the list of options.

e B B B - . < 3D stationary solid mechanics - COMSOL Multiphysics - [m]

File

Save
| Save version v Information

= Modeling Example

Title: 3D stationary selid mechanics Latest version: Oct 7, 2024, 4:44:26 PM

Comments: Saved by:

=] Add Database
| > Description

- By BS
= Browse Tags
No tags assigned.

Save v

The header reads Save version, as the model already exists in the database. The
title is the same as when saving the first version.
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2 In the Title field, change the title to Structural analysis of a wrench and type
Added a geometry for a wrench in the Comments field.

Save version

Title: Structural analysis of a wrench

[ 2)

Comments:

Added a geometry for a wrench

Save =

3 Click the [] Save button.
You now have two versions of the model saved in your database.

For the purpose of demonstrating multiple versions, we will make a small change
to the model and save another version by adding a description to the model. This
will be the third version.

| Click the root node in the Model Builder window.

2 In the Description ficld under the Presentation scction, type Analysis of the
mechanical stress level in a wrench.

3 From the File menu, select [ ] Save as Version.
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4 Type Added a description. in the Comments field. Click Save.

Save version

Title: Structural analysis of a wrench

Comments:

Added a description. c

Save =

THE VERSIONS WINDOW

Up to this point, you have saved three versions of the model in the database.
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I From the Windows menu = in the Layout section of the Home tab, select
Versions to open the Versions window.

=5 =

Windows Reset
v Desktop ~

1 Add Physics

21 Add Multiphysics

"% Add Study

[®, Result Templates

21 Add Material from Library

B Material Browser

[ Application Libraries

m]] Part Libraries

2= Add-in Libraries

=% Selection List

Properties and Comments
= Auxiliary Data

Messages

Table

External Process

Comparison Result

J -

Find and Replace

Versions G

2 You will see the three versions in a table in chronological order, with the most
recent version in the first row and the oldest version in the last row. The first
row in the table is highlighted in bold to indicate that it is the current version
in the COMSOL Desktop.

Messages Progress Log WVersions X

& sk {5 Structural analysis of a wrench”: Showing 3 versions Modeling Example (Repository 1/Main)
Title Saved Saved By Branch Comments

[+][Structural analysis of a wrench Oct7, 2024, 4:50:31PM  Alice Main Added a description.

[5] Structural analysis of a wrench Oct 7, 2024, 4:48:16 PM Alice Main Added a geometry for a wrench

[#] 3D stationary selid mechanics Oct7, 2024, 44426 PM | Alice Main Setup for a 30 solid mechanics model using a stationary study.

©

OPENING OLDER VERSIONS

You can easily open an older version from the Versions window.
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I Select the last row in the table and click the Open button in the toolbar. You
can also double-click the row. Select No if you are asked to save any unsaved
changes.

Messages Progress Log versions X

(&) sfe (D "Structural analysis of a wrench":
Title Saved

[#] |Structural analysis of a wrench Oct 7, 2024, 4:50:31 FM

[#] |Structural analysis of a wrench Oct 7, 2024, £:4%:16 PM

|+] ]3D stationary solid mechanics |Oct 7, 2024, 4:44:26 PM

The first version is opened in the COMSOL Desktop. In this version, there is
no Import = node under the Geometry |1 A node, and the Description field is

empty.
2 Select the middle row in the table and click Open

The second version is opened in the COMSOL Desktop. In this version, the
Import node is now present under the Geometry node, but the Description ficld
is still empty.

3 Select the first row in the table and click Open
The third, and latest, version is opened in the COMSOL Desktop.
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Working with a Draft of the Model

It may have crossed your mind that saving a new model version requires several
steps — especially compared to just pressing Ctrl+S for a model opened from the
file system. You need to open the Save window, think of a comment describing
your changes (although the comment is not required), and then click the Save
button []. You might even realize after saving multiple versions that your
modeling work has gone in the wrong direction. You would then have a version
history cluttered with unwanted versions.

A more lightweight option when working on a model is to save a draft of the
model. You can save multiple versions of this draft without affecting the original
model. Once you are happy with your draft, you can save it as a new version of the
original model. You may of course choose to discard your draft altogether and
instead go back to the original model and, perhaps, start a new draft.

STARTING A NEW DRAFT

Let’s continue working with the wrench model but now using drafts. Make sure
that you have opened the latest (first-row) version in the Versions window.

Add a generic steel material for the wrench and save your work as a new draft.

I Click Component | > Materials :: , in the Geometry Cleanup dialog box, click
Clean up Automatically. If you earlier selected the checkbox Remember my choice,
then this dialog box will not be displayed.

2 Right-click Component | > Materials and select Add Material from Library

3 In the Add Material window, click to expand the Built-In folder. Scroll down to
find Structural steel, right-click, and select Add to Component 1.

4 Close the Add Material window.

202 |



5 From the File menu, select [} Save Draft. You can also use the keyboard
shortcut Ctrl+S.

File Home  Definitions  Geometry  Material

[ MNew Ctrl+N

@ Run Application

& Open.. Ctrl+0

P Open From... Ctrl+Shift+0
Recent >

[ Application Libraries

') save Draft Ctrl+5 e

| 4 save as Version...

I saveTo... Ctrl+Shift+5

Revert to Saved Ctrl+Shift+R

| Compact History
COMSOL Multiphysics Server >
Help >

T Licensed and Used Products...
Preferences...
Exit

You have now created a first version of a draft of the model. You can see this draft
version as a new row in the table in the Versions window above the three versions
of the original model. The draft version uses a separate pen icon ( ) to
distinguish it from the regular versions ( [+] ). Note that the regular versions
belong to the original model, not the draft itself — they are included in the table
to make it easier for you to track where the draft originated from.

Messages Progress Log Versions X

c a9 Structural analysis of a wrench': Showing 4 versions Modeling Exarple (Repository 1/Main)
Title Saved Saved By Branch Comments

j Structural analysis of a wrench Oct 7, 2024, 5:06:50 PM  Alice Main Draft of *Structural analysis of a wrench’ saved by user.

[#] Structural analysis of a wrench Oct 7, 2024, 4:50:31 PM Alice Main Added a description.

[] [Structural analysis of a wrench Oct7,2024, £49:16 PM | Alice Main Addled 3 geometry for 3 wrench

[+] 30 stationary solid mechanics Oct7, 2024, %4426 PM  Alice Main Setup for a 3D solid mechanics model using a stationary study.

SAVING ADDITIONAL DRAFT VERSIONS

Just like in “Example 1: Structural Analysis of a Wrench” on page 40, now specify
the load applied to the wrench and save your draft changes.

I Select Parameters 1 P; in the Model Builder window.
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2 In the Settings window’s Parameters table, enter these settings:
- In the Name column, enter F.
- In the Expression column, enter 150[N].
- In the Description column, enter Applied force.
3 From the File menu, select [/ Save Draft.
Selecting Save Draft a second time creates a second version of your draft — the
Versions window now contains two draft versions and three regular versions.

Just as for the regular versions of the original model, you can inspect an older draft
version by selecting the corresponding row in the table and clicking Open

A draft is a model in its own right in the database — existing side-by-side with the
original model. You can switch back and forth between them in the COMSOL
Desktop simply by opening one or the other.

I From the File menu, select Open From (J&-).
2 In the Open window, choose your database, Modeling Example, in the list of
options.

The Open window shows a list containing the latest version of the draft ( /) and
the latest version of the original model ( [+] ).

(&) Y ¥~ ¥ 2 of 2 results shown

O, Search 1| =

Structural analysis of a wrench
Oct 4, 2021, 12:37:41 PM (Alice)

Structural analysis of a wrench G
Oct 4, 2021, 12:32:17 PM (Alice)

Open Run
3 Select the version of the original model ( [+] ) and click the Open button

The Model Manager detects that there is a draft of the original model in
progress that corresponds to a draft version that is newer than the latest version
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of the model. A dialog appears, in which you can choose to open that newer
draft version instead.

Open *

More recent versions found for the selected model in branch 'Main'.

rl |:| Structural analysis of a wrench -Sep 16, 2022,12:32:17 PM (Alice) G
:l Structural analysis of a wrench -Sep 16, 2022,12:37:41 PM (Alice)

Open Cancel

4 Select the top node in the tree and click Open to open the original model. The
latest version of the model is opened in the COMSOL Desktop — neither the
Structural steel node nor the Parameters scttings is present in the model, as
expected.

You could, at this point, continue working with the original model, thereby
implicitly discarding your draft work. The draft itself can be manually deleted from
the database at some later time.

Assume that you choose to continue with your draft. Open the latest version
again:

I From the File menu, sclect Open From J&.

2 In the Open window, choose your database in the list of options.

3 Select the draft version ( [7:) and click Open

Finish the component setup by defining boundary conditions and mesh settings:

I Right-click Solid Mechanics (solid) = and select Fixed Constraints ju .
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2 In the Graphics window, rotate the geometry and select the front surface of the
partially modeled bolt. The Boundary number in the Selection list is 35.

3 Right-click Solid Mechanics (solid) =1 once more and select Boundary Load i .
4 Sclect the top socket face (boundary 111) in the Graphics window.

5 In the Settings window for Boundary Load, under Force, sclect Total force as the
Load type and enter -F in the text field for the z component.

6 Sclect Mesh I 4 . In the Settings window for Mesh, under Physics-Controlled
Mesh, sclect Coarser from the Element size list.

7 Click the Build All & button in the Settings window.
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With the basic setup finished, select Save Draft [ to save a third draft version.

Messages Progress Log Versions

(&) sfe IO “Structural analysis of a wrench': Showing 6 versions Modeling Example (Repository 1/Main)
Title Saved Saved By Branch Comments

" ]lStructural analysis of a wrench Oct7, 2024, 5:16:15PM  Alice Main Draft of ‘Structural analysis of a wrench' saved by user. 6

5] |Structural analysis of a wrench Oct7, 2024, 5:10:13 PM | Alice Main Draft of ‘Structural analysis of a wrench’ saved by user.

%] |Structural analysis of a wrench Qct 7, 2024, 5:06:50 PM Alice Main Draft of 'Structural analysis of a wrench' saved by user.

[] [Structural analysis of a wrench Oct7, 2024, £50:31 PM |Alice Main Added a description.

[#] [Structural analysis of a wrench Oct7, 2024, £49:16 PM | Alice Wain Added a geometry for a wrench.

[] 3D stationary solid mechanics Oct7, 2024, 44426 PM  |Alice Main Setup for a 3D solid mechanics model using a stationary study.

FINISHING YOUR DRAFT

With the component setup finished, you can save your draft work back to the
original model:

I From the File menu, select [ Save as Version.

The Save window opens with your database preselected in the list. The header
reads Save version from draft as a new version of the original model that will be
saved from the draft.

2 Type Finished model for the von Mises stress in a steel wrench in the
Comments field.

version from draft

Title: Structural analysis of a wrench

Comments:

Finished model for the von Mises stress in a steel wrench

Save -

3 Click the Save button
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Open the Versions window to see that all draft versions are now gone from the
table. Instead, there is a fourth version of the original model and the draft itself

has been deleted.

Messages Progress Log fersions X

c sl L9 Structural analysis of a wrench”: Showing 4 versions Modeling Example (Repository 1/Main)
Title Saved Saved By Branch Comments

D Structural analysis of a wrench Oct 7, 2024, 5:21:31 PM  Alice Main Finished model for the von Mises stress in a steel wrench.

[#] Structural analysis of a wrench Oct 7, 2024, 450:31 PM Alice Main Added a description.

[5] Structural analysis of a wrench Oct7, 2024, 44916 PM | Alice Main Added a geometry for a wrench.

[#] 3D stationary solid mechanics Oct7, 2024, 44426 PM | Alice Main Setup for a 30 solid mechanics madel using a stationary study.
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Comparing Versions

You can see all changes made to the model when you save it from your draft.
I Right-click the second row in the table in the Versions window and select
Compare ( 5]z ).
The Comparison Result window is opened with a comparison between the
current model in the COMSOL Desktop and the selected version.

2 The expanded tree shows, for example, the force parameter, the steel material,
the mesh settings, and the two boundary conditions added from your draft.
Graphics  Comparison Result %

B =ty - = ot

Compare with opened

"
Opened Saved version

[#] |Structural analysis of a wrench [] | Structural analysis of a wrench — Oct 7, 2024, 4:50:
Differences
Filter results: Exclude all matching labels ~ AT T ip

Regular expression:

~ g Structural analysis of 2 wrench
~ Pi Parameters

~ b Variables that only exist in local file
a= F
>

Views
Definitions
Materials
T ltems to be added to remote file
> aga Structural steel (mat1)
Meshes
A Mesh 1
e Attributes differ
> = Features

< Iomom

<

~ = Physics
~ 57 Solid Mechanics (solid)
~ = Festures
~ &5 Items to be added to remote file
> fmw Fixed Constraint 1
> (s Boundary Load 1

Comparing values

"
Attribute Value in opened Value in saved

b |Expression (F) 150[N]

&

You can also compare two older versions with each other:

I Select the second and third rows in the Versions window, using Ctrl+click, then
right-click either one, and select Compare ;] .

The Comparison Result window is updated with a comparison between these two
versions.
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2 Expand the tree and select the Attributes differ child node. In the Comparing
values table, you will find the description you added in the third model version.

4 gfu Structural analysis of a wrench
iTe Attributes differ

Comparing values G
L

Attribute Value in older Value in newer

iT | Description Analysis of the mechanical stress level in a wrench

3 Close the Comparison Result window.
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Excluding Built, Computed, and Plotted Data

Let’s now run the study. First, make sure you have the latest version of the model
opened:
I In the Versions window, double-click the first row.

2 Right-click Study | ~& and select Compute = to solve the model. When the
computation finishes after a few seconds, the von Mises stress is displayed in a
default Volume plot in the Graphics window.

Storing simulation data generated by a model can require large amounts of disk

space. For such data that is reproducible — such as built, computed, and plotted
data — it may be undesirable, or even impossible due to sheer size, to save it in

the database. To control which data is saved in the database:

I Select the root node in the Model Builder window.

2 In the Settings window, in the Save section under Built, computed, and plotted
data, in the In database list, sclect Exclude.

v Save
Built, computed, and plotted data
On file:
Include =

In database:

Exclude - G

Include in regular and draft versions
Include in regular versions
Include in draft versions

Exclude
TUCTEUICTTOTTT PTErSrenCes oeraungy T

Note that by using the On file list menu, you can also exclude built,
computed, and plotted data when saving to the file system.

3 From the File menu, select [1 Save as Version.

The Save window opens for your database with the message Built, computed, and
plotted data is excluded from the save under Information.

Information

Latest version:  Oct 4, 2021, 12:47:03 PM e
Saved by: Alice

Built, computed, and plotted data is excluded from the save.

@

4 Type Saved without generated simulation data. in the Comments field.
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5 Click Save

The model remains in its solved state in the COMSOL Desktop after the save. Go
to the File menu, select [=] Revert to Saved, and click Yes in the dialog that appears.
The latest saved version without the solution is opened. You can reproduce the
lost (by now) solution by right-clicking Study | ~s» and selecting Compute = .
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Importing Auxiliary Data to the Database

You may have noticed that, while the model is version-controlled in the database,

the same is not true for the CAD input file. You can import the file to the database

as follows:

| From the Windows menu = in the Layout section on the Home toolbar, select
Auxiliary Data to open the Auxiliary Data window.

The Auxiliary Data window shows the input files used in the model. In this case,
a single row is shown, corresponding to the CAD file that is used in the Import

= node.
Messages Progress Log Auxiliary Data X Versions
o
Node Setting Location Status
[ Import 1 (imp1) (Companent 1 (comp1) > Geometry 1) |Filename (Source) C:\Pragram Files\COMSOL\COMSOLE3\Multiphysics\appli... Availsble on disk

o

2 Select the table row, right-click on either row, and select Import to Database = .

3 The Import dialog shows the file wrench.mphbin in a table.

[ Import
Target location: Modeling Example (Repository 1/Main)

File Source
[Z] |wrench.mphbin | C:\Program Files\COMSOL\COMSOLE3\Multiphysics\applications\ COMSOL_Multiphysics\Structural_Mechanics\wrench.mph

©

1item to import.

Options
Include auxiliary files found in imperted models
Tags: Mone -
Computed data: Include or exclude based on application settings

OK Cancel

4 Click OK.
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Select the Import 7= node in the Model Builder window. The Filename field in the
Import section in the Settings window now shows a reference to the file that is

uploaded to the database.

Model Builder

— = Et -

4

v @ Wrench (root)
v () Global Definitions
Fi Parameters 1
4 Default Model Inputs
2 Materials
~ [l Component 1 {comp1)
» = Definitions
v Geometry 1
= Import 1 (imp1)
Form Union (fin)
Remove Details 1 {rmd 1)
£ Cleanup Log
v ige Materials

> EpE Structural steel (mat1)
v =2 Solid Mechanics (solid)
&= Linear Elastic Material 1

Settings
Import
) Build Selected » [E8 Build All Objects B

Label: Import1

~ Source

Source:
COMSOL Multiphysics file
Filename:
wrench.mphbin (Modeling Example)
W& Browse ¥ [[& Import

~ Virtual Geometry

Include result from virtual operations

~ Selections of Resulting Entities

Finish by saving the model to the database:

I From the File menu, sclect [ Save as Version.

2 Type Referenced CAD file from database. in the Comments ficld. Click Save
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The Model Manager Workspace

This concludes this quick introduction to the Model Manager. For detailed
information on using the Model Manager, see the book Model Manager

Reference Manual.

You are encouraged to further explore the Model Manager in the Model Manager
workspace. This is a dedicated workspace in the COMSOL Desktop for tasks

related to using the Model Manager.

To open the Model Manager workspace, click the Model Manager

button in the

Workspace scction of the Home toolbar. In the Model Manager workspace, you will
see the Model Manager toolbar as well as various windows belonging to the
workspace. The latest versions of your model and CAD file are displayed.

Q search | 5] =

Title Tags Saved |0
[+] [structural analysis of a wrench Oct7,2024, 52131 PM | |

(@ MNew commits detected on branch, Current results may be out of date. Refresh for updated results.

Versions X Commits References

“Structural analysis
EEl e L2 D ofawrench" Modeling Example (Repository 1/Main)
Showing 5 versions

Title Saved
[=][Structural analysis of a wrench Oct 7, 2024, 5:51:11 PM
[+] [Structural analysis of a wrench Oct 7, 2024, 5:21:31 PM
[5][structural analysis of a wrench Oct 7, 2024, 4:50:31 PM
[+] Structural analysis of a wrench Oct 7, 2024, 4:4%:16 PM
[5][3D stationary solid mechanics Oct 7, 2024, 4:44:26 PM

23GB|246GB

a e & B v v »  Structural analysis of a wrench - COMSOL Multiphysics - O

File Database

y’ 3 = Import Open b Compare =

¥ A = I P ke p %

) ) = Export Run Set Tags
Model Application  Modeling  Add Windows ~ Reset
Builder  Builder Example «  Database o PreviewFile [j Delete - Desktop
Workspace Database Item Layout

Model Manager Settings
€] 9 v =+ [EE 10f1 results shown Modeling Example (Repository 1/Main)  M°de!

e

Save 4 Reset

v Version

. . .
Locwiars Modipo el sy
Saved: Qct 7, 2024, 5:51:11 PM
Saved by:
Saved in: 6.3
Title: Structural analysis of a wrench
Filename:

Update from:
Description:

Analysis of the mechanical stress level in a
wrench

i
il

v Contents Et~

~ @ Structural analysis of a wrench (root)
@ Global Definitions
v [l Component 1 (comp1)

» = Definitions

» YA Geometry 1

> :it Materials

» =3 Solid Mechanics (solid)

A Mesh 1

» ~db Study 1

> B Results

x
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To learn more about what you can do in the workspace, you can, for example:

* Seclect the model and expand the model tree in the Content section of the
Settings window. Here, you can browse the content of a model without
opening it.

 Search for your model by applying various Item and Contents Filters. Examples
include a Physics filter for finding a Solid Mechanics interface (=) or a
Parameter filter for the applied force 150[N].

* Right-click the model and seclect References (% ) to see the database

relationship between the model and the CAD file in the References window.
* Right-click the CAD file and select Versions ( 7 ) to see all versions of the
file — currently only one — in the Versions window.

* Right-click the model and select Commits ( (%) ) to open the Commits window.
Double-click the third table row from the top. You will see details on the
commit in which a new version of the original model was saved from your
draft, and the draft itself was deleted.

In order to more easily test the various features of the Model Manager, you can
download a demo database by selecting, from the File menu, Help > Download
Demo Database for Model Manager.

Help > B Help F1
T Licensed and Used Products... |! Documentation Ctrl+F1
Preferences... @ Application Gallery
Exit i Support Center
Training

(%) Check for Product Updates

Update COMSOL Application Libraries

Update COMSOL Part Libraries

)

o
i

Update COMSOL Add-in Libraries

= Download Demo Database for Model Manager

m

About COMSOL Multiphysics

This demo database contains models and associated files from the Application
Libraries.
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Appendix A — Building a Geometry

This section details how to create the busbar geometry using the built-in geometry
tools in COMSOL Multiphysics. The step-by-step instructions take you through
the construction of the geometry using the parameters set up in the Global
Definitions section.

All geometry operations under the geometry node in the model tree are organized
in a parametric sequence of operations called a geometry sequence. Using
parameterized dimensions helps to produce what-if analyses and geometric
parametric sweeps.

As an alternative to building the geometry using the tools available in COMSOL
Multiphysics, you can import a geometry created with CAD software. The
optional CAD Import Module and Design Module support many CAD file
formats. Moreover, several add-on products are available that provide
bidirectional interfaces to common CAD software packages. See “Appendix E —
Connecting with LiveLink™ Add-Ons” on page 266 for a list. Note that the
Design Module, in addition to the features available in the CAD Import Module,
adds functionality for dimensions and constraints. The Design Module also
includes additional 3D geometry modeling operations such as loft, fillet, chamfer,
midsurface, and thicken.

If you have not done so already, start with “Example 2: The Busbar — A
Multiphysics Model” on page 81. Follow the steps in the section “Model Wizard”
on page 41 to add the physics and study and then follow the steps under Global
Definitions to add the parameters, which are then used in the remainder of this
section. Return to this section to learn about geometry modeling.

Alternatively, load the model busbar_geom from the Application Libraries tree
under COMSOL Multiphysics > Multiphysics. Then, in the model tree, right-click the
Geometry node and select Clear Sequence. This deletes all geometry operations
from the model tree.

The first step in the geometry sequence is to draw the profile of the busbar.
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I Under Component I, right-click
Geometry | » and sclect Work Plane =..
In the Settings window for Work Plane:

- Sclect xz-plane from the Plane list (the

last option in the list).

- Click the Go to Plane Geometry
button 4 on the toolbar in the
Settings window for Work Plane.

Continue by editing the axis and grid

settings in Work Plane 1.

2 In the Model Builder window, expand
the View 2 node 1~ and click Axis 1.

v Geormnetry 1

~ [E] Work Plane 1 (wp1)
| Plane Geometry
v [ view2

[y Axis G

- Form Unien (fin)

3 In the Settings window for Axis:

Under Axis:

- In the x minimum and y minimum

fields, enter -0.01.

- In the x maximum and y maximum

fields, enter 0.11.
Under Grid:

- Seclect the Manual Spacing checkbox.
- In the x spacing and y spacing ficlds,

enter 5e-3.

4 Click the Update button ¢ on the

toolbar.

Note that the values you type will
automatically adjust slightly after you
click Update to adapt to the screen

aspect ratio.
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Settings
Work Plane
) Build Selected » [ Build All Objects &3

Label:  Work Plane 1 E
~ Plane Definition

Plane type: CQuick =

G Plane: xz-plane -

Offset type: Distance -

y-coordinate: 0 m
» Local Coordinate System

~  Unite Objects

Unite objects

Repair tolerance: Autornatic A

~ Selections of Resulting Entities
[T] Resulting objects selection

Show in physics: Boundary selection
Color: Mene

Selections from plane geometry

[] Show in physics

Cumulative selection

Contribute to: Mone - MNew
Settings
Axis
(#) Update G
Label:  Axis E

G Axis

x minimum: =001
x maximurm: 0,11

y minimum:  -0.01

8 83 83 8

y maximurm: 0,11

View scale: Mone

~ Grid

Manual spacing G

¥ spacing:  3e-3
y spacing:  5e-3
Extra x: m L.

Extra y: m L



You can use interactive drawing to create a geometry using the drawing tools from
the Sketch tab on the ribbon while pointing and clicking in the Graphics window.

File Home  Work Plane  Sketch  Developer

7 +| Snap to Grid /71 Solid A e . 7" Draw Quadratic ,:I
_ WA . ° S = .y . -
Sketch et 1\ Construction Polygon  Circular  Interpolation **° SR Rectangle
l—g Constrain Arc v Curve ~ = Point ¥
Sketch Draw Settings Draw

You can also right-click the Plane Geometry node % under Work Plane 1 = to add
geometry objects to the geometry sequence. Note that you can add geometry
objects in the same way from the Work Plane tab on the ribbon. For clarity, this
example will demonstrate the noninteractive way of creating the geometry (not
using the Sketch tab).

In the next few steps, we create a profile of the busbar.

5 In the Model Builder window under Work Plane 1, right-click Plane Geometry 2
and select Rectangle .

In the Settings window for Rectangle

under Size, enter: Settings

Rectangle
- L+2*tbb in the Width field. [ Build Selected ~ [E Build Al B
- 0.1 in the Height field. Label: Rectangle 1 =

Click the Build Selected button & . .
~ Object Type

Type: Solid =

~ Size and Shape

e Width:  L+2%thb

Height: 0.1
~ Paosition

Base: Corner =
wow: 0

yw: 0
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6 Create a second rectangle. Under
Work Plane |, right-click Plane Settings

Geometry A and select Rectangle 1. Reclanaie
) Build Selected ~ [E8 Build All B

Under Size, enter:

. . . Label: Rectangle 2 _@
- L+tbb in the Width ficld.
: . v Object T
- 0.1-tbb in the Height field. S
Under Pesition, enter: Type | Solid S
- tbb in the yw field. v Size and Shape
Click the Build Selected button = . c Vodifchy) +thl
Height:  0.1-tbb
Use the Boolean Difference operation et
N ositon

to subtract the second rectangle from
the first one. Base: | Comner

7 Under Work Plane 1, right-click Plane -
Geometry ¥ and sclect Booleans and
Partitions > Difference . In the
Graphics window, click r1 (the larger of the two rectangles) to add it to the
Objects to add list in the Settings window for Difference.

yw:  thb

To help select the geometry, you can display geometry labels in the
Graphics window. In the Model Builder window under Geometry | >
WorkPlane 1, click the View 2 node. Go to the Settings window for View
and select the Show geometry labels checkbox.
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8 Click the Difference node. In the
Settings window for Difference, click Settings
the Active selection button to the left Difference -
of the Objects to subtract list. Select ¥ BulldSelected 88 Buld Al B8
the smaller rectangle, r2, by using the LaicEly| Difference 1 S
mouse scroll wheel or arrow keys to « Difference
cycle through the overlapping

Objects to add:

rectangles to first highlight it and " 8
then click on it to select it. e &= @ —
Click Build Selected = . oo
Another way to select r2 in the

Graphics window is to use the s

Selection List feature. Go to the Home
tab on the ribbon and select Windows Z g
> Selection List. In the Selection List, G @& —
click to highlight r2 (solid). Then, & &
right-click r2 (solid) in the list and

select Add to Objects to Subtract for

Difference to add it to the Objects to

subtract list. Right-click on the

Selection List window title and select Close.

Ohbjects to subtract:

After building the selected geometry, you should have a backward-facing,
L-shaped profile. Continue by rounding the corners of the L-shaped profile.

eaf- ¢l - @ @-@-BF «20- B3O 5-@8
‘ !
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9 Under Work Plane I, right-click Plane Geometry A and select Fillet .

Select point 3 (in the inner-right corner) to add it to the Vertices to fillet list.

There are different ways to add points:

- In the Graphics window, click point 3 to add it to the Vertices to fillet list.

- From the Home tab, sclect Windows > Selection List. In the Selection List
window, click 3. The corresponding point is highlighted in the Graphics
window. Click the Add to Active Selection for Fillet button + in the Settings
window for Fillet or right-click in the Selection List.

Settings
Fillet
] Build Selected » [E Build All &8

Label: |[Fillet 1 =

~ Points

Vertices to fillet:

v dift
(97 :

o

B 50 (i}
|

~ Radius

@ Radius: thb m

I0 Enter tbb in the Radius field. Click Build Selected & .

This creates a fillet at the inner corner.
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Il For the outer corner, right-click .
Plane Geometry » and select Settings

o Fillet
Fillet 1.
a ] Build Selected » [E Build All &8

121n the Graphics window, click point

X Label: Fillet 2 =
6, the outer corner, to add it to the s
Vertices to fillet list. v Points
I3 Enter 2*tbb in the Radius field. Click Vertices to fillet:
; . v fil Bl
Build Selected = . @ ; & —
o §
~ Radius

G Radius:  2*tbb m

The result should match this figure:

Graphics <8
aa@r&@ b &y @ = 2@~ T O -G-@8

0.17] r

In the Design Module you will find tools available in the Sketch tab for
interactive drawing and dimensioning of fillets and general 2D sketches.

Next, extrude the work plane to create the 3D busbar geometry.
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I In the Model Builder window, right-click Work Plane | & and select Extrude =
In the Settings window for Extrude, enter wbb in the Distances from Plane table
(replace the default) to extrude to the width of the profile.

~ Distances
Specify: Distances from plane -

L3
Distances (m)

o -

=) * H=hy

The table allows you to enter several values in order to create sandwich

structures with different materials. In this case, only one extruded layer is
needed.

2 Click Build Selected » and then click the Zoom Extents |:j button on the Graphics

toolbar. Click the Save button [ and name the model busbar.mph (if you have
not already done so).

0.05 m

Next, create the titanium bolts by extruding two circles drawn in two work
planes.
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3 In the Model Builder window, right-click Geometry | 2 and add a Work Plane ..
A Work Plane 2 node is added. In the Settings window for Werk Plane, under
Plane Definition, sclect Face parallel as the Plane type.

Model Builder Settings
— + ® Etv Elv - B~ Work Plane
¥ B Build Selected [ Build All Objects 2§

v <& busbar_geom.mph (root) Label: Waork Plane 2 =
v () Global Definitions
Fi Parameters 1 ~ Plane Definition
Materials
~ [l Component 1 {comp1) Plane type: Face parallel = G
» = Definitions Planar face:
v Geometry 1
¥ E Wark Plane 1 {wp 1)
L_,.!, Extrude 1 {ext1)
e « [B] Work Plane 2 (wp2) P—
Plane Geornetry T
> 1= View 3 Offset type: Distance =

4 Form Unien (fin) Offset in normal direction: 0 m

Materials
= N
. Reverse normal direction
» +\_ Electric Currents {ec) O

4 In the Graphics window, click face 8, as shown in the figure below, to add it to
the Planar face list in the Settings window for Work Plane.

Face 8 is now highlighted in blue and the work plane is positioned on top of the
face.

‘ " 0.1

e
A | |
| oo -

5 Click the Go to Plane Geometry button » to start drawing the first circle
representing the position of the first bolt. Click the Zoom Extents button (1) on
the Graphics toolbar.
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6 Under Work Plane 2, right-click
Plane Geometry . and sclect Circle

In the Settings window for Circle:

) Settings
- Under Size and Shape, in the circle 9
Radius ficld, enter rad_1. B Build Selected v [ Build Al 23
- Under Pesition, leave the default Label: Circle 1

xw and yw coordinates (0, 0).
Click Build Selected = .

~ Object Type

Type: Solid
G ~ Size and Shape
Radius: rad_1

Sectorangle: 360

G ~ Paosition

Base: Center
wow: 0
yw: 0

Continue creating the bolt by adding an extrude operation.
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I In the Model Builder window, right-click Work Plane 2 & and select Extrude =.
In the Settings window for Extrude, in the first row of the Distances from Plane
table, enter -2*tbb to extrude the circle.

Model Builder Settings
- i = &t Extrude
Brpet ' ([ Build Selected ~  [E Build All Objects &

h

v & bushar_geom.mph (root) Label:  Extrude 2 =
v () Global Definitions
Fi Parameters 1 ~ General
i) Materials
~ [l Component 1 {comp1) Extrude from: Work plane =
> =,
Work plane: Work Plane 2 (wp2) » =
> & Work Plane 1 (wp1) Input objects:
[E] Extrude 1 (ext1) T =]
/ p
~ E Wark Plane 2 (wp2) El —
~ Plane Geornetry P
Circle 1{c1)
> [y View 3
G [T Extrude 2 (ext2) Input object handling: Unite with g
- Form Union (fin)
25 Materials v Distances
¥ +\_ Electric Currents (ec)
Specify: Distances from plane =

» IE) Heat Transfer in Solids (ht)
> iy Multiphysi "
wiy VILILPRYSICS Distances (m)

A5 Mesh 1
> ~do Study 1 -2tbh

> [El Results

2 Click the Build Selected button = to create the cylindrical part of the titanium
bolt that runs through the busbar.

Next, draw the two remaining bolts.

| 227



3 Right-click Geometry | ¥ and select Work Plane =.. A Work Plane 3 node is
added. In the Settings window for Work Plane, for Work Plane 3, sclect Face
parallel as the Plane type.

4 In the Graphics window, click face 4, as shown in the figure, to add it to the
Planar face list in the Settings window for Work Plane.

5 Click the Show Work Plane button » on the Settings window for Work Plane and
the Zoom Extents button 3 on the Graphics toolbar to get a better view of the
geometry.

To parameterize the position of the two remaining bolts, add the circles that
form the cross sections of the bolts.
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6 Under Work Plane 3, right-click Plane Geometry » and select Circle o .

In the Settings window for Circle:
- Under Size and Shape, enter rad_1
in the Radius field.

- Under Position, enter
-L/2+1.5[cm] in the xw field and
-wbb/4 in the yw field.

Click Build Selected & .

Copy the circle that you just created
to generate the third bolt in the
busbar.

G

Settings
Circle
) Build Selected ~ [E8 Build All B

Label: Circle 1

~ Object Type
Type: Solid
~ Size and Shape

Radius: rad_1

Sectorangle: 360
v Position

Base: Center

Under Work Plane 3, right-click Plane G L2+ 1.5[em]

Geometry ¥ and sclect Transforms >
Copy .

In the Graphics window, click the
circle c1 to select and add the circle
to the Input objects list in the
Settings window for Copy.

In the Settings window for Copy
under Displacement, enter wbb/2 in
the yw field.

yw:  -whb/4

Settings

Copy

) Build Selected ~ [E8 Build All B
Label: Copy1

~ Input

Input objects:

xwi
©-

Keep input objects
~ Displacement
Specify: Displacement vector

0

whhb/2

& (50 ()
I

deg

b
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10 Click Build Selected = and click the Zoom Extents button =} on the Graphics
toolbar.

Your geometry, as shown in the work plane, should match this figure so far.

L@~ CRCARE-RE K=}
| \ : . . . .
o |
0.03% I
0.0257] F
0.027] N
0.0157] F
0.017] N
0.0057] F
© . f
0.005 ] F
0.017] N
0.0157] F
0.02 N
0.0257] F
0.03 N
0.0357] F
0.05 ! 0.04 ! 0.03 ! 0.02 ! 0.01 ‘B ‘B.B] ‘B 02 ‘B 03 ‘B 04 ‘B 05 ‘B 06

Continue by extruding the circles.
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Il In the Model Builder window, right-click Work Plane 3 & and select Extrude =.
In the Settings window for Extrude, in the first row of the Distances from Plane
table, enter -2*tbb (replace the default). Click Build All Objects = .

Model Builder Settings
— —+ + | St Sl = Extrude
o ) Build Selected » [E8 Build All Objects B

b

Type filter text

v <& busbar_geom.mph (root) Label: Extrude 3 =
v () Global Definitions
Fi Parameters 1 ~ General
i Materials
v Component 1 (comp 1) Extrude from: Work plane =
? = Definitions Work plane: Work Plane 3 (wp3) ~ %
v Geometry 1
> & Work Plane 1 (wp1) Input objects:
[E) Extrude 1 (ext1) E +
v & Work Plane 2 (wp2) 0= m —
~ Plane Geornetry e

[E] Extrude 2 (extd) Input object handling: Unite with g
v 5 Work Plane 3 (wp3)
v Plane Geametry ~ Distances
(=) Circle 1(c1)
m Copy 1 (copy1) Specify: Distances from plane -
> [ View 4 "o
Extrude 3 (ext3) ISERES ()
& Form Union (fin) ®|-f’—*tbb |

235 Materials

The geometry and geometry sequence should match the figures below. Click
the Save button @ and name the model busbar.mph.
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Creating Parts and Using the Part Libraries

After setting up the busbar or other geometry model, it is convenient to be able
to save it for future use, hence avoiding unnecessary work. In the steps you have
just completed, the geometry was stored directly in the COMSOL model file that
will also be used to set up the complete busbar model. Instead, you can also create
a reusable and parameterized part that can serve as a building block of a more
complex COMSOL model geometry, which is stored in a separate file accessible
through the Part Libraries.

While building the busbar geometry, you were using features from the Geometry
and Workplane tabs. A Parts ribbon section is located in these tabs.

Extract 2 Create Part far
@ |§| rac HHHH o Create Pa - - ,-',':'\_.:
) iii Delete &% Load Part ~ n = .
Conversions Part Selections Selection Colors
- Libraries - List -

Parts Selections

From the Parts ribbon section, you can choose to create or load a part, or add a
part to the model geometry by selecting one from the Part Libraries. Several Part
Libraries are already provided with the software by default. When new parts are
created, they are added under a part’s parent node in the Global Definitions section
of the model tree. To add a part from a library, you can also right-click the
Geometry node and select Parts > Part Libraries.

232 |



The figure below shows an Internal Helical Gear part from the part library of the
Multibody Dynamics Module. The part comes with 18 Input Parameters that
control the dimensions.

Graphics

Qa@r &f L.

For additional information on working with parts and the Part Libraries, see the
Reference Manual.
To continue with the busbar tutorial, return to the section “Materials” on
page 95. Optionally, first review the section “The Auto Completion and Find
Tools” on page 89.
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Appendix B— Keyboard and Mouse Shortcuts

These shortcuts are applicable to the Model Builder, Application Builder, Model
Manager, and the Graphics window.

KEYBOARD SHORTCUTS

SHORTCUT (WINDOWS, LINUX) SHORTCUT (MACOS) ACTION

FI (Fn+Fl on certain tablets) Fl Open the Help window if needed
and display context-sensitive help for
the selected node or window.

Ctri+FI Command+F| Open the COMSOL
Documentation front page in an
external window.

F2 F2 Rename the selected node, file, or
folder.

F3 F3 Disable selected nodes.

F4 F4 Enable selected nodes.

F5 F5 Update solution with respect to new

definitions without re-solving the
model. Update reduced model data.

Also, on Windows, to continue in
the Method Editor's debugging tool
in the Application Builder.

Fé Fé6 Build the preceding node in the
Geometry branch or plot the
previous plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Also, on Windows, to step in the
Method Editor's debugging tool in
the Application Builder,
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

F7

F8

F9

Del

Escape (Esc)

Left arrow (Windows);

Shift+Left arrow (Linux)

Right arrow (Windows);
Shift+Right arrow (Linux)

Up arrow

Down arrow

F7

F8

Del

Escape (Esc)

Left arrow

Right arrow

Up arrow

Down arrow

Build the selected node in the
geometry and mesh branches,
compute the selected study step,
compute the selected node in the
solver sequence, or plot the next
plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Also, on Windows, to step into in
the Method Editor's debugging tool
in the Application Builder.

Build the geometry, build the mesh,
compute the entire solver sequence,
update results data, update the plot,
write a report or presentation, or
run a method or method call.

Also, on Windows, to create an
executable or an add-in in the
Application Builder.

On Windows, check syntax for a
method in the Application Builder.

Delete selected nodes, objects, or
rows in a table.

Cancel ongoing interactive 2D
drawing and 3D clipping operations.

Collapse a branch in the model tree.

Expand a branch in the model tree.

Move to the node above in the
Model Builder. Highlight the next
entity for a 3D geometry in the
Graphics window when it has focus.

Move to the node below in the
Model Builder. Highlight the previous
entity for a 3D geometry in the
Graphics window when it has focus.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Alt+numbers

Alt+Left arrow

Alt+Right arrow

Ctri+A

Ctri+B

Ctrl+Shift+B

Ctr+C

Ctrl+D

Ctrl+Shift+D

Ctrl+F
Ctrl+Shift-F
Ctr+G
Ctrl+Shift+G
Ctrl+K

Ctrl+L

See comment

Ctri+Left arrow

Ctrl+Right arrow

Command+A

Not available

Not available

Command+C

Command+D

Command+Shift+D

Command+F
Command+Shift+F
Command+G
Command+Shift+G

Command-+L

For the Windows version only: run
the corresponding Quick Access
Toolbar command if a number is
pressed above the character
keyboard; otherwise, insert the
corresponding ASCII character
(requires use of the numeric keypad
on Windows). To enter special
ASCII characters on macOS, you
can change to a specific Unicode
Hex Input keyboard layout.

Move to the previously selected
node in the model tree.

Move to the next selected node in
the model tree.

Select all domains, boundaries,
edges, or points; Select all cells in a
table.

Enable and remove breakpoint, for
use in the Application Builder.

Enable and disable breakpoint, for
use in the Application Builder.

Copy text in fields. Copy images in
graphics and plot windows. Copy
tree nodes.

Clear the selection of all domains,
boundaries, edges, or points in the
Model Builder. Clear all selections in
Form Editor windows.

Duplicate the selected node in the
model tree.

Find a search string.

Find a search string in a method.
Group nodes.

Ungroup nodes.

Create, use, or rename a shortcut to
a model tree node (for use in the
Application Builder).

Take a quick image snapshot.
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SHORTCUT (WINDOWS, LINUX) SHORTCUT (MACOS) ACTION

Ctrl+N Command+N New model.

Ctrl+O Command+O Open a model file from the file
system.

Ctrl+Shift+O Command+Shift+O Open a model file from a Model
Manager database or file system.

Ctrl+P Command+P Print the contents of the plot
window.

Ctrl+Shift+R Command+Shift+R Revert to the saved version of the
model file and reinitializes the Ul

Ctrl+S Command+S Save a model file to the file system.

Ctrl+Shift+S Command+Shift+S Save a model file to a Model
Manager database or file system.

Ctrl+V Command+V Paste copied text or object.

Ctri+X Command+X Cut copied text or object.

Ctri+Y Ctri+Shift+Z Redo the last undone operation.

Ctri+Z Command+Z Undo the last operation.

Ctri++ Ctrl key and plus key: Zoom in, in
form editors, method editors, and
the Main Window editing window,
in the Application Builder..

Ctrl+- Ctrl key and minus key: Zoom out,
in form editors, method editors, and
the Main Window editing window,
in the Application Builder.

Ctrl+0 Reset zoom to 100% in form
editors, method editors, and the
Main Window editing window, in
the Application Builder.

Ctri+Alt+0 Zoom to fit the available space in
form editors and the Main Window
editing window, in the Application
Builder.

Ctrl+1 Create alocal variable or correct the
type of an existing variable in
methods.

Ctrl+7 Toggle comments on and off in

methods.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Ctrl+Up arrow

Ctrl+Down arrow

Ctrl+Space

Ctrl+Tab

Ctrl+Shift+Tab

Ctrl+Shift+A

Ctri+Shift+]

Ctrl+Shift+M

Ctri+Alt+Left arrow

Ctri+Alt+Right arrow

Ctri+Alt+Up arrow

Ctrl+Alt+Down arrow

Ctri+F4

Command+Up arrow

Command+Down
arrow

Ctrl+Space

Ctri+Tab

Ctrl+Shift+Tab

Command+Alt+Left
arrow

Command+Alt+Right

arrow

Command+Alt+Up
arrow

Command+Alt+
Down arrow

Command+W

Move a Definitions node, Geometry
node, physics node (except default
nodes), Material node, Mesh node,
Study step node, or Results node up
one step.

Move a Definitions node, Geometry
node, physics node (except default
nodes), Material node, Mesh node,
Study step node, or Results node
down one step.

In text fields for expressions: to get
access to lists of special operators,
variables, prefixes, functions, and
other expressions. In methods in the
Application Builder: for code
completion.

Switch focus to the next window on
the desktop.

Switch focus to the previous
window on the desktop.

Switch to the Application Builder
workspace from the Model Builder
or Model Manager.

Switch to the Model Manager
workspace from the Model Builder
or Application Builder.

Switch to the Model Builder
workspace from the Application
Builder or Model Manager.

Switch focus to the Model Builder
window.

Switch focus to the Settings window.

Switch focus to the previous section
in the Settings window.

Switch focus to the next section in
the Settings window.

Close the active window in
COMSOL Desktop, if it is closable.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Ctrl+F8
Ctrl+Alt+Left arrow

Ctri+Alt+Right arrow

Ctrl+Alt+Up arrow

Ctrl+Alt+Down arrow

Shift+F10 or

(Windows only) Menu key

Ctrl+Pause

Ctrl+Space or Ctri+/

R

+ or - keyboard button, or
Up arrow or Down arrow

button

Multiply key

Divide key
Shift+Divide key

Page Up or Page Down

Command+Alt+Left
arrow

Command+Alt+Right
arrow

Command+Alt+Up
arrow

Command+Alt+
Down arrow

Ctrl+F10

Command+.
(Command + period)

Ctrl+Space

R

+ or - keyboard
button, or

Up arrow or Down
arrow button

+, -

Alt+Right arrow
Alt+Left arrow
Alt+Shift+Left arrow

Page Up or Page
Down

Test an application.

Switch focus to the Model Builder
window.

Switch focus to the Settings window.

Switch focus to the previous section
in the Settings window.

Switch focus to the next section in
the Settings window.

Open the context menu.

Stop running a method when test
running applications.

Open list of predefined quantities
for insertion in Expression fields.

Toggle between automatic and
manual rotation center for mouse
rotation in 3D.

Cycle between geometric entities in
3D (domains, boundaries, edges,
points) for selection when the focus
is in the Graphics window.

Highlight the next or previous entity
for a 3D geometry in the Graphics
window. Expand or collapse a
branch in the Model Builder.

Expand selected part of a tree.
Collapse selected part of a tree.
Collapse other parts of a tree.

Move up or down in a window in
the COMSOL Desktop
environment.
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MOUSE SHORTCUTS

SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Left-click and hold down the
mouse button while dragging
the mouse.

Right-click and hold down the
mouse button while dragging
the mouse.

Middle-click and hold down the
mouse button while dragging
the mouse.

Press Ctrl and use the scroll
wheel.

Middle-click and use the scroll
wheel.

Press Ctrl and left-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and right-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and middle-click.
While holding down the key
and button, drag the mouse.

Press Ctrl and middle-click.

Press Ctrl+Alt and left-click.
While holding down the keys
and button, drag the mouse.

Press Alt and left-click. While
holding down the key and
button, drag the mouse.

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows.

Rotate the scene around the axes
parallel to the screen’s x- and y-axes
with the origin at the scene rotation
point.

Move the visible frame on the image
plane in any direction (pan).

The scene is zoomed in/out around
the mouse position where the
action started.

The scene is zoomed in or out
around the mouse position where
the action started.

The scene is zoomed in/out around
the mouse position where the
action started with, but with
somewhat larger steps.

Tilt and pan the camera by rotating
about the x- and y-axes in the image
plane.

Move the camera in the plane
parallel to the image plane.

Move the camera into and away
from the object (dolly in or out).

Zoom to the area around the point
on the model determined by the
mouse position.

Rotate the objects in the scene
around the camera look-at direction.

Rotate the objects in the scene
around the axis that intersects the
camera origin and the scene'’s
rotation center (roll direction).
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Press Alt and right-click. While
holding down the key and
button, drag the mouse.

Press Alt and middle-click.
While holding down the key
and button, drag the mouse.

Middle-click on model.
Press X, Y, or Z and left-click.

While holding down the key
and button, drag the mouse.

R

+ or - keyboard button, or

Up arrow or Down arrow
button.

Same as for Windows

Same as for Windows

Same as for Windows

Same as for Windows

+ or - keyboard
button, or

Up arrow or Down
arrow button

Move the scene in the plane
orthogonal to the axis between the
camera and the scene rotation
point.

Move the camera along the axis
between the camera and the scene
rotation point.

Set the center of rotation.

Rotate around the X, Y, or Z-axis,
respectively.

Toggle between manual and
automatic rotation center.

Cycle between 3D geometric
entities (domains, boundaries, edges,
points) for selection. When focus is
in the Graphics window.
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Appendix C — Language Elements and Reserved Names

Building a model tree in COMSOL Multiphysics is equivalent to graphically
programming a sequence of operations. Using the Record Code functionality in
the Application Builder or saving as a model file for MATLAB® or Java® records
and saves the sequence of operations as a list of traditional programming
statements. In this section, we will give an overview of the following element
categories as defined by the underlying COMSOL language:

e Constants
e Variables

e Functions
¢ Operators

» Expressions

These language elements are built in or user defined. Operators cannot be user
defined. Expressions are always user defined.

ABOUT RESERVED NAMES

Built-in elements have reserved names, names that cannot be redefined by the
user. If you try to use a reserved name for a user-defined variable, parameter, or
function, the text where you enter the name will get a yellow squiggly underline
and you will get a tooltip message if you hover over the text string. Reserved
function names are reserved only for function names, which means that such
names can be used for variable and parameter names and vice versa. In the
following pages, we list the most commonly used built-in elements and hence
those reserved names. A more exhaustive list of built-in elements can be found in
the Programming Refevence Manual and the Application Programming
Guide.

VARIABLES USED IN APPLICATIONS

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of'a parameter. In addition, variables
to be used in applications can be defined in the Application Builder under the
Declarations node. Such variables are available globally in form objects and
methods but cannot be used in the Model Builder.
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Constants and Parameters

There are three different types of constants accessible from the Model Builder:
built-in mathematical and numerical constants, built-in physical constants, and
parameters. Parameters are user-defined constants, which can vary over parameter
sweeps. Constants are scalar valued. The tables below list the built-in
mathematical and numerical constants as well as built-in physical constants.
Constants and parameters can have units.

BUILT-IN MATHEMATICAL AND NUMERICAL CONSTANTS

DESCRIPTION NAME VALUE

Floating-point relative accuracy for double eps 22 (~2.2204-1 0! 6)

floating-point numbers, also known as

machine epsilon

The imaginary unit i, ] i,sqrt(-1)

Infinity, oo inf, Inf A value larger than what
can be handled with
floating-point
representation

Not-a-number NaN, nan An undefined or
unrepresentable value,
such as the result of 0/0
or inf/inf

T pi 3.141592653589793
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BUILT-IN PHYSICAL CONSTANTS

DESCRIPTION NAME VALUE

Acceleration of gravity g_const 9.80665[m/s"2]

Avogadro constant N_A const 6.02214076e23[1/mol]

Bohr radius a0_const 4*pi*epsilon0_const*hbar_const"2
/ (me_const*e_const"2)

Boltzmann constant k_B_const 1.380649e-23[J/K]

Characteristic impedance ~ Z0_const 376.73031346177066[ohm]

of vacuum (impedance of

free space)

Electron mass me_const 9.10938291e-31[kg]

Elementary charge e_const 1.602176634e-19[C]

Faraday constant F_const 96485.3365[C/mol]

Fine-structure constant
Gravitational constant

Molar volume of ideal gas
(at 273.15 Kand | atm)

Neutron mass

Permeability of vacuum
(magnetic constant)

Permittivity of vacuum
(electric constant)

Planck's constant

Planck’s constant over 2 pi
Proton mass

Speed of light in vacuum

Stefan—Boltzmann
constant

Universal gas constant

Wien'’s displacement law
constant

alpha_const
G_const

V_m_const

mn_const

mu0_const

epsilon0_const

h_const
hbar_const
mp_const
c_const

sigma_const

R_const

b_const

7.29735298e-3

6.67384e-11[m"3/ (kg*s~2) ]

2.2413968e-2[m"3/mol]

1.674927351e-27[kg]

2*alpha_const*h_const/c_const/e_

const/e_const

1/mu0_const/c_const/c_const

6.62607015e-34[J*s]

1.05457172533629¢e-34[J*s]

1.672621777e-27[kg]
299792458[m/s]

5.670373e-8[W/ (m"2*K~4) ]

8.3144621[J/ (m01*K) ]
2.8977721e-3[m*K]

PARAMETERS

Parameters are user-defined constant scalars in the Global Definitions branch in the

model tree. Example uses are:

o Parameterizing geometric dimensions
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o Parameterizing mesh element sizes

¢ Defining parameters to be used in parametric sweeps

A parameter can be defined as an expression in terms of numbers, parameters,
built-in constants, and built-in functions of parameters and built-in constants.
Parameters should be assigned a unit, using [ 1, unless they are dimensionless.

Variables

There are two types of variables used in the Model Builder: built-in variables and
user-defined variables. Variables can be scalars or fields. Variables can have units.

Note: Spatial coordinate variables and dependent variables are user-defined
variables of special interest. These variables have default names based on the space
dimension of the geometry and the physics interface, respectively. As a result of
the names chosen for these variables, a list of built-in variables will be created by
COMSOL Multiphysics: the first- and second-order derivatives with respect to
space and time. The following table contains some of the most important built-in
variables. For a complete list, see the Reference Manual.
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BUILT-IN VARIABLES

NAME
concompid

curv

curvi,curv2

dom

dvol

freq

geomapproxdist

hinscribed
lambda

linearizedelem

numberofdofs

meshelement
meshelementall

meshtype

meshvol

nx,ny,nz,dnx,dny,dnz,un

X,uny,unz

phase

DESCRIPTION

An integer value that is unique for each
connected component of geometric entities of

the types: domains, boundaries, edges, and points.

The curvature of a boundary in 2D

The principal curvature components of a
boundary in 3D

The domain number for a domain, boundary,
edge, or point

Volume scale factor variable; This is the
determinant of the Jacobian matrix for the
mapping from local (element) coordinates to
global coordinates.

Frequency

For each element, this variable indicates how far a
node point in each element was moved from the
geometry.

Mesh element size (length of the longest edge of
the element)

Element inscribed diameter

Eigenvalue

Elements forced to be linear

Number of degrees of freedom

Mesh element number, per type
Mesh element number

Mesh type index for the mesh element; This is the
number of edges in the element.

Volume of the (linearized) element

Normal components for the boundary surface
normal vector. Down and up normal components
in the x-direction are dnx and unx, respectively,
and similarly for the y- and z-directions.

Phase angle

Field

Field
Field

Field

Field

Global
variable

Field

Field

Field

Global
variable

Field

Global
variable

Field
Field
Field

Field
Field

Global
variable
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qual, qualcondition, Mesh quality measures Field
qualcurvedskewness,
qualgrowth,
qualmaxangle,
qualskewness,
qualvollength
realdetjac The determinant of the Jacobian matrix for the Field
mapping from a straight mesh element to the
possibly curved element used when solving. Use
this variable to measure the difference in shape
between a curved element and the
corresponding straight element.
realdetjacmin A scalar field variable for each element defined as  Field
the minimum value of the reldetjac variable
for the corresponding element.
A reldetjacmin value less than zero for an
element means that the element is wrapped
inside-out; that is, the element is an inverted
mesh element.
s,s1,s2 Curve and surface parameterization variables Field
t Time Global
variable
tcurvx, tcurvy,tcurvix, Tangential directions for the corresponding Field
curvly,tecurviz,tourvax, curvature variables
tcurv2y,tcurv2z
tx,ty,tix,t1y,t1z, Tangent vector components correspondingto the  Field
t2x,t2y,t2z curve and surface parameterizations
qual A mesh quality measure between O (poor quality)  Field
and | (perfect quality)
USER-DEFINED VARIABLES THAT GENERATE BUILT-IN VARIABLES
DEFAULT NAME DESCRIPTION TYPE
Xy, ¥, Z Spatial coordinates (Cartesian) Field
r, phi, z Spatial coordinates (Cylindrical) Field
u, T, etc. Dependent variables (Solution) Field

Example: T is the name for the temperature in a 2D, time-dependent heat transfer
model; x and y are the spatial coordinate names. In this case, the following built-in
variables will be generated: T, Tx, Ty, Txx, Txy, Tyx, Tyy, Tt, Txt, Tyt, Txxt, Txyt,
Tyxt, Tyyt, Ttt, Txtt, Tytt, Txxtt, Txytt, Tyxtt, and Tyytt. Here, Tx corresponds
to the partial derivative of the temperature T with respect to x, Ttt corresponds to
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the second-order time derivative of T, and so on. If the spatial coordinate variables
have other names — for example, psi and chi — then Txy would be Tpsichi, and
Txt would be Tpsit. (The time variable t is built in; the user cannot change its

name.)

Functions

In the Model Builder, there are two types of functions: built-in and user-defined.
Functions can be scalar valued or field valued depending on the input
argument(s). Some functions can have units for both input and output arguments.

BUILT-IN MATHEMATICAL FUNCTIONS

These functions do not have units for their input or output arguments.

NAME DESCRIPTION SYNTAX EXAMPLE
abs Absolute value abs(x)

acos Inverse cosine (in radians) acos(x)
acosh Inverse hyperbolic cosine acosh(x)
acot Inverse cotangent (in radians) acot(x)
acoth Inverse hyperbolic cotangent acoth(x)
acsc Inverse cosecant (in radians) acsc(x)
acsch Inverse hyperbolic cosecant acsch(x)

arg Phase angle (in radians) arg(x)

asec Inverse secant (in radians) asec(x)
asech Inverse hyperbolic secant asech(x)
asin Inverse sine (in radians) asin(x)
asinh Inverse hyperbolic sine asinh(x)
atan Inverse tangent (in radians) atan(x)
atan2 Four-quadrant inverse tangent (in radians) ~ atan2(y,x)
atanh Inverse hyperbolic tangent atanh(x)
besselj Bessel function of the first kind besselj(a,x)
bessely Bessel function of the second kind bessely(a,x)
besseli Modified Bessel function of the first kind besseli(a,x)
besselk Modified Bessel function of the second kind  besselk(a,x)
binomial Binomial coefficients binomial(n,k)
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NAME

DESCRIPTION

SYNTAX EXAMPLE

ceil
conj

cos

cosh

cot

coth

csc

csch

erf
erfinv
exp
factorial
floor
gamma
gcd

imag

lcm
legendre
legendre
log
log10
log2

max

min

mod

poweps

psi

random
randomnormal
range

real

Nearest following integer
Complex conjugate

Cosine

Hyperbolic cosine
Cotangent

Hyperbolic cotangent
Cosecant

Hyperbolic cosecant

Error function
Inverse error function
Exponential
Factorial of nonnegative integer
Nearest previous integer
Gamma function

Greatest common divisor
Imaginary part

Least common multiple
Legendre polynomials
Associated Legendre functions
Natural logarithm

Base-10 logarithm

Base-2 logarithm

Maximum of two arguments
Minimum of two arguments
Modulo operator

Power for use with derivatives of

expressions that need to be evaluated near

Zero

Psi function and its derivatives

Random function, uniform distribution

Random function, normal distribution

Create a range of numbers

Real part

ceil(x)
conj(x)
cos(x)
cosh(x)
cot(x)
coth(x)
csc(x)
csch(x)
erf(x)
erfinv(x)
exp(x)
factorial(n)
floor(x)
gamma(x)
gcd(a,b)
imag(u)
lcm(a,b)
legendre(1,x)

legendre(1l,m,x)

log(x)
log10(x)
log2(x)
max(a,b)
min(a,b)
mod(a,b)

poweps(x,n)

psi(x,k)

random(X,y, ..

-)

randomnormal (X,y, ...

range(a,step,b)

real(u)




NAME DESCRIPTION SYNTAX EXAMPLE
round Round to closest integer round(x), round(x,p)
sec Secant sec(x)
sech Hyperbolic secant sech(x)
sign Signum function sign(u)
sin Sine sin(x)
sinh Hyperbolic sine sinh(x)
sphericaly Spherical harmonic function sphericaly(1,m,theta,phi)
sphericalyr Real spherical harmonic function sphericalyr(1l,m,theta,phi)
sqrt Square root sqrt(x)
sqrteps Square root for use with expressions that ~ sqrteps(x)
need to be evaluated near zero
tan Tangent tan(x)
tanh Hyperbolic tangent tanh(x)
zernike Zernike polynomials zernike(n,m,r,phi)
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BUILT-IN OPERATOR FUNCTIONS

These built-in functions behave differently than the built-in mathematical
functions. They may not belong in an introductory text but are listed to complete
the list of reserved names. For more information, see the Reference Manual.

NAME NAME NAME NAME

adj d lintotalavg stddev
at depends lintotalpeak subst
atlintotalpeak dest lintotalrms substval
atlocal dflux linzero sum
atonly diskavg mean test

ato diskint nif timeavg
at1 down nojac timeint
at2 dtang noenv timemax
at3 elemavg novar timemin
atentO elemgpmax noxd treatasconst
atent1 elemgpmin patcheval try_catch
atent2 elemint pd uflux
atent3 emetric pint up
atpmax env pmax var
atpmin error pmin with
attimemax frame.dt ppr withparam
attimemin fsens pprint withsol
atxd fsensimag prev

atxdo gpeval psum

atxd1 if reacf

atxd2 integrate realdot

atxd3 isdefined residual

ballavg islinear scope.atenti

ballint isnan scope.ati

bdf jacdepends sens

bndenv laginterp setconst

centroid lindev setind

circavg linper setval

circint linpoint shapeorder

circumcenter isinf side

cubeint linsol sphavg

cubeavg lintotal sphint

USER-DEFINED FUNCTIONS

A user-defined function can be defined in the model tree under the Global
Definitions node or, for each Component, under the Definitions node. Select a
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template from the Functions menu and enter settings to define the name and

detailed shape of the function.

TEMPLATE NAME ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Analytic The function name is its identifier;
for example, ant.
The function is a mathematical
expression of its arguments.
Example: Given the arguments x
and vy, its definition is
sin(x)*cos(y).
The function has an arbitrary
number of arguments.

Interpolation The function name is its identifier;
for example, int1.
An interpolation function is defined
by a table or file containing the
values of the function in discrete
points.

The file formats are the following:
spreadsheet, grid, or sectionwise.
The function has one to three
arguments.

Piecewise The function name is its identifier;
for example, pw1.
A piecewise function is created by
splicing together several functions,
each defined on one interval. Define
the argument, extrapolation and
smoothing methods, and the
functions and their intervals.

This function has one argument with
different definitions on different
intervals, which must not overlap or
have any holes between them.

The name of the function with
comma-separated arguments within
parentheses. For example:
ani1(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:
int1(x,y,z)

The name of the function with a
single argument within parentheses.
For example:

pwi (x)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Gaussian Pulse

Ramp

Rectangle

Step

Triangle

The function name is its identifier;
for example, gp1.
The Gaussian pulse function defines
a bell-shaped curve according to the
expression
—(a-xy)”
1 20°
e
oN2T

y(x)=

It is defined by the mean parameter,
Xq, and the standard deviation, ©.

The function has one argument.

The function name is its identifier;
for example, rm1.

A ramp function is a linear increase
with a user-defined slope that begins
at some specified time.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, rect.

A rectangle function is 1 in an
interval and 0 everywhere else.

The function has one argument.

The function name is its identifier;
for example, step1.

A step function is a sharp transition
from 0 to some other value
(amplitude) at some location.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, trit.

A triangle function is a linear
increase and linear decline within an
interval and 0 everywhere else.
The function has one argument. It
can also be smoothed.

The name of the function with a
single argument within parentheses.
For example:

gp1(x)

The name of the function with a
single argument within parentheses.
For example:

rmi(x)

The name of the function with a
single argument within parentheses.
For example:

recti(x)

The name of the function with a
single argument within parentheses.
For example:

step1(x)

The name of the function with a
single argument within parentheses.
For example:

trit(x)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Waveform

Normal
Distribution

Random

External (Global
Definitions only)

The function name is its identifier:
for example, wv1.

A waveform function is a periodic
function with one of several
characteristic shapes: sawtooth, sine,
square, or triangle.

The function has one argument. It
can also be smoothed.

The function name is its identifier:
for example, nd1.

Defines the probability density
function, cumulative distribution
function, and quantile function for a
normal distribution.

The function name is its identifier:
for example, rn1.

A random function generates white
noise with uniform or normal
distribution and has one or more
arguments for simulating white
noise.

The function has arbitrary number
of arguments.

An external function defines an
interface to one or more functions
written in the C language (which
can be a wrapper function
interfacing source code written in,
for example, Fortran). Such an
external function can be used, for
example, to interface a user-created
shared library. Note that the
extension of a shared library file
depends on the platform: .dll
(Windows), .so (Linux), or .dylib
(macOs).

The name of the function with a
single argument within parentheses.
For example:

wv1(x)

The name of the function with a
single argument within parentheses.
For example:

nd1(x), nd1_cum(x), and
nd1_cum_inv(Xx)

The name of the function with
comma-separated arguments within
parentheses. For example:
rni(x,y)

The arguments x and y are used as
random seeds for the random
function.

The name of the function and the
appropriate number of arguments
within parentheses. For example:
myextfunc(a,b)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

MATLAB®
(Global
Definitions only)

Elevation

Image

Least-Squares Fit

A MATLAB® function interfaces
with one or more functions written
in the MATLAB® language. Such
functions can be used as any other
function defined in COMSOL
Multiphysics®, provided that
LiveLink™ for MATLAB® and
MATLAB® are installed. (MATLAB®
functions are evaluated by
MATLAB® at runtime.)

The function name is its identifier,
for example, elev1.

Used to import geospatial elevation
data from digital elevation models
and map the elevation data to a
function of x and y. A DEM file
contains elevation data for a portion
of the Earth’s surface. The resulting
function behaves essentially like a
grid-based interpolation function.

The function name is its identifier,
for example, im1.

Used to import an image (in BMP,
JPEG, PNG, or GIF format) and map
the image's RGB data to a scalar
(single-channel) function output
value. By default, the function’s
output uses the mapping
(R+G+B)/3.

The function name is its identifier,
for example, 1sq1_fun1.

Used for least-squares function
approximation. Defines a
least-squares fit of one or more
parameterized functions with
respect to the input data. The input
data can be a file, a local table, or a
results table.

The name of the function and the
appropriate number of arguments
within parentheses. For example:
mymatlabfunc(a,b)

The name of the function with
comma-separated arguments within
parentheses. For example:
elevi(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:
im1(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:
1sq1_funi1(x1,x2)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Gaussian Process

Polynomial
Chaos
Expansion

Deep Neural
Network

The function name is its identifier,
for example, gpm1.

Used for multidimensional
interpolation and surrogate model
training. Defines one or more
functions trained on input data
through a Gaussian process
regression method. The input data
can be a file or a result table.

Note: Training a Gaussian
Process function requires the
Uncertainty Quantification Module.
Using a model that already contains
a trained Gaussian Process
function does not require any
add-on products.

The function name is its identifier,
for example, pce1.

Used for multidimensional
interpolation and surrogate model
training. Defines one or more
functions trained on input data
through a Polynomial Chaos
Expansion method. The input data
can be a file or a result table.

Note: Training a Polynomial
Chaos Expansion function
requires the Uncertainty
Quantification Module. Using a
model that already contains a
trained Polynomial Chaos
Expansion function does not
require any add-on products.

The function name is its identifier,
for example, dnn1.

Used for multidimensional
interpolation and surrogate model
training. Defines one or more
functions trained on input data
through a Deep Neural
Network method. The input data
can be a file or a result table.

The name of the function with
comma-separated arguments within
parentheses. For example:
gpm1(x1,x2)

The name of the function with
comma-separated arguments within
parentheses. For example:
pcel(x1,x2)

The name of the function with
comma-separated arguments within
parentheses. For example:
dnni(x1,x2)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Partial Fraction
Fit

Function Switch

The function name is its identifier,
for example, pff1.

Used for rational approximation of
frequency-domain responses. This
approximation makes it possible to
compute its inverse Fourier
transform analytically and thus
obtain the time-domain impulse
response function.

The input data can be a file or a
result table. The output is complex
valued.

The function name is its identifier,
for example, sw1.

A switch is used to switch between
global functions during a solver
sweep. You add the functions as
subnodes under the Switch node.
The switch for functions acts
essentially as a switch statement in a
programming language; that is, it
dynamically chooses one of its
underlying branches depending on a
parameter that can be controlled
from the solvers using a Function
Sweep study. You can also add a
Switch node under Materials and
then use a Material Sweep to
sweep over a discrete set of
materials.

The name of the function with a
single argument within parentheses.
For example:

pffi(x)

Switch is a container node for

functions.

Unary and Binary Operators

In the Model Builder, the following table contains the unary and binary operators
that can be used in expressions.

PRECEDENCE LEVEL SYMBOL DESCRIPTION
| () {} Grouping, Lists, Scope
2 " Power

1 -+

Unary: Logical NOT, Minus, Plus

| 257



PRECEDENCE LEVEL SYMBOL DESCRIPTION

4 [1] Unit

5 * Multiplication, Division

6 + - Binary: Addition, Subtraction

7 < <= > >= Comparisons: Less-Than, Less-Than or
Equal, More-Than, More-Than or Equal

8 == = Comparisons: Equal, Not Equal

9 && Logical AND

10 || Logical OR

[ , Element Separator in Lists

Expressions

PARAMETERS

A parameter expression can contain: numbers, parameters, built-in constants,
built-in functions of parameter expressions, and unary and binary operators.
Parameters can have units.

VARIABLES

A variable expression can contain: numbers, parameters, constants, variables,
functions of variable expressions, and unary and binary operators. Variables can
have units.

FUNCTIONS

A function definition can contain: input arguments, numbers, parameters,
constants, functions of parameter expressions, including input arguments, unary
and binary operators.
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Appendix D — File Formats

COMSOL File Formats

The COMSOL Model MPH-file type, with the extension .mph, is the default file
type containing the entire model tree and application tree from the Model Builder
and Application Builder, respectively. The file contains both binary and text data.
The mesh and solution data is stored as binary data, while all other information is
stored as plain text.

The COMSOL binary and text file types, with the extension .mphbin and .mphtxt,
respectively, contain either geometry objects or mesh objects that can be imported
directly to the Geometry or Mesh nodes in the model tree. Note that if the CAD
Import Module, Design Module, or one of the LiveLink™ add-on products for
CAD was used to create a geometry model, then the same product may be
required to open the corresponding file. This is because the geometry model may
require features that are only available in one of the add-on products.

The Physics Builder file type, with the extension .mphphb, contains one or more
user-defined physics interfaces that you can access from the Model Builder. See the
Physics Builder Manual for more information.

See Supported External File Formats for more information about all the other
formats supported by COMSOL Multiphysics.

FILE TYPE EXTENSION IMPORT EXPORT
COMSOL Model and Application .mph Yes Yes
COMSOL Binary Data .mphbin Yes Yes
Physics Builder .mphphb Yes Yes
COMSOL Text Data .mphtxt Yes Yes

Supported External File Formats

CAD

The CAD Import Module and Design Module allow for the import of a range of
industry-standard CAD file types. Additional file types are available through the
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bidirectional functionality of the LiveLink products for CAD as well as with the
File Import for CATIA® V5 add-on.
The DXF (2D), VRML (3D), STL (3D), PLY (3D), and 3MF (3D) file types are
available for import with COMSOL Multiphysics and do not require any add-on
products. Unless noted otherwise in the table below, import of the listed file types

is available on all supported versions of Linux

®

, macOS, and Windows® operating

systems.

FILE TYPE EXTENSION IMPORT ~ EXPORT
AutoCAD® 23 .dwg Yes Yes®
|r1ver1tor®|'2'3 .ipt,.iam Yes Ye38
Nx©®'2 prt Yes No
PTC Creo Parametric™ 3 prt,.asm Yes Yes®
Revit® 34 .rvt Yes’ Yes®
Solid Edge®3'5 .par, .asm Yes’ Yes®
SOLIDWORKS®'23 .sldprt, .sldasm Yes Yes®
DXF 3D and 2D) .dxf Yes Yes’
Parasolid®’ Xty xmt_txt,.x_b,.xmt_bin  Yes Yes
ACIS®! .sat,.sab, .asat,.asab Yes Yes
STEP! .step, .stp Yes Yes
IGES! .iges,.igs Yes Yes
CATIA® V526 .CATPart, .CATProduct Yes No
VRML, v1”7 .veml, .wrl Yes No
STL .stl Yes Yes
3MF .3mf Yes No
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FILE TYPE EXTENSION IMPORT EXPORT

PLY .ply Yes No

|Requires one of the LiveLink™ products for AutoCAD®, PTC Creo Parametric™, Inventor®,
Revit®, Solid Edge®, SOLIDWORKS®, the CAD Import Module, or the Design Module
2Import supported on Windows® and Linux operating systems only

3Synchronization of files between COMSOL Multiphysics and a linked CAD program
supported on Windows® operating systems only

4Requires LiveLink™ for Revit®

5Requires LiveLink™ for Solid Edge®

6Requires the CAD Import Module (or the Design Module or one of the LiveLink™ products
for AutoCAD®, Inventor®, PTC Creo Parametric™, Revit®, Solid Edge®, or SOLIDWORKS®)
and the File Import for CATIA® V5

/Limited to a single geometric domain

8From/To file using linked CAD package, provided the original CAD geometry is created in the
CAD package

9E><por‘t is supported for 2D geometry objects only, including work plane objects in 3D

ECAD

The ECAD Import Module allows for import of 2D layout files with automatic
conversion to 3D CAD models. The Touchstone file type is used for exporting
S-parameters, impedance, and admittance values from simultaneous port and
frequency sweeps. The SPICE Circuit Netlist file type is converted at import to a
series of lumped circuit element nodes under an Electrical Circuit node.

FILE TYPE EXTENSION IMPORT ~ EXPORT
IPC-2581" .cvg, . xml Yes No
ODB++ .zip, .tar, .tgz,.tar.gz  Yes No
GDS! .gds Yes No
OASIS .oas No Yes
Touchstone? .s2p, .s3p,.s4p, ... No Yes
SPICE Circuit Netlist® .cir Yes Yes

|Requires the ECAD Import Module

2Requires either the AC/DC Module, RF Module, MEMS Module, or Wave Optics Module
3Requires either the AC/DC Module, RF Module, MEMS Module, Plasma Module, or
Semiconductor Module

4E><port is supported for 2D geometry objects only, including simultaneous export of objects
from multiple work planes in 3D
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MATERIAL DATABASES

From the Materials node, in the model tree, you can import material data on the
MPH-file format as well as on a COMSOL-native XML format. You can also
export material data on the COMSOL-native XML format. When importing
material data from an MPH-file, only the material contents of the file are
considered. For exporting material data on the MPH-file format, you simply save
the MPH-file using the options on the File menu.

The Chemical Reaction Engineering Module and the Plasma Module can read
CHEMKIN® files for simulating complex chemical reactions in the gas phase. The
Plasma Module can read LXCAT files for sets of electron-impact collision cross
sections. The Metal Processing Module import material properties from the
software ]MatPr0®.

FILE TYPE EXTENSION IMPORT EXPORT
COMSOL Model and Application .mph Yes Yes
COMSOL Model XML .xml Yes Yes
CHEMKIN®! .dat, .txt, .inp’ Yes No
CAPE-OPEN! (direct connection) n/a nfa n/a
LXCAT file? .1xcat, . txt Yes No
JMatPro®4 .xml Yes No

|Requires the Chemical Reaction Engineering Module or the Plasma Module. The Plasma
Module only supports thermodynamic and transport data.

2Requires the Plasma Module.
3Any extension is allowed: these are the most common extensions.

4Requires the Metal Processing Module.

MESH

The NASTRAN® Bulk Data file types are used to import a volumetric mesh. The
VRML, STL, PLY, and 3MEF file types are used to import a triangular surface mesh
that can serve as a starting point for creating a volumetric mesh.

FILE TYPE EXTENSION IMPORT ~ EXPORT
3MF .3mf Yes Yes
NASTRAN® Bulk Data .nas, .bdf, .nastran,.dat Yes Yes
PLY .ply Yes Yes
COMSOL Sectionwise .txt, .csv,.dat Yes Yes
STL .stl Yes Yes
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FILE TYPE EXTENSION IMPORT EXPORT

VRML, v .vrml, .wrl Yes No
VTK .vtu No Yes

IMAGES, MOVIES, AND AUDIO

Results visualization can be exported to a number of common image file types; See
the table below. Images can also be read and used as interpolation functions for
physics modeling. Animations can be exported to one of the Animated GIF, AVI,
and WebM file types. The 3D representation from a 3D plot can be exported to
the gITF™ format for 3D scene exchange. Audio files can be imported and
exported on the WAVE Audio File format.

FILE TYPE EXTENSION IMPORT ~ EXPORT
Animated GIF .gif No Yes
AV! .avi No Yes
BMP .bmp Yes Yes
EPS (1D graphs only) .eps No Yes
GIF .gif Yes Yes
gITF™ .glb No Yes
JPEG .ipg, - jpeg Yes Yes
MP4 .mp4 Yes?  No
oGV .ogv Yes?  No
PNG .png Yes Yes
TIFF Ltif, L tiff No Yes
WAVE .wav Yes Yes
WEBM .webm Yes”?  Yes

| Available for Windows® only
2Available in the Application Builder, for Windows® only, in the video form object

PROGRAMMING LANGUAGES AND SPREADSHEET

Model files for Java® are editable files with the extension . java that contain
sequences of COMSOL commands as Java® code. Edit the files in a text editor to
add additional commands. You can compile these Java® files into Java® Class files
with the extension .class and run them as separate applications. Program code
used in model files for Java® is essentially identical to that of the Method Editor
in the Application Builder. However, the Method Editor comes with an integrated
Java® compiler.
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Model files for MATLAB® are editable script files (M-files), similar to the model
files for ]ava®, for use with MATLAB®. These model files, which have the
extension .m, contain a sequence of COMSOL commands as a MATLAB® M-file.
You can run the model files in MATLAB® like any other M-file scripts. It is also
possible to edit the files in a text editor to include additional COMSOL
commands or general MATLAB® commands. Running model files in the M-file
format requires LiveLink™ for MATLAB®.

With a license for LiveLink™ for Excel®, you can save models on the Visual Basic
for Applications (VBA) format for use with Excel®.

Compiled C-code can be linked with a model or application in several ways
including the External Material and External Function interfaces in the Model
Builder and as the External Library interface in the Application Builder.

FILE TYPE EXTENSION IMPORT EXPORT
MATLAB®: Model file for MATLAB® .m No Yes
MATLAB®: Function' -m Yes No
Java®: Archive file . ar“/J Yes No
Java®: Compiled model file forJava® .class Yes No
Java®: Model file forJava® .java No Yes
C: Function .dlla,. soé‘,.dylib5 Yes No
Fortran’: Function .dllB,. so? Yes No
Excel®? .x1sx,.vba Yes Yes

|Requires LiveLink™ for MATLAB®

2Requires LiveLink™ for Excel®, available for Windows® only

3Available for Windows® only

“Available for Linux® only

>Available for macOS only

®Can be linked to a method in an application using the Application Builder

7Requires a C-wrapper to the Fortran code and to include the C-code DLL as an External C
Library in the Application Builder. Alternatively, you can include a Fortran DLL directly as an
External C Library in the Application Builder. Note: You need to consider the naming
convention for exported Fortran function names. For example, in \/\/indows®, it is typically
required that Fortran function names are in uppercase.

NUMERICAL AND INTERPOLATION DATA FORMATS

The grid, sectionwise, and spreadsheet file types can be read for defining
interpolation functions. Furthermore, the sectionwise and spreadsheet file types
can be read and used for defining interpolation curves and written for exporting
results. In addition, tables can be copied and pasted on the spreadsheet format.
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Parameters and variables can be imported and exported to the plain text,

comma-separated values, or data file types.

The continuous and discrete color table text file types are used for user-defined

color tables for results visualization.

Digital elevation model (DEM) files can be read and used as a parametric surface

for defining a geometry.

FILE TYPE EXTENSION IMPORT EXPORT
Copy and paste spreadsheet format n/a Yes Yes
Excel® spreadsheetl .x1sx Yes Yes
Table .txt, .csv,.dat Yes Yes
Grid Ltxt Yes Yes
Sectionwise .txt,.csv,.dat Yes Yes
Spreadsheet .txt, .csv,.dat Yes Yes
Parameters .txt,.csv, .dat Yes Yes
Variables .txt, .csv,.dat Yes Yes
Continuous and Discrete color table Ltxt Yes No
Point data for Cut Point datasets Ltxt Yes No
DEM .dem Yes No
VTK .vtu No Yes

|Requires LiveLink™ for Excel®, available for Windows® only
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Appendix E— Connecting with LiveLink™ Add-Ons

The following table shows the options to start COMSOL and the different linked
partner software using the LiveLink™ add-on products.

COMSOL® Can Start COMSOL Can Start Partner Software Can Connect
Software from Partner Software  from COMSOL Running Sessions
LiveLink™ Yes! Yes? No
for Excel®

LiveLink™ Yes® Yes® Yes®
for MATLAB®

LiveLink™ No Yes® No
for Simulink®

LiveLink™ No No Yes
for AutoCad®

LiveLink™ No No Yes
for Revit®

LiveLink™ No No Yes
for PTC®Creo®

Parametric™

LiveLink™

for Inventor®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

LiveLink™ No No Yes
for Solid Edge®

LiveLink™ No No Yes
for SOLIDWORKS®

'"When you open a model from E><ce|®, a model window starts and a link is established
automatically. The model window is an output window that displays geometry, mesh, and results.
%A model that includes a table reference to an Excel® spreadsheet automatically starts an Excel®
process in the background when the model is run in the COMSOL Desktop environment.

3You can start a COMSOL Multiphysics server from a MATLAB® se55|on using the system
command and then connect to it using mphstart in the MATLAB® command prompt.
*The cOMsOL Multlphyswcs with MATLAB® desktop shortcut starts a COMSOL Multiphysics
server and MATLAB® , then connects them automatically. When you run a COMSOL Multiphysics
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model in the COMSOL Desktop interface that includes a MATLAB® function (Global Definitions
> Functions), a MATLAB® engine and connection is started automatically.

>You can connect a MATLAB® seSS|on to a running COMSOL Mutltiphysics server using the
command mphstart in the MATLAB® command prompt.

The COMSOL Multiphysics with Simulink® desktop shortcut starts a COMSOL Multiphysics
server and MATLAB™, then connects them automatically. You can then start Simulink® and add a
COMSOL Cosimulation block where you load a cosimulation file to run a cosimulation.
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Index

A AC/DC Module 82, 107 examples 35

accuracy file types 36
convergence analysis 7/ MPH-files 12, 35

Add Material window window 37
busbar model 95 Application Library update 37
opening 49, 95 autocompletion

Add Multiphysics parameter and variable names /80
button 108 parameters and variables 89
window 08 average temperature /75

add-in 130

B Basic template /33
add-on modules

AC/DC Module 82, 105, 107

Application Libraries 35

CAD Import Module 217, 259

Chemical Reaction Engineering Mod-
ule 262

Design Module 217, 223, 259

ECAD Import Module 261

MEMS Module 149

physics list 42, 84

Plasma Module 262

Structural Mechanics Module 40, 55,
71

Blank form template /33
blank model, creating 20, 22
boundaries 104
adding to selection 106
variables scope 33
boundary condition 102
automatically defined 55
boundary load 54
busbar, setting 102
electric current 102, 105
fixed constraint 53
free 52

ground, electrical 107

study types 86 heat transfer 102

ics 139 . .
advanced topics 13 insulating 104

all combinations .
material interface 55, 71

parametric sweep |73 settings window 10

analysis boundary load 54

convergence /1 boundary number, graphics display 58

example, parametric sweep 77 boundary section

animation 26, 183
context menu 103
application 15, 122
Application Builder 8, 10, 13, 15, 33,
122, 242

Application Gallery 37

boundary selection, busbar model 104
boundary surface normal direction, up
and down 58, 246

Browse 44
Application Libraries /9
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Browse From 44
Build All button
geometry 92
meshes 61, I
built-in
constants, functions, and variables 35
materials 49, 95
variables I 15
button object 125
Button, Form Objects 127

CAD files, storing in database 2/3
CAD Import Module 217, 259
Cancel button /3, 3/
case, parameter 29, 173
chamfer 217
Chatbot window 32
Chemical Reaction Engineering Module
262
clip plane 60
cloud computing 184
Cluster Computing node 184, 187
cluster job 187
Cluster Sweep node 184, 187
color theme 17, 99
coloring
materials 99
selections 99
command sequence /28, 136
Compact MPH-files 36
compiler 15
component coupling /74
Component node, adding materials 95
computing studies 76
COMSOL Client 15
COMSOL Compiler 15
COMSOL Desktop environment
customizing 29
on Linux 24
on macOS 24

overview 8
COMSOL Multiphysics 15

native CAD format 44

opening 41
COMSOL Server |5
constants

mathematical and physical types 35
constraints 217
context menu

domain and boundary sections 103
contextual tab 23
contributing node 157
convergence analysis 7|
Convergence plot /1, 112
cooling

air stream 8/

natural convection 87
coupling operator 74
Create Selection 34

button 152
custom settings window 30

customized desktop 29

dark theme |7
Data Viewer window 57
datasets, defined 26
default feature 102
degrees of freedom 71, 78
derivatives 35
Derived Values 79, 119
defined 26
Global Evaluation 78
Volume Maximum 71, 77, 119
Design Module 217, 223, 259
dimensions 217
discretize 61
documentation, models 12, 35
domain level 103
domain section

context menu 103



domains
materials 98
remove from selection 98

variables scope 33

down, surface normal direction 58, 246

draft, Model Manager 202
draft, saving as version 207

dynamic help 13, 31

ECAD Import Module 261
edges
variables scope 33
Editor Templates window 127
eigenfrequency analysis 26
Electric Currents interface
defining boundary conditions 103
multiphysics 86, 107
overview [02
electric potential 82
physics node 105
voltage drop, parameter 87
electrical heating 8/
empty
selection 54
Enable Tooltip 141
environment reflections 100
equation
built-in 102
user-defined 68
evaluating
volume maximum 71, 120
von Mises stress 72
Evaluation Group 79, 119
automatic re-evaluation 79
example
advanced, electrical heating 81
basic, structural mechanics 40
Excel® 264, 266
exclude data, Model Manager 2/ |

exclusive node 156

executable /5
Export node 26
exporting images |20
expressions
Boolean 69
manual entry 73, 87
replacing 69, 115, 118
units, specifying 72
user-defined 68

External Process window 12

file import 44
File menu 18
fillet 217, 223
filter

Model Builder 39
Filter Options menu 39
find

parameters and variables 90
finite element

mesh 6/

tetrahedra 6/
Fixed Constraint node 53
Floating Network License /84
Form Editor 13, 125
form objects 122
form union, geometry 92
frequency response 27
frequency-domain study 26
functions

advanced topics 139

built-in 35

mathematical 35

scope 87
Functions node 87

geometric dimensions
parameters, and /2, 28, 232
parametric sweep 87

geometry
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building 87 multiphysics 86, 107

CAD format 43 overview 102

importing 43 Help window 13

in Application Libraries 91 opening 25

loading from file 87, 91 high performance computing 184
operations 217 Home tab 23

parameterized |2, 28, 87, 91, 232 HPC 184

sequence 217 hybrid parallelism /85

settings window /0 I Image Snapshot button /21

Geometry node 38
Global Definitions node 25, 28

images, creating thumbnails /20

importing
functions 87 fle 44
parameters 87 geometry 43
scope 33,87 information windows 9, I [, 3/
variables 32

initial conditions 10

global parameters 28, 29, 51, 74, 87 Initial Values node

expression 28

gl TF-file format 21

Electric Currents interface 103
Heat Transfer in Solids interface 103
graphics Solid Mechanics interface 52

rendering and hardware 6 input fields 124

Graphics menus 24
graphics object 125, 126, 135
Graphics toolbar

default view button 53, 65, 107, 117

Input Parameters
for part 233
Isosurface plot 182

) Javafile 39, 263

Java Shell window 132

image snapshot button 12/
zoom extents button 93, |14

Graphics window 9, |1, 24, 31 Joule heating

geometry, and 44 equations 102

plot 63 multiphysics coupling 107

rotate geometry 53, 113, 114 multiphysics interface 84

selecting boundary 53, 54, 107 L Laminar Flow interface 161
toolbar 9 Linux
using 45, 93 clusters 187
zoom box 54 version 24
Ground, boundary condition 106 LiveLink™ add-ons 266
grouping local database 192
nodes 32 loft 217

H Heat Transfer in Solids interface Log window [, 63

defining boundary conditions 103 M macOS version 24
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Main Window Editor 3
Material Browser

defined 12

material contents section 49, 96
material color and texture 99
material interface

mechanical contact 55, 71
material rendering 100
materials

copper 8/

domains, assigning 97

model tree 38

settings window 10

steel 49, 68

titanium alloy 81
Materials node 49, 95

mathematical constants and functions

35
MATLAB® 264
Max/Min Volume plot 73

Maximum and minimum values table

119
MEMS Module
thermal expansion, and 149
mesh
convergence analysis, and 7/
density 74
finite element 6/
model tree, and 38
parameterizing 74, 109
physics-controlled, default 109
refining 74
settings 61
unstructured tetrahedral 109
user-controlled 74, 109
mesh element size
parameters, defining 28, 110
settings 6/

mesh-convergence analysis 78

Message Passing Interface (MPI) 185
Messages window [/, 63
method /3]
model 33
Method Call 131
Method editor 13, 131
M-file 39, 264
midsurface 217
modal tab 23
Model Builder 8, 122, 133
defined 13
example 38
expanding sections 103
geometry import 43
keyboard shortcuts 239
node sequence example 52
the ribbon, and 23
toolbar 8
window 30
model history 39
Model Manager 8, 14, 19, 191
draft 202
exclude data 21|
Open From 192
Save To 192
search 216
Versions window |99
workspace 215
model method 33
model tree 8, 30
building 25
defined 87
example 38
geometry 38
Global Definitions node 25, 51, 87
Materials node 38, 49
Model Builder 13
nodes 25
Results node 26
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ribbon 23 node groups 32

root node 25 nodes 25

Study node 26, 38 default feature 52
Model Wizard reordering 39

adding physics 26, 42, 84, 195 o Open I8

Component node, and 26 Open From 19

creating a new model 20 Model Manager 192

General Studies 42 OpenGL 16, 100

More Studies 42 Override and Contribution 52, 157

opening 41, 84

preset studies 86, 195 P parallel computing /84

space dimension 41, 84 parameter case 29, 73

parameter switch

study 26, 85
models parametric sweep |73
defining 13 parameters 28, 124, 135

adding 55

defining 74, 87
displaying value 56
editing 55, 92

discretization 6/
documentation 12, 35
saving 94, 21 |

structural mechanics 40
expression 28, 74

symmetry |14

workflow 38 global 28, 29
MPHBIN-file 259 meshes, and 74
MPH-file 259 name 74

excluding data when saving 2/ | range of values 75

full and compact 36 results 32, 181

saving 94, 121 scope 87
MPHPHB-file 259 using, referencing 105
MPHTXT-file 259 Parameters node 87, 139
MPI /85 parametric geometry model 217

multicore processors |84 parametric study 87

multiphysics interface 86 parametric sweep 28

multiphysics models 81 all combinations /73
Multiphysics node 102, 103, 108, 150
multiphysics phenomena 8/

Multislice plot /13

example 75

meshes, and 74

parameter switch /73
range, defining 75

N New /8 specified combinations 173

New Form wizard |22 part 12, 232

Ribbon buttons tab 136 Input Parameters 233
no solutions stored, message 37
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Part Libraries 232
physics
adding 84
boundary conditions 102
electromagnetic heating 84
heat transfer 84
Joule heating 81, 102
laminar flow 161
model tree 38
physics interface 20, 86
Electric Currents 86
Heat Transfer in Solids 86
Joule Heating 84
Laminar Flow 161
Solid Mechanics 42, 195
Plasma Module 262
player 183
plot
regenerate after solving 79
plot group 26
3D, adding 68
Plot window 3/
plots
expression, user-defined 68
max/min volume 73
model tree 38
regenerating 73
windows |/
points, variables scope 33
Poisson'’s ratio 97
polynomial functions 6/
preferences /6
preset studies 86
Preview MPH-files 37
principal stress 156
program code
model file for Java 39
model M-file 39
progress bar |3, 3/

Progress window [ [, 63

Quick Access Toolbar 8, 10, 24, 30

Recent 19
Record Code 132
renaming plot groups 69
rendering options /6
reports, defined 26
reserved name 35
Reset Window Layout 36
resizable graphics window |33
resolution of curvature, mesh 110
results
color table range 113, 115
derived values 71, 77, 119
displaying 64
parameters 32, 18/
units, changing 64
Results node
3D plot group 73, 115, 154
busbar defaults /13
subnodes 26
surface node, adding 115, 154
Revert to Saved 19
ribbon 9, 30
Add Material 49, 101, 160
Build All 92
Build Mesh /11
Compute 76, 154, 170
defined 10, 23
example 9
importing geometry 43
Model Builder 23
Physics tab 53, 150
Windows 12, 63,221
Work Plane 219
Ribbon buttons 136

Ribbon buttons tab, New Form wizard

136
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root node
default units 174
defined 25
model thumbnails 120
Model Wizard 41

Run Application 18

running simulations | /2

Save |9
Save As |9
Save To 19
Model Manager 192
saving files 94, 121
scheduler
Grid Engine 187
IBM LSF 187
Microsoft HPC Pack 187
Open Grid Scheduler 187
PBS 187
SLURM 187
scope
global definitions 87
parameters and variables 33
parameters and variables, defined 28
variable name 34
search
parameters and variables 90
search, in Model Manager database 216
Select Study window 22
selecting
boundaries 57
multiple boundaries /52
using the graphics window context
menus 58
selecting internal surfaces 57
Selection 34, 57, 99, 100
empty 54
selection /52
Selection List window 12, 221

selection of geometry objects, domains,

boundaries, edges, and points 57
Settings Form /31
Settings Forms /31
Settings window 8, 10, 25, 30
customized 130
settings window
keyboard shortcut 239
shared memory parallelism /84
Show Material Color and Texture 99
Show Selection Colors 99
simulation, running [ 12
Single form template 123, 133
skybox image 100
software rendering /6
Solid Mechanics interface 42, 195
add-on modules 149
Solved MPH files 36
solvers
configurations 76
iterative 75, 76
stationary 63, 76
using 63
space dimension 20
specified combinations
parametric sweep |73
Stationary study 42, 63, 195
steady-state study 26
Streamline Multislice plot /13
structural analysis 40
structural displacement field 6/
structural mechanics
design 70
plastic deformation 68
stresses and strains 8/, 97
von Mises stress 64
Structural Mechanics Module
application library 40
mechanical contact 55, 71

thermal expansion 49



studies
computing solutions 76, 112
defining 63
example, multigrid iterative 76
example, stationary 63
model tree 38
preset 86
types 26
Study node 26
solution sequence |2
Suppress Selection Highlight 100
surface normal direction, graphics dis-
play 58
surface normal direction, up and down
58, 246
Surface plot
color table range /16
deformation 64
electrical current density /15
replace expression |15
settings 69
updating 14, 115

table

Maximum and minimum [ /9
Table window 12

graph plot 77

wrench results 72
Tables node 26
tables, evaluating 77
temperature /13, 171
temperature, average |75
Test Application 127, 137
tetrahedron, polynomial functions 61
thermal expansion 81, 97
thicken 217
thumbnail image 120
time-dependent study 26
torque, applied 40

unit, changing 64, 155
up, surface normal direction 58, 246
update COMSOL Application Libraries
37
Update Solution 180
user interface
COMSOL Desktop 8
overview 8

user-controlled mesh 74

variables
advanced topics 139
built-in 35
example, built-in 78
expression 32
scope 87
scope, limit 33
Variables node 32, 87
version
control 195
opening 200
saving 196
Versions window, Model Manager 199
visualization [/
colortable 113,115
Volume Maximum, evaluating 7/, 120
Volume plot /13

von Mises stress 64, 156

Window Layout /36
Windows list 63, 221
wizard

New Form 22
workflow 35
Workspace 122, 133

yield stress 40, 68

Young's modulus 97

zoom |71

Zoom Extents command 129
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